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Preface

This guide describes Oracle's StorageTek VSM GUI software. VSM GUI provides a point-and-click alternative to VTCS commands and utilities in the VSM environment.


Audience

This document is for administrators and analysts who install, configure, and use VSM GUI.





Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.


Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.





Conventions

The following text conventions are used in this document:


	Convention	Meaning
	boldface	Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.
	italic	Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.
	monospace	Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.












1 Introduction

Welcome!

Oracle's StorageTek Virtual Storage Manager Graphical User Interface (VSM GUI) provides a Web-based interface to Virtual Tape Control Software (VTCS) management and reporting commands for the StorageTek VSM library products.

VSM GUI is available in two forms:

	
Pre-installed as an LDOM (virtual machine) in a VSM console (VSMc) server


	
A standalone virtual machine software product to be installed on a VMware or Oracle VM (x86-64) server




Either form provides a virtual machine that includes all necessary software already installed to run the VSM GUI. It is then user-configured to communicate with VTCS, to gather, display, and report on VSM resources, and to issue command requests to VTCS.
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2 Installation and Configuration

VSM GUI is available in two forms:


	
Pre-installed as an LDOM (virtual machine) in a VSM console (VSMc) server



	
A standalone virtual machine software product to be installed on a VMware or Oracle VM (x86-64) server





This chapter describes installation and configuration processes for both situations.





VSM GUI Standalone VM Software Installation






VSM GUI Standalone VM Software Installation

Follow the instructions below if VSM GUI is to be downloaded and installed on a VMware x86-64 server.

Skip this section if VSM GUI is pre-installed as an LDOM on a VSMc server. See oVTCS Console System Configuration.


Product Distribution Medium

The VSM GUI web application is distributed using a Virtual Machine (VM). The VM environment contains the operating system and software stack required to access VSM GUI. You will ingest the VM into a VMware environment at your site. The distribution type is Open Virtualization Format (OVA).


VM Resource Requirements

For best VSM GUI application performance, the following minimum resources should be allocated for the product VM:

	
32 GB memory


	
80 GB virtual disk space


	
4 CPU








VM Software Versions

The VM for the VSM GUI application works with the following VM environments:

VMware:

	
VMware ESXi: 5.1.0, Build 1483097


	
vSphere Client: 5.1.0, Build 1471691




	
Note:

Use a ESXi version that meets requirements for the VM server CPUs.














VM System OS/Software Stack Details

Third party software components installed and configured to support the VSM GUI application include:

Operating System: Oracle Linux 6.7

	
Hostname: vsmguisvr


	
User: vsmgui (customer access only)


	
User: oracle




Web server: Weblogic 12.1.3

Database: Oracle Database 12c Release 12.1.0.1.0 - 64bit Production







Download VSM GUI Software

	
Access the Oracle Software Delivery Cloud website at the following URL:

http://edelivery.oracle.com/


	
Click Sign In and enter your credentials as prompted.


	
Locate the StorageTek VSM GUI software in the Product search box and then select the Linux x86-64 platform. When you have the correct product and platform in the Selected Products box, click Continue.


	
Available versions of the product are displayed, with the current release pre-selected. If this is correct, click Continue.


	
Review and accept the terms of the license agreements and click Continue.


	
When the files to download are displayed, click Download All. The files are downloaded to the location you specify.


	
The downloaded files are .zip files. You may need to unzip them:

	
If the files were downloaded to a UNIX/LINUX system, run the unzip command on each file.


	
If the files were downloaded to a Windows system, Windows Explorer will unzip them when you open them.





	
Use the md5sum utility to verify the downloaded files:

	
On a UNIX/LINUX system, use the command:

md5sum -c VSMGUI_file_parts.md5sum


	
On a Windows system, Microsoft provides a free Microsoft File Checksum Integrity Verifier (fciv.exe) which can be downloaded for this.




The md5sum file is ASCII text.


	
Combine the .ova file parts to create the full .ova file.

	
On a UNIX/LINUX system, use the command:

cat VSMGUI_n.ova.a* > VSMGUI_n.ova

where n is the version number in the file names, such as 1.2.3.00.000.


	
On a Windows system, from a DOS window, execute the provided batch file, cat_parts.bat.





	
Use the md5sum utility to verify the complete .ova file is correct:

	
On a UNIX/LINUX system, use the command:

mdsum -c VSMGUI_n.ova.md5sum

where n is the version number in the file name, such as 1.2.3.00.000.


	
On a Windows system, Microsoft provides a free Microsoft File Checksum Integrity Verifier (fciv.exe) which can be downloaded for this.




The md5sum file is ASCII text.


	
Review the VSM GUI Release Notes for this release before proceeding.








VM System Deploy for VMware Environments

	
On a Windows PC or server, install VMware vSphere Client software version 5.1.0, Build 1471691.


	
Start VMware vSphere Client and log in using credentials created at install time.

A Security Warning may be displayed for the Certificate. If so, click Ignore.


	
Optional: Save VM configuration from previous OVA install. If this is an upgrade to a previous OVA install and configuration, perform the following steps:

	
Save the current site configuration:

$ cd /opt/vsmgui/scripts

$ ./siteConfigCopy.sh save


	
Back up the site configuration and LDAP configuration to a PC or server:

/opt/Oracle/Middleware/Oracle_Home/user_projects/domains/vsmgui/config/config.xml

/home/vsmgui/siteConfigData.sql





	
Deploy VM using the VMGUI_n.ova file by selecting Deploy OVF Template on the File menu.




	
Note:

If this is the first time the client software has been executed, the Home screen may be initially displayed. If so, click the Inventory icon and then deploy the OVF template as instructed above.








	
Follow the prompts in the Deploy OVF wizard as follows:

	
Source: Select the source location by browsing to the VMGUI_n.ova file. Then click Next.


	
OVF Template Details: Click Next to continue.


	
Name and Location: Enter a name and location for the deployed template. This should be a name that communicates the VM type and version number (for example, VSM_GUI_1.2.3.00.000). Then click Next.


	
Storage: Select the data storage for this VM. Then click Next.


	
Disk Format: Select Thick Provision Eager Zeroed. Then click Next.


	
Network Mapping: Select the source network from the network inventory. Then click Next.


	
Ready to Complete: The deployment settings are displayed and you are asked if these are the options to use.

If not correct, click Back and correct the settings.

If correct, select Power On After Deployment. Then click Finish.












VM System Configuration

	
Access the new VM:

	
Select the new VSM GUI VM in the left pane list of virtual machines.


	
Select the Console tab in the main right pane. You may need to click the Console screen to display the desktop login.


	
Log in to Linux desktop:

Username: vsmgui

Password: vsm6admin





	
Open a command terminal and execute Linux/System configuration:

$ cd /opt/vsmgui/scripts

$ ./vsmGui_config.sh


	
Complete all configuration prompts:

	
At Would you like to configure/reconfigure Network?, select y.


	
At Select Action, select Device Configuration and press Enter.


	
At Select a Device, select eth0 and press Enter.


	
At Network Configuration, enter the network configuration data for your site.

Do not change Name: eth0 or Device: eth0.

At Use DHCP [*], use the space bar to clear DHCP.

Fill in the Static IP, Netmask, Default Gateway IP, and optionally the primary and secondary DNS Servers.

Select OK to complete device configuration and then select Save to save it.


	
Enter DNS configuration. This step is optional. Configuration for DNS does not directly affect the use of the VSM GUI application.

Select DNS Configuration and fill in the IP addresses for the primary DNS server and, if available, the secondary and tertiary DNS servers, and also the DNS Search Path, such as mycompany.com. Do not change Hostname: vsmguisvr.

Select OK to complete DNS configuration and then select Save&Quit to save it and exit from Network Configuration.


	
Complete the prompts for Time Zone and NTP Server Configuration.





	
When prompted to reboot the system, enter y to continue.


	
After the system restarts, open a command terminal and start Oracle Database service:

$ su – oracle (password = vsm6sqladm!)

$ sqlplus /nolog

SQL> connect sys as sysdba; (password = vsm6sqladm)

SQL> startup;

SQL> quit

$ lsnrctl start

$ exit


	
Set up the database. As user vsmgui, enter the following commands:

$ cd /opt/vsmgui/scripts

$ ./vsmGui_import.sh


	
Add an existing LDAP user that will be the VSM GUI administrator:

$ cd /opt/vsmgui/scripts

$ ./vsmGui_user.sh


	
Optional: Restore VM configuration from previous OVA install.

If this is an upgrade to a previous OVA install and you backed up the configuration files during VM system deployment, perform the following steps:

	
Copy siteConfigData.sql to /home/vsmgui


	
Copy config.xml to /opt/Oracle/Middleware/Oracle_Home/user_projects/domains/vsmgui/config/config.xml


	
Run the following to restore site configuration:

$ cd /opt/vsmgui/scripts

$ ./siteConfigCopy.sh restore





	
With the Oracle Database online, start the Weblogic Service:

$ sudo service weblogicd start

The command will direct output to the terminal during startup. After a prompt is returned, status can also be verified using the following command:

$ sudo service weblogicd status


	
Configure Weblogic to access the LDAP server for authentication using either Open LDAP or Microsoft Active Services. See LDAP Configuration for Weblogic.


	
Restart Weblogic after completing LDAP configuration:

$ sudo service weblogicd stop

$ sudo service weblogicd start


	
Perform required site configuration. See VSM GUI Initial Site-Specific Configuration.









oVTCS Console System Configuration






oVTCS Console System Configuration

Skip this section if VSM GUI was installed and configured on a VMware x86-64 server in the previous section.

Follow the instructions below if VSM GUI is installed as an LDOM on a VSMc server.




	
Note:

The procedures that follow assume that the VSM GUI application is already configured in the VSMc as described separately in the VSM console Installation, Configuration, and Service Guide. Ensure that this has already been done before continuing.







Perform the following steps:

	
Access the new LDOM by opening a command terminal using TUI or Putty (terminal session):

Username: oracle

Password: vsm6SQLadm


	
Start Oracle Database:

$ sqlplus /nolog

SQL> connect sys as sysdba; (password vsm6sqladm)

SQL> startup;

SQL> quit

$ lsnrctl start


	
Start Pre-Configuration Weblogic Services:

$ sudo svcadm enable wladmin

Wait for the service to come online (for example, ex - $ svcs wladmin). Then start the wlmanaged service:

$ sudo svcadm enable wlmanaged


	
Configure Weblogic to access the LDAP server for authentication using either Open LDAP or Microsoft Active Services. See LDAP Configuration for Weblogic.


	
Stop Weblogic:

$ sudo svcadm disable wlmanaged

Wait at least one minute. The service may report disabled sooner than it is.

$ sudo svcadm disable wladmin

The service should resolve to maintenance mode after this initial pre-configuration.

$ sudo svcadm disable wladmin


	
Perform Post-Weblogic configuration:

$ cd /opt/vsmgui/scripts

$ ./vsmGui_wlconfig.sh

The script will report the new weblogic and new ingest services are disabled:

STATE STIME FMRI

disabled 14:08:28 svc:/application/weblogic:default

STATE STIME FMRI

disabled 14:08:32 svc:/application/ingest:default


	
Start Weblogic with Post-Configuration service:

$ sudo svcadm enable weblogic


	
Add an existing LDAP user that will be the VSM GUI administrator:

$ cd /opt/vsmgui/scripts

$ ./vsmGui_user.sh


	
Optional: Restore VSM GUI LDOM site configuration from another LDOM install. If this is an upgrade to a previous LDOM install and you backed up the site configuration file from previous deployment, perform the following steps:

	
Copy siteConfigData.sql to /export/home/oracle.


	
Run the following to restore site configuration:

$ cd /opt/vsmgui/scripts

$ ./siteConfigCopy.sh restore





	
Perform required site configuration. See VSM GUI Initial Site-Specific Configuration.







VSM GUI Initial Site-Specific Configuration






VSM GUI Initial Site-Specific Configuration

Site configuration is required as a part of the initial VSM GUI installation process.




	
Note:

Ingest must be disabled before you add or change any value in the site configuration.







This information includes the set of tapeplexes from which data will be collected, the set of hosts connected to each tapeplex, and the values for various alert conditions that VSM GUI supports and displays.

Site configuration is where you define local site-specific information that VSM GUI requires to operate correctly.




	
Note:

For a VSMc configuration, each VSMc represents a tapeplex and each node of a VSMc represents a host for accessing that tapeplex.







Additionally, site configuration is where you define which users in your LDAP directory can access VSM GUI and the type of access that is allowed on each tapeplex for each user.


Site Configuration Tasks

Site configuration tasks include the following:

	
For each supported tapeplex, supply tapeplex names and severity level of log file messages


	
For each tapeplex, determine whether data for all VTVs or just initialized VTVs is to be collected


	
For each tapeplex, provide connection details for each connected host


	
Ensure there is at least one HTTP server defined for each tapeplex. VSM GUI can only collect data and display data from the defined HTTP server.


	
Ensure that each configured host runs a version of ELS supported by VSM GUI


	
Provide LDAP user names who may access VSM GUI. Optionally, provide Email addresses.


	
Assign user roles for each user on each tapeplex. The user role defines the set of VSM GUI pages available. If a user has no access for a tapeplex, then the user will not see data for that tapeplex.


	
Define alert levels for each tapeplex


	
Define VTSSs in each tapeplex and alert levels for each VTSS


	
The default database update configuration can be altered, if required. Several site configuration properties are editable to fine-tune host cycle times and batch record sizes for your site.








Required Site Data

You must collect the following information before performing site configuration:

	
A list of tapeplex names for which data will be collected


	
For each tapeplex, a list of connected hosts and a list of connected VTSSs


	
For each connected host, the host name or IP address, the SMC HTTP server port number, and the ELS version. For pre-ELS 7.3.1 VSMc hosts, the SMC subsystem name and ELS subsystem name are also required.


	
A list of LDAP user names that will be allowed access to VSM GUI


	
For each LDAP user name, the name of the tapeplex or tapeplexes they may access


	
For each LDAP user name, the user role on each tapeplex they may access








VSM GUI User Names and User Role Definitions

VSM users can be any user names in your site's LDAP directory. The user name and login password for VSM GUI are the same as the user's LDAP login and password.

For each tapeplex a user is allowed to access, a user role is assigned that governs the level of VSM GUI access the user is allowed for that tapeplex.

There are three user roles:

	
VsmViewer: Accesses the Status and Display tabs, and the Administration – Database Update Log option, with no access to context menus, the Management and VSM Console tabs, and the other Administration options, on the specified tapeplex


	
VsmOperator: Accesses the Status, Display, Management, VSM Console and Administration – Database Update Log option, with no access to other Administration options, on the specified tapeplex


	
VsmGuiAdmin: Accesses the Status, Display, and Administration tabs (excluding access to context menus) across all tapeplexes




An LDAP user was identified during VM system configuration as the first VSM GUI user. This user's role is VsmGuiAdmin. You will log in as this user to perform initial site configuration.





Site Configuration Procedures

Site configuration procedures for VSM GUI are on the Administration menu. The procedures are in the form of a multi-page Site Configuration Wizard that steps you through the site configuration process.

To perform site configuration:

	
Open a browser to the static host IP address you defined for VSM GUI during VM system configuration.


	
At the login prompt, log in to VSM GUI using the LDAP user name you defined as the administrator during VM system configuration.


	
At the Dashboard, click the Administration tab and select Site Configuration to open the Site Configuration Wizard.


	
At the Introduction page, review the displayed information and then click Next Page to begin the configuration process.


	
At the Configure Supported Tapeplexes page, define the tapeplexes and the hosts that are connected to each tapeplex. Then click Next Page.


	
At the Configure Application Users page, define the LDAP user names that will be allowed VSM GUI access, the tapeplexes each user will be allowed to access, and the user's role for each accessible tapeplex. Then click Next Page.


	
At the Configure Alert Levels page, define the critical alert level thresholds for each VTSS in each supported tapeplex. Then click Next Page.


	
At the Configuration Properties page, fine-tune host cycle times and batch record sizes for your site if desired. Then click Next Page.


	
At the Summary page, review the configuration settings to ensure they are complete and accurate. To make changes, click Previous Page and Next Page to navigate among the pages.


	
When you are finished, click Done to close the Site Configuration Wizard. A dialog is displayed. Click OK to close the Site Configuration tab.







	
Note:

All site configuration data must be defined during the initial site configuration process but can be modified at any time.












Start Data Ingest Process






Start Data Ingest Process

The procedure for starting the ingest process depends on whether you have VSM GUI VM or oVTCS Console. In both cases, site configuration must already be completed for ingest to run successfully.

If you have VSM GUI VM, start the ingest process as follows:

	
Log in to VSM server as user vsmgui (password vsm6admin)


	
Open a command terminal and run the following command:

$ sudo service ingestd start




If you have oVTCS Console, start the ingest process as follows:

	
Log in to VSM GUI LDOM as user oracle (password vsmSQLadm)


	
Open a command terminal and run the following command:

$ sudo svcadm enable ingest







Access VSM GUI






Access VSM GUI

After site configuration and a successful ingest of data, the VSM GUI web application can be accessed on a client system using a local browser and the following URL:

http://server name or IP:7003/VSM_UI/faces/UIShell










Getting Started
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3 Getting Started

When VSM GUI has been installed and configured for your site, the VSM GUI web application can be accessed by authorized LDAP users on a client system using a local browser.





Log in to VSM GUI






Log in to VSM GUI

Open a local browser to the internal Web address for VSM GUI at your site. The VSM GUI administrator should provide this address if you are authorized to access VSM GUI.

When prompted, enter your LDAP user name and password and then click OK.

Login will continue if you are an authorized user. If not, contact the VSM GUI administrator for your site.




Accessibility Settings






Accessibility Settings

After a successful login, a dialog is displayed with Accessibility settings:

Click Screen Reader to activate screen reader mode on the application.

Click Do not show these options again to hide this dialog for future logins.

Click Continue to close the dialog and display the VSM GUI Dashboard. The Accessibility settings are remembered for future logins.




	
Note:

You can change the Accessibility settings at any time by clicking Accessibility Settings in the upper right corner of the VSM GUI application pages. The Accessibility dialog is displayed.










User Role






User Role

Different users have different levels of access to VSM GUI. For each user, a user role is assigned that governs the level of VSM GUI access the user is allowed. There are three user roles:

	
VsmViewer: views information in the GUI


	
VsmOperator: runs Management Commands and VSM Console activities


	
VsmGuiAdmin: Administers VSM GUI




Each user is assigned a VsmViewer or VsmOperator role for each tapeplex defined in the Site Configuration. All users of VSM GUI therefore have at least VsmViewer access to all the tapeplexes.

Users with the VsmViewer role can see the following:

	
Status menu: All menu items


	
Display menu: All menu items


	
Administration menu: Database Update Log




Users with the VsmOperator role can see all of the above plus the following:

	
Management menu: All menu items


	
VSM Console menu: All menu items




Users with the VsmGuiAdmin role can see the following in addition:

	
Administration menu: All menu items







Logging Off






Logging Off

To log off and end a VSM GUI session, click Logout at the upper right on any VSM GUI display screen.




VSM GUI Dashboard






VSM GUI Dashboard

Once you are logged in, the initial VSM GUI display is the Dashboard.

The Dashboard indicates current VSM system status and provides alerts for key performance metrics. The Dashboard is always available during a VSM GUI session.




VSM GUI Navigation Tree






VSM GUI Navigation Tree

The navigation tree left of the Dashboard contains links to the complete set of VSM GUI reports and commands. The links are organized in five menu tabs: Status, Display, Management, VSM Console, and Administration.

Click a tab to display its menu details. Your access to various functions depends on your user role.


Status

	
Dashboard


	
Active Processes


	
Queued Processes


	
Tasks








Display

	
Display CLINK


	
Display Cluster


	
Display Configuration


	
Display Drive


	
Display MVC


	
Display MVC Pool


	
Display VLE


	
Display VTD


	
Display VTSS


	
Display VTV








Management

	
Command Log


	
Audit


	
MVC Drain


	
Reclaim


	
Reconcile


	
Vary








VSM Console

	
Command Line Interface


	
Configuration/Policy


	
Console Log








Administration

	
Site Configuration


	
Application Logs


	
Database Update Log


	
User Activity Log















Status Menu
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Dashboard



	
Active Processes



	
Queued Processes



	
Tasks









Dashboard






Dashboard

The VSM GUI Dashboard indicates current VSM system status and provides alerts for key performance metrics.

The Dashboard is initially displayed when you log in to VSM GUI and remains active throughout the VSM GUI session. To re-display the Dashboard during a session, just click the Dashboard tab at the top of the pane.

Dashboard elements include:

	
Status


	
VTV Counts


	
Free MVCs


	
MVCs in Error




A database update error message is displayed at the top of the Dashboard if there has been an issue with the database refresh process. Click the error message to display the Database Update Log and manage the database refresh process manually.



Status

This data table shows current system status summarized for all VTSSs in each tapeplex or expanded to show each VTSS in a selected tapeplex.

To display, select Status and Dashboard on the navigation tree.

You may need to scroll horizontally or detach the table to view all columns.

Click the Expand button left of the tapeplex name to display the VTSSs for that tapeplex.

The status for each field is summarized with a status indicator:


	Icon	Name	Description
	[image: Surrounding text describes good.jpg.]
	Good	Indicates no threshold violations are detected
	[image: Surrounding text describes caution.jpg.]
	Caution	Indicates warning thresholds have been exceeded
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates critical thresholds have been exceeded
	[image: Surrounding text describes unknown.jpg.]
	Unknown	Indicates status could not be detected






Click a status indicator to display its details:

	
Click a VTSS Status or DBU indicator to view the Display VTSS panel filtered for the selected tapeplex or VTSS.


	
Click a RTDs or vRTDs indicator to view the Display Drive panel filtered for that drive type on the selected tapeplex or VTSS.


	
Click an IPCLINKs or FICON CLINKs indicator to view the Display CLINK panel filtered for the selected tapeplex or VTSS.


	
Click a Migrate Queue or Replication Queue indicator to view the Queued Processes panel filtered for the selected tapeplex or VTSS.




Table columns and descriptions include:


	Column	Description
	Tapeplex VTSS	The tapeplex name and the VTSS names in the tapeplex.
	VTSS Status	Indicates VTSS status:
Good: Indicates the VTSS is Online.

Warning: Indicates the VTSS is Online-p, Quiescing, Quiesced, or Started.

Critical: Indicates the VTSS is Offline or Offline-p.

Unknown: Indicates a value other than Online, Online-p, Offline, Offline-p, Quiescing, Quiesced, or Started.


	DBU	Indicates the DBU level:
Good: Indicates the DBU is less than the high auto-migrate threshold (HAMT).

Warning: Indicates the DBU is greater than or equal to the high auto-migrate threshold (HAMT).

Critical: Indicates the DBU is greater than the alert level for this VTSS.

Unknown: Indicates the DBU, alert level, or HAMT values are missing.


	RTDs	Indicates the RTD status:
Good: Less RTDs are offline than the warning number for this VTSS.

Warning: More RTDs are offline than the warning number for this VTSS.

Critical: More RTDs are offline than the critical number for this VTSS.

Unknown: Status of some RTDs is unknown, or critical/warning alert levels are missing.


	vRTDs	Indicates the vRTD status:
Good: Less vRTDs are offline than the warning number for this VTSS.

Warning: More vRTDs are offline than the warning number for this VTSS.

Critical: More vRTDs are offline than the critical number for this VTSS

Unknown: Status of some vRTDs is unknown, or critical/warning alert levels are missing.


	IP CLINKs	Indicates the IP Clinks status:
Good: Less IP CLINKs are offline than the warning number for this VTSS.

Warning: More IP CLINKs are offline than the warning number for this VTSS.

Critical: More IP CLINKs are offline than the critical number for this VTSS.

Unknown: Status of some IP CLINKs is unknown, or critical/warning alert levels are missing.


	FICON CLINKs	Indicates the FICON CLINKs status:
Good: Less FICON CLINKs are offline than the warning number for this VTSS.

Warning: More FICON CLINKs are offline than the warning number for this VTSS.

Critical: More FICON CLINKs are offline than the critical number for this VTSS


	Migrate Queue	Indicates the migrant queue level status:
Good: Less Migration processes in the queue than the warning number for this VTSS.

Warning: More Migration processes in the queue than the warning number for this VTSS.

Critical: More Migration processes in the queue than the critical number for this VTSS.

Unknown: Critical/warning alert levels are missing, or Queued Processes data is missing.


	Replication Queue	Indicates the replication queue level status:
Good: Less Replication processes in the queue than the warning number for this VTSS.

Warning: More Replication processes in the queue than the warning number for this VTSS.

Critical: More Replication processes in the queue than the critical number for this VTSS.

Unknown: Critical/warning alert levels are missing, or Queued Processes data is missing.








Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Expand	Show individual VTSSs in the selected tapeplex
	Expand All Below	Expands all tapeplexes below the current selection
	Collapse All Below	Collapses all tapeplexes below the current selection
	Expand All	Expands all tapeplexes
	Collapse All	Collapse all tapeplexes
	Scroll to First	Scroll to the top of the list of tapeplexes
	Scroll to Last	Scroll to the bottom of the list of tapeplexes
	Reorder Columns	Select the column sequence for Visible columns






Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










VTV Counts

This graph shows VTV scratch and resident counts for each tapeplex.

To display, select Status and Dashboard on the navigation tree.

Hover the mouse on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Free MVCs

Free MVCs reports show free MVC status for MVC Pools or media types:

To display, select Status and Dashboard on the navigation tree.



Free MVCs: MVC Pools

The MVC Pools data table indicates Free MVCs current status for each MVC Pool on each tapeplex.

The status for each field is summarized with a status indicator:


	Icon	Name	Description
	[image: Surrounding text describes good.jpg.]
	Good	Indicates no threshold violations are detected
	[image: Surrounding text describes caution.jpg.]
	Caution	Indicates warning thresholds have been exceeded
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates critical thresholds have been exceeded
	[image: Surrounding text describes unknown.jpg.]
	Unknown	Indicates status could not be detected






Click a status indicator to display its details:

MVC Pools are shown to be in a critical state if the number of free MVCs is less than the Minimum Free MVCs value for the pool.

MVC Pools are shown to be in a warning state if the number of free MVCs is equal to than the Minimum Free MVCs value for the pool.

MVC Pools are shown to be in a good state if the number of free MVCs is greater than the Minimum Free MVCs value for the pool.

MVC Pools are shown to be in an unknown state if the Minimum Free MVCs value or the number of free MVCs is not known.

Hover the mouse on an object to display summary data for the object.

Click an MVC Pool in the data table to show the Display MVC Pool panel, filtered for that MVC Pool.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Free MVCs: Media

The Media graph shows Free MVCs sorted by media type.

Click an object in the graph to show the Display MVC panel, filtered for that media type.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard












MVCs in Error

MVCs in Error reports show MVCs in error sorted by MVC Pool or media type:

To display, select Status and Dashboard on the navigation tree.



MVCs in Error: MVC Pools

The MVC Pools graph show MVCs in error, sorted by MVC Pool.

Hover on an object to display summary data for the object.

Click an MVC Pools object to show the Display MVC Pool panel, filtered for that MVC Pool.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










MVCs in Error: Media

The Media graphs show MVCs in error, sorted by media type.

Hover on an object to display summary data for the object.

Click a media object to show the Display MVC panel, filtered for that media type.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard












Active Processes






Active Processes

This data table shows the active processes for all tapeplexes at the time displayed.

To display, select Status and Active Processes on the navigation tree.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can cancel a process by right clicking its Process ID to display a context menu with an option to cancel the process.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex name.
	Host	The host running the process.
	Process ID	The Process ID for the function, which is a unique number in the range 0 - 65536. When the process ID reaches 65536 it wraps back to zero.
	Function	The type of request:
AllocSCR: Job allocation request for a scratch VTV.

AllocVTV: Job allocation request for a specific VTV.

Audit#: Audit utility request.

Cancel@: Cancel command.

Consold#: Consolidate or export utility task.

Consolid: Recall VTVs for remigration to a consolidation MVC. This appears as a child request to an Int_cons or Consold# request.

Dismount: Dismount a VTV from a VTD.

Display@: Display or query command.

Drain: Recall VTVs from MVC for remigration during drain or reclaim processing. This is a child of a VtvMover request.

Drain@: Drain command or utility.

DrainMVC: There is one DrainMVC request per MVC being drained. DrainMVC, which is a child request of a Drain@ request, is responsible for managing the entire drain process for a single MVC. The VTV column indicates the status of the processing against the MVC.

DELETSCR: Delete scratch utility.

Getmgpol: Obtain current management and storage class definitions.

Getconfig: Get configuration information

HSCChnge: Notification of parameter files being changed.

Import#: Importing of VTV or MVC by a utility.

Int_cons: PGMI initiated consolidate request

MEDVERfy: Media Verify parent task

Migrate: General request to perform the migrations of VTVs to a MVC. This may appear as a child to other request types.

Migrate@: Migrate command or utility. This includes migrates to threshold and auto migrates.

Mount: Mount a VTV upon a VTD. Depending upon circumstances, this may be subsequently seen as a VTV transfer or recall request.

Move MVC: There is one Move MVC request per MVC being processed by reconcile or archive. Move MVC, which is a child request of a MoveVTV# request, is responsible for managing the entire VTV movement process for a single MVC. The VTV column indicates the status of the processing against the MVC.


	
	MoveVTV#: This is a request from the ARCHIVE or RECONCILE utility commands to move copies of VTVs between MVCs. The value -TIME- in the VTV column indicates that the ELAPSED parameter was specified.
MvcMaint: MVCMAINT utility request.

MVC_chek: Check status of MVC.

MVC_eot: Reset the end of tape position of a MVC after completing a drain or reclaim. This is a child of either a DrainMVC, ReclmMVC or Move MVC request.

MVC_inv: Audit of an MVC. This appears as a child request to an Audit# request.MVCpool#: Obtain details and status of MVC pools for a utility.PGMI_req: A request received through the PGMI interface that has yet to be decoded.Query@l: Query or Display command.

MVC_upd: Reset or update MVC status.

Recall: General request to perform the recall of VTVs from a MVC. This may include a Cross TapePlex Autorecall (CTA) request from the mounting system. Recall may appear as a child to other request types.

Recall@: Recall command or utility.

Reclaim@: Auto reclaim request or a Reclaim command or utility. The value -TIME- in the VTV column indicates that the ELAPSED parameter was specified.

ReclmMVC: There is one ReclmMVC request per MVC being reclaimed. ReclmMVC, which is a child request of a Reclaim@ request, is responsible for managing the entire reclaim process for a single MVC. The VTV column indicates the status of the processing against the MVC.

Reconcil: Perform a crosscheck between the contents of the two VTSSs in a cluster.

Replicat: Perform the replication of VTVs between VTSSs in a cluster.

Scratch: Scratch a VTV request from HSC.

Sel_scr: PGMI select scratch

Set@: Set command.

Transfer: Mount a VTV upon a VTD by transferring the VTV between two VTSSs.

Unload: Unload MVC from RTD.

Uscratch: Unscratch a VTV request from HSC.

Vary_dev: Perform very processing against an individual RTD or CLINK. This appears as a child request to an VARY@ request.

Vary@: Vary command.

VtvMaint: VTVMAINT utility request.


	
	VTVMover: There is one VTVMover request per MVC being drained or reclaimed. This is a child of either a DrainMVC, ReclmMVC or Move MVC request. This request is responsible for the movement of VTVs from one MVC to another.
VTSS_inv: Audit of a VTSS. This appears as a child request to an Audit# request.

VTSS_list: Obtain a list of VTV resident within a VTSS. This appears as a child request to a Reconcil or auto migration request.

VTV_upd: Resynchronize VTV status in the VTSS with the CDS.


	Parent ID	The ID of the parent process associated with the request.
	VTSS	The VTSS name or the VTSS list name associated with the request.
	VTV Volser	The volser of the VTV currently being used in the process.
	MVC Volser	The volser of the MVC currently being used in the process.
	RTD Device Address	The unit address of the RTD currently being used in the process.
	VTD Device Address	The device address of the VTD currently being used in the process
	Task Type	The task that is processing the queue or the task to which the request is queued.
	Reason	The reason why the process is active.
	ACS	The ACS the process is using.
	LSM	The LSM the process is using.
	Storage Manager	The Storage manager the process is using.
	Internal Device Type	The Internal device type the process is using.
	For Mount	Indicates if the process is for a mount.
	For VTV Move	Indicates if the process is for VTV moves.
	Local Wait Time (mins)	The local wait time in minutes.
	Storage Class	The storage class for migration targets.
	Refreshed	The date and UTC time the data was stored or updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove Filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard








Cancel a Process

To cancel a process, right click the Process Id for that process.

A context menu is displayed. Click Cancel on the context menu.

A dialog is displayed with details about the selected process.

Click Submit to cancel the selected process, or just close the Cancel tab to not submit the request.






Queued Processes






Queued Processes

This data table shows the queued processes for all tapeplexes at the time displayed.

To display, select Status and Queued Processes on the navigation tree.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can cancel a process by right clicking its Process ID to display a context menu with an option to cancel the process.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex name.
	Host	The host running the process.
	Process ID	The Process ID for the function, which is a unique number in the range 0 - 65536. When the process ID reaches 65536 it wraps back to zero.
	Function	The type of request:
AllocSCR: Job allocation request for a scratch VTV.

AllocVTV: Job allocation request for a specific VTV.

Audit#: Audit utility request.

Cancel@: Cancel command.

Consold#: Consolidate or export utility task.

Consolid: Recall VTVs for remigration to a consolidation MVC. This appears as a child request to an Int_cons or Consold# request.

Dismount: Dismount a VTV from a VTD.

Display@: Display or query command.

Drain: Recall VTVs from MVC for remigration during drain or reclaim processing. This is a child of a VtvMover request.

Drain@: Drain command or utility.

DrainMVC: There is one DrainMVC request per MVC being drained. DrainMVC, which is a child request of a Drain@ request, is responsible for managing the entire drain process for a single MVC. The VTV column indicates the status of the processing against the MVC.

DELETSCR: Delete scratch utility.

Getmgpol: Obtain current management and storage class definitions.

Getconfig: Get configuration information

HSCChnge: Notification of parameter files being changed.

Import#: Importing of VTV or MVC by a utility.

Int_cons: PGMI initiated consolidate request

MEDVERfy: Media Verify parent task

Migrate: General request to perform the migrations of VTVs to a MVC. This may appear as a child to other request types.

Migrate@: Migrate command or utility. This includes migrates to threshold and auto migrates.

Mount: Mount a VTV upon a VTD. Depending upon circumstances, this may be subsequently seen as a VTV transfer or recall request.

Move MVC: There is one Move MVC request per MVC being processed by reconcile or archive. Move MVC, which is a child request of a MoveVTV# request, is responsible for managing the entire VTV movement process for a single MVC. The VTV column indicates the status of the processing against the MVC.


	
	MoveVTV#: This is a request from the ARCHIVE or RECONCILE utility commands to move copies of VTVs between MVCs. The value -TIME- in the VTV column indicates that the ELAPSED parameter was specified.
MvcMaint: MVCMAINT utility request.

MVC_chek: Check status of MVC.

MVC_eot: Reset the end of tape position of a MVC after completing a drain or reclaim. This is a child of either a DrainMVC, ReclmMVC or Move MVC request.

MVC_inv: Audit of an MVC. This appears as a child request to an Audit# request.MVCpool#: Obtain details and status of MVC pools for a utility.PGMI_req: A request received through the PGMI interface that has yet to be decoded.Query@l: Query or Display command.

MVC_upd: Reset or update MVC status.

Recall: General request to perform the recall of VTVs from a MVC. This may include a Cross TapePlex Autorecall (CTA) request from the mounting system. Recall may appear as a child to other request types.

Recall@: Recall command or utility.

Reclaim@: Auto reclaim request or a Reclaim command or utility. The value -TIME- in the VTV column indicates that the ELAPSED parameter was specified.

ReclmMVC: There is one ReclmMVC request per MVC being reclaimed. ReclmMVC, which is a child request of a Reclaim@ request, is responsible for managing the entire reclaim process for a single MVC. The VTV column indicates the status of the processing against the MVC.

Reconcil: Perform a crosscheck between the contents of the two VTSSs in a cluster.

Replicat: Perform the replication of VTVs between VTSSs in a cluster.

Scratch: Scratch a VTV request from HSC.

Sel_scr: PGMI select scratch

Set@: Set command.

Transfer: Mount a VTV upon a VTD by transferring the VTV between two VTSSs.

Unload: Unload MVC from RTD.

Unscratch: Unscratch a VTV request from HSC.

Vary_dev: Perform very processing against an individual RTD or CLINK. This appears as a child request to an VARY@ request.

Vary@: Vary command.

VtvMaint: VTVMAINT utility request.


	
	VTVMover: There is one VTVMover request per MVC being drained or reclaimed. This is a child of either a DrainMVC, ReclmMVC or Move MVC request. This request is responsible for the movement of VTVs from one MVC to another.
VTSS_inv: Audit of a VTSS. This appears as a child request to an Audit# request.

VTSS_list: Obtain a list of VTV resident within a VTSS. This appears as a child request to a Reconcil or auto migration request.

VTV_upd: Resynchronize VTV status in the VTSS with the CDS.


	Parent ID	The ID of the parent process associated with the request.
	VTSS	The VTSS name or the VTSS list name associated with the request.
	VTV Volser	The volser of the VTV currently being used in the process.
	MVC Volser	The volser of the MVC currently being used in the process.
	RTD Device Address	The unit address of the RTD currently being used in the process.
	VTD Device Address	The device address of the VTD currently being used in the process
	Task Type	The task that is processing the queue or the task to which the request is queued.
	Reason	The reason why the process is active.
	ACS	The ACS the process is using.
	LSM	The LSM the process is using.
	Storage Manager	The Storage manager the process is using.
	Internal Device Type	The Internal device type the process is using.
	For Mount	Indicates if the process is for a mount.
	For VTV Move	Indicates if the process is for VTV moves.
	Local Wait Time (mins)	The local wait time in minutes.
	Storage Class	The storage class for migration targets.
	Refreshed	The date and UTC time the data was stored or updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove Filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard







Cancel a Process

To cancel a process, right click the Process Id for that process.

A context menu is displayed. Click Cancel on the context menu.

A dialog is displayed with details about the selected process.

Click Submit to cancel the selected process, or just close the Cancel tab to not submit the request.






Tasks






Tasks

This data table shows all tasks for all tapeplexes at the time displayed.

To display, select Status and Tasks on the navigation tree.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex the task is on.
	Host	The host.
	Task Number	The task number for each task on the current host.
	Task Type	INV: Inventory Manager
CMD: Command Task

DSP: Dispatcher Task

SS: VTSS Task

RTD: RTD Task

DRV: RTD Scheduler

SCR: Scratch Manager

RCM: Reclaim Manager

MSC: Migration Scheduler

CSH: Clink Scheduler

CLK: CLINK Task

UNK: Unknown


	Slot ID	The Slot ID of the lock within the lock buffer.
	VTSS	The VTSS the task is on.
	VTV Volser	The volser of the VTV used in the task.
	MVC Volser	The volser of the MVC used in the task.
	Path Name	The RTD, VTD, or path the task is using.
	Device Address	The RTD or VTD device address the task is using.
	VTD Device Address	The device address of the VTD that is using the task.
	Task Lock	Indicates lock status for the task. A task lock generally indicates contention with another host.
	VTV Lock	Indicates if the VTV in the task is locked.
	MVC Lock	Indicates if the MVC in the task is locked.
	RTD Lock	Indicates if the RTD in the task is locked.
	VTD Lock	Indicates if the VTD in the task is locked.
	Waiting Count	The count of requests waiting for locks.
	Pending Count	The count of pending requests.
	Function	The function of the task.
	Process ID	The process ID of the task.
	Parent ID	The process ID of the parent process.
	ACS	The ACS the task is using.
	LSM	The LSM the task is using.
	Storage Manager	The storage manager the task is using.
	Internal Device Type	The local wait time in minutes.
	For Mount	Indicates if the process is for a mount.
	For VTV Move	Indicates if the process is for VTV moves.
	Local Wait Time (mins)	The local wait time in minutes.
	Storage Class	The storage class for migration targets.
	Refreshed	The date and UTC time the data was stored or updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard
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5 Display Menu
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Display CLINK

This pane displays Cluster Links (CLINKS) information.

To display, select Display and CLINK on the navigation tree.



Cluster Links (CLINKS)

This data table shows CLINK information.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex.
	VTSS	The primary or sending VTSS name.
Context menu: Audit VTSS, Vary VTSS.


	Partner Tapeplex	The partner tapeplex in the cluster.
	Partner VTSS	The secondary or receiving VTSS in the cluster.
Context menu: Audit VTSS, Vary VTSS.


	CLINK ID	The CLINK ID that has been assigned to the CLINK within the VTSS.
Context menu: Vary CLINK.


	Channel ID	The back-end channel interface to which the CLINK is connected.
	IPIFID	The IPIF ID of the CLINK.
	Cluster	The cluster name if the CLINK is used for replication of VTVs within the tapeplex and is part of a cluster. The VTSS name in the Partner VTSS column indicates the other VTSS that operates in the cluster.
	Status	One of the following:
MAINT: The link has failed or it has been varied into maintenance mode.

OFFLINE: The link is offline and unavailable to all hosts and VTSSs.

ONLINE: The link is online and available to all hosts and VTSSs.

ON-SYNC: Available for synchronous replication.

ON-ASYNC: Available for asynchronous replication.

P_OFFLINE: The link is pending offline.

P_ONLINE: The link is pending online.

RECOVERY: The link is being reset following an error or a vary online operation.

UNUSABLE: Not available for replication due to hardware errors or assigned-elsewhere conditions.

UUI ERR: This is a CLINK defined for electronic export and it has been unable to contact the remote VTCS. There should be messages in the HSC JOBLOG that indicate the reason for the problem. This could include problems with the definitions, the local SMC, or the remote HTTP server on the remote VTCS.


	Usage	One of the following:
ASSIGNED: Link is assigned to the host in the HOST field but is not currently replicating. This usage occurs when VTCS is starting or terminating link use or is attempting error recovery on the link after a replication failure.

FREE: Link is idle (not doing replications).

REPLICATING: Link is actively doing replications.


	Host	The host that the link is assigned to.
	Partner VTD	The address of the VTD on the partner VTSS that forms the other end point to the connection. For a cluster link, the host address of the VTD is reported. For an electronic export link, this is not possible as there is no access to the other tapeplex configuration. In this case, only the ordinal number of the VTV is reported.
	Replication Capability	Indicates the CLINK is available for synchronous or asynchronous replication.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









CLINK Status

This graph shows current CLINK counts for each VTSS, sorted by current status.

Hover on an object to display summary data for the object.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









CLINK Usage

This graph shows current CLINK usage for each VTSS, sorted by current usage state.

Hover on an object to display summary data for the object.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Detach Pane icon]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Detach Pane icon]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard
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Display Cluster

This pane displays Cluster information.

To display, select Display and Cluster on the navigation tree.



Clusters

This data table shows Cluster information.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Select a row to display data for that Cluster in the CLINKs for Cluster data table.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Cluster	The cluster name.
	Tapeplex	The tapeplex name.
	VTSS	One of the VTSSs in the cluster.
Context menu: Audit VTSS, Vary VTSS.


	Direction	The direction of the link between the VTSSs, either TO, FROM, or PEER:
TO or FROM indicate the direction of VTV replication in Uni-Directional Cluster. VTVs can only be replicated from the Sending to the Receiving VTSS.

PEER indicates that the VTSSs are configured as a Bi-Directional (Peer-to-Peer) Cluster. VTVs can be replicated from either VTSS to the other.


	Partner VTSS	The partner VTSS in the cluster.
Context menu: Audit VTSS, Vary VTSS.


	Mode	One of the following cluster operating modes:
ASYNC-REPLICATE: Both VTSSs in the cluster are online to VTCS. Production workload can go to either VTSS, but for a unidirectional (primary/secondary) cluster, VTVs can only be replicated from the sending VTSS. Synchronous replication is not enabled across the cluster.

SYNC-REPLICATE: Both VTSSs in the cluster are online to VTCS. Production workload can go to either VTSS, but for a unidirectional (primary/secondary) cluster, VTVs can only be replicated from the sending VTSS. Synchronous replication is enabled across the cluster.

DEGRADED: One of the two VTSSs in a bidirectional peer-to-peer cluster is either offline or quiesced. Production workload can go the remaining online VTSS. VTVs requiring replication, however, are allocated to the remaining VTSS only if no other full-function clusters are available and suitable. In this case, replicate VTVs are migrated immediately with keep and queued for replication when the other VTSS comes online. When the other VTSS comes online, VTCS reconciles the contents of both VTSSs.

DEGRADED SECONDARY: The primary is online to VTCS and the secondary is either offline or quiesced. Workload can run on the primary. VTVs requiring replication, however, are allocated to the primary only if no other full-function clusters are available. In this case, replicate VTVs are migrated immediately with keep and are queued for replication, which occurs when the secondary comes online.

DEGRADED PRIMARY: The secondary is online to VTCS and the primary is either offline or quiesced. Workload can run on the secondary. VTVs requiring replication, however, are allocated to the secondary only if no other full-function clusters are available. When the primary comes back online, VTCS reconciles the contents of the primary and secondary.

NON-OPERATIONAL: No workload is possible on this cluster.

CLINKS OFFLINE: All defined CLINKs are offline. No workload is possible on this Cluster.

ONLY SECONDARY: The Secondary is online to VTCS and the Primary has no CLINKs online. Workload can run on the Secondary. VTVs requiring replication, however, are allocated to the Secondary only if no other Full Function Clusters are available.

ONLY PRIMARY: The Primary is online to VTCS and the Secondary has no CLINKs online. Workload can run on the Primary. VTVs requiring replication, however, are allocated to the Primary only if no other Full Function Clusters are available. In this case, Replicate VTVs are migrated immediately with keep and are queued for replication.

FULL-FUNCTION: Indicates that both VTSSs are operational. If something goes wrong with the state of either VTSS, then it reports as degraded or non-operational.

Tracks MVC chaining when a file runs off the end of one volume onto another.


	Replication Capability	Indicates the cluster is available for synchronous or asynchronous replication.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










CLINKs for Cluster

This data table displays CLINKs for the Cluster selected in the Clusters data table.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	CLINK ID	The CLINK ID that has been assigned to the CLINK within the VTSS.
	Channel ID	The back-end channel interface to which the CLINK is connected.
	IPIF ID	The IPIF ID of the CLINK.
	Status	One of the following:
Maint: The link has failed or it has been varied into maintenance mode.

OFFLINE: The link is offline and unavailable to all hosts and VTSSs.

ONLINE: The link is online and available to all hosts and VTSSs.

ON-SYNC: Available for synchronous replication.

ON-ASYNC: Available for asynchronous replication.

P_OFFLINE: The link is pending offline.

P_ONLINE: The link is pending online.

RECOVERY: The link is being reset following an error or a vary online operation.

UNUSABLE: Not available for replication due to hardware errors or assigned-elsewhere conditions.

UUI ERR: This is a CLINK defined for electronic export and it has been unable to contact the remote VTCS. There should be messages in the HSC JOBLOG that indicate the reason for the problem. This could include problems with the definitions, the local SMC, or the remote HTTP server on the remote VTCS.


	Usage	One of the following:
Assigned: Link is assigned to the host in the HOST field but is not currently replicating. This usage occurs when VTCS is starting or terminating link use or is attempting error recovery on the link after a replication failure.

Free: Link is idle (not doing replications).

Replicating: Link is actively doing replications.


	Host	The host that the link is assigned to.
	Partner VTD	The address of the VTD on the partner VTSS that forms the other end point to the connection. For a cluster link, the host address of the VTD is reported. For an electronic export link, this is not possible as there is no access to the other tapeplex configuration. In this case, only the ordinal number of the VTV is reported
	Replication Capability	Indicates the CLINK is available for synchronous or asynchronous replication.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Selected Row Data	Show data for selected rows
	[image: Remove Pane icon]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Remove Pane icon]
	Filter	Filter the data
	[image: Remove Pane icon]
	Remove filter	Remove the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard
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Display Configuration

This pane displays Configuration information.

To display, select Display and Configuration on the navigation tree.

Use the First Previous Next Last buttons to navigate among different tapeplexes.

Click the Print icon to display the form data in a separate window for printing.

Click the Refresh icon to refresh the data from the VSM GUI database or the Run ELS icon to refresh the actual configuration data by running appropriate ELS commands on the host.

Columns and descriptions include:


	Column	Description
	VTSS Subsystems	Indicates the number of VTSSs in the tapeplex.
	Global Max VTV	Indicates the maximum number of VTVs that can be migrated to a single MVC.
	Global MVC Free	Indicates the minimum number of free MVCs in the MVC pool that causes VTCS to start an automatic space reclamation.
	Global VTV Attribute	Indicates when VTCS assigns a Management Class to a VTV, either ALLmount to assign a class whenever VTCS mounts the VTV or Scratch to assign a class only when VTCS does a scratch mount of the VTV.
	Global Recall with Error	Indicates whether VTCS recalls VTVs with read data checks during recall and drain operations, either Yes or No.
	Global Replication	Indicates when VSM replicates a VTV, either Always to replicate whenever the VTV is dismounted or Changed to replicate only if the VTV was Changed while it was mounted.
	Global VTV Page Size	Indicates the page size for VTV data stored in the VTSS and on the MVCs, either Standard or Large.
	Global Sync Replicate	Indicates whether the VTV synchronous replication feature is enabled, either Yes or No.
	Global Max RTDs	Indicates the maximum number of RTDs supported.
	Global Fast Migrate	Indicates whether the stacked/streamed migrates feature is enabled, either Stacked (or Yes) to enable the stacked method for migration, Stream to enable the streaming method, or No to disable the feature.
	Global Init MVC	Indicates whether un-initialized MVCs are to be initialized when they are first mounted, either Yes or No.
	Global Maximum VTV Size (MB)	Indicates the default maximum VTV size that is used during the creation of VTVs.
	Global Fast Reclaim	Indicates whether VTCS should perform Early Time to First Byte (ETTFB) concurrent tape recall/mount, either Yes or No.
	Global Locktout	Indicates the minimum number of minutes that a resource is locked before message SLS6946E is issued.
	Global Non-Library Drain	Indicates whether VTCS accepts non-library resident MVCs for drain/reclaim processing, either Yes to mount the non-Library MVC or No to suppress the mount and purge the request.
	Global Non-Library Migrate	Indicates whether non-library resident MVCs are selected for migration processing, either Yes or No.
	Global Non-Library Reclaim	Indicates whether non-library resident MVCs are selected for reclaim processing, either Yes or No.
	Global MVC Mount Timeout (mins)	Indicates the value in minutes when an MVC mount time out occurs.
	Global Log Policy	Indicates whether VTCS CDS logging is Optional or Required.
	Global Lock Structure	Indicates the Coupling Facility Structure that holds VTCS Lock Data.
	CDS Compatible Level 7.0	Indicates the CDS is compatible with ELS release 7.0.
	CDS Compatible Level 7.1	Indicates the CDS is compatible with ELS release 7.1.
	CDS Compatible Level 7.2	Indicates the CDS is compatible with ELS release 7.2.
	CDS Compatible Level 7.3	Indicates the CDS is compatible with ELS release 7.3
	Reclaim Max MVC	Indicates the maximum number of MVCs that are processed by a single space reclamation task.
	Reclaim Start	Indicates the percentage level at which automatic space reclamation starts for each ACS.
	Reclaim Max Concurrent MVCs	Indicates the maximum number of MVCs that VTCS concurrently processes for both drain and reclaim.
	Reclaim Threshold (%)	Indicates the percentage of fragmented space that makes an MVC eligible for demand or automatic reclamation.
	Reclaim Threshold (%) - VL	Indicates the percentage of fragmented space that makes a Virtual MVC (VMVC) eligible for demand or automatic reclamation
	Global Reclaim Inplace	Indicates whether dynamic reclaim supported is enabled within VTCS, either Yes or No.
	Reclaim Inplace Threshold (%)	Indicates the percentage of fragmented space that makes an MVC in partitioned format eligible for space reclamation processing.
	Reclaim Protect	Indicates the time in hours to prevent (or protect) an MVC from being re-used after it is drained or reclaimed.
	CDS Free Blocks	The difference between the minimum space required and the size of the CDS.
	Refreshed	The date and UTC time the data was stored or last updated.






Click the icons above the configuration details to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard
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Display Drive

This pane displays Real Tape Drive and virtual Real Tape Drive information.

To display, select Display and Drive on the navigation tree.



Drives (RTDs and vRTDs)

This data table displays RTD and vRTD drive information.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Click a row to display paths to that drive in the Paths to Drive data table.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex.
	Device Address	The RTD Address.
Context menu: Vary Drive.


	VLE	The VLE that the vRTD is on.
	Owner VTSS	The VTSS that is currently connected to the RTD.
	Device Type	The device type (RTD Type) of the RTD.
	Partitioning Support	The partitioning support setting, Yes, No, or Unknown.
	ACS	The ACS the RTD is attached to.
	LSM	The LSM the RTD is attached to.
	Status	One of the following RTD statuses:
RECOVER RTD: The RTD is being reset after a problem, a vary, or an initialization.

MIGRATE VTV: The RTD is migrating a VTV.

RECALL VTV: The RTD is recalling a VTV.

UNLOAD MVC: A forced unload of the RTD is occurring.

VTV TRANSFER: The RTD is migrating a VTV before recalling it on another VTSS.

AUDIT MVC: An MVC is being audited.

BUSY: The RTD is busy (non-specific task).

IDLE: An MVC is allocated to the RTD but the MVC is not being used.

ONLINE/FREE: The RTD is online and available.

MAINTENANCE: The RTD is in maintenance mode.

OFFLINE: The RTD is offline and unavailable to all hosts and VTSSs

RECOVERY: The RTD is being reset after an error or a vary online.

INITIALIZE: The host is verifying RTD status and availability.

SUSPEND: The RTD operations are suspended. This occurs when one or more RTDs and a CLINK are configured on the same port. The RTDs remain in SUSPEND mode while the CLINK is online.

PATH OFFLINE: The RTD status is unknown because the VTSS cannot contact the RTD or if the paths were not correctly configured.

PATH SUSPEND: The RTD is globally online but the path from the VTSS is suspended due to the RTD being paired with a Clink.

FAIL/OFFLINE: The RTD was placed offline due to a failure.

TOP ID: The process Id of the request that is top of the queue for next using this RTD from this host.

TOP HOST: The host which has the request that is top of the queue for next using this RTD.


	MVC Allocated	The volser of the MVC allocated for mounting on the RTD.
	MVC Mounted	The MVC that is currently mounted on the RTD.
	Host	The host that currently owns the RTD.
	MVC Volser	The volser of the MVC currently mounted on the RTD or allocated to the RTD for mounting.
	Requests Queued	The number of requests that are currently queued.
	Allocation Time Remaining (mins)	The allocation time remaining, in minutes.
	Local Wait Time (mins)	The local wait time, in minutes.
	Global Wait Time (mins)	The global wait time, in minutes.
	Internal Device Type	The internal coding of the device type.
	Serial Number	The serial number of the RTD.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Selected Row Data	Show data for selected rows
	[image: Remove Pane icon]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Remove Pane icon]
	Filter	Filter the data
	[image: Remove Pane icon]
	Remove filter	Remove the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Paths to Drive

This data table displays path information about the selected drive.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	VTSS	The VTSS name.
	Path Name	The drive path name.
	Status	The drive's current status.
RECOVER RTD: The RTD is being reset after a problem, a vary, or an initialization.

MIGRATE VTV: The RTD is migrating a VTV.

RECALL VTV: The RTD is recalling a VTV.

UNLOAD MVC: A forced unload of the RTD is occurring.

VTV TRANSFER: The RTD is migrating a VTV before recalling it on another VTSS.

AUDIT MVC: An MVC is being audited.

BUSY: The RTD is busy (non-specific task).

IDLE: An MVC is allocated to the RTD but the MVC is not being used.

ONLINE/FREE: The RTD is online and available.

MAINTENANCE: The RTD is in maintenance mode.

OFFLINE: The RTD is offline and unavailable to all hosts and VTSSs

RECOVERY: The RTD is being reset after an error or a vary online.

INITIALIZE: The host is verifying RTD status and availability.

SUSPEND: The RTD operations are suspended. This occurs when one or more RTDs and a CLINK are configured on the same port. The RTDs remain in SUSPEND mode while the CLINK is online.

PATH OFFLINE: The RTD status is unknown because the VTSS cannot contact the RTD or if the paths were not correctly configured.

PATH SUSPEND: The RTD is globally online but the path from the VTSS is suspended due to the RTD being paired with a Clink.

FAIL/OFFLINE: The RTD was placed offline due to a failure.

TOP ID: The process Id of the request that is top of the queue for next using this RTD from this host.

TOP HOST: The host which has the request that is top of the queue for next using this RTD.


	Channel ID	The channel ID of the drive path.
	IPIF ID	The IPIF value that was specified for the path.
	Logical Device ID	The logical device ID assigned to the path.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Selected Row Data	Show data for selected rows
	[image: Remove Pane icon]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Remove Pane icon]
	Filter	Filter the data
	[image: Remove Pane icon]
	Remove filter	Remove the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









Drive Status

This graph shows the current drive count by device type, sorted by drive status.

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects in the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Pane Information icon]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Detach Pane icon]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Detach Pane icon]
	Pie chart	Display the graph as a pie chart
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









Drive Allocation

This graph shows the current drive count by device type, sorted by allocation state.

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Pane Information icon]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Detach Pane icon]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Detach Pane icon]
	Pie chart	Display the graph as a pie chart
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









Drive Requests Queued

This graph shows the current number of requests queued at each device address.

Hover on an object to display summary data for the object.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Pane Information icon]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Display MVC






Display MVC

This pane displays Multi-Volume Cartridge information.

To display, select Display and MVC on the navigation tree.



Multi-Volume Cartridges (MVCs)

This data table shows MVC information.

You may need to scroll horizontally or detach the table to view all columns.

Click a row to display VTVs for that MVC in the VTVs on MVC data table.

The status for some fields is summarized with a status indicator:


	Icon	Name	Description
	[image: Surrounding text describes good.jpg.]
	Good	Indicates no threshold violations are detected
	[image: Surrounding text describes caution.jpg.]
	Caution	Indicates warning thresholds have been exceeded
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates critical thresholds have been exceeded
	[image: Surrounding text describes unknown.jpg.]
	Unknown	Indicates status could not be detected






Click a status indicator to display its details.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex the MVC belongs to.
	MVC Volser	The volser of the MVC.
Context menu: Audit MVC Volser, MVC Drain, Reclaim, Reconcile.


	Available (GB)	The size of the space available in the MVC for additional VTVs.
	Used (GB)	The size of the space in the MVC used by current VTVs.
	Fragmented (GB)	The size of the space in the MVC used by fragmented VTVs.
	Unavailable (GB)	The size of the space in the MVC that is not available for use.
	Available Percentage	The percentage of the MVC that is physically available for use.
	Used Percentage	The percentage of the MVC used by current VTVs.
	Fragmented Percentage	The percentage of the MVC that contains noncurrent VTVs. This space is not available for use until it is reclaimed or the MVC is drained.
	Usable Percentage	The percentage of space on the MVC that can be used by VTCS. This may be zero even if there is still space physically available. For instance, if the VTV per MVC limit is reached then the usable percentage is reported as zero. Similarly, if an error has been reported against an MVC, VTCS does not use this MVC for output and the usable percentage is reported as zero.
	Times Mounted	The number of times the MVC has been mounted for writing or reading since it was added to the MVC inventory.
	Last Mounted	The date and time at which the MVC was mounted or attempted to be mounted on a RTD.
	Last Migration	The date and time at which the last VTV migration was performed to the MVC.
	Last Drain/Reclaim	The date and time at which the MVC was last processed by Drain or Reclaim processing and its end-of-tape pointer was reset.
	VTSS Last Mounted	The name of the last VTSS that performed a migration to the MVC.
Context menu: Audit VTSS, Vary VTSS.


	Initialized	Indicates the MVC's initialization status, either standard, partitioned, or not initialized.
	Media	The volume media type or recording technique.
If Need PTF is displayed, then this host lacks support for this media type, but another host does have support for this media type.


	Media Size (MB)	The size of the MVC in megabytes.
	Storage Class	The Storage Class that owns the MVC. MVCs only become a member of a storage class when they contain migrated VTVs.
Context menu: MVC Drain, Reclaim, Reconcile


	MVC Pool	The name of the MVC Pool the MVC is in.
Context menu: MVC Drain, Reclaim.


	Number of VTVs Migrated	The number of current VTVs migrated to this MVC.
	VTV Count	The number of active VTVs on the MVC.
	Audit	Indicates if the MVC is either currently being audited or has been the subject of a failed audit. While in this state the MVC is not used for migration but can be used for recalls. Due to the inherent state, recalls may fail because the CDS is not yet up-to-date with the MVC contents. To clear this condition, rerun the audit against this MVC.
	Broken	Indicates if the MVC, drive, or combination of the two has a problem. VTCS attempts to depreference MVCs with this state. If the MVC caused the problem, use a DRAIN(EJECT) command to remove the MVC from service. If the RTD caused the problem, use the MVCMAINT utility to reset the MVC state.
	Consolidation	Indicates if the MVC is consolidation MVC.
	Data Check	A data check condition has been reported against this MVC. VTCS attempts to depreference the usage of MVCs with this state. To get into this state, a data transfer must have failed upon two different RTDs.
To clear this state:

If all VTVs on the MVC are duplexed, run MVC Drain on the MVC without the Eject option. This recovers all VTVs and removes the MVC from service.

If all VTVs on the MVC are not duplexed, run VTCS AUDIT on the MVC. The audit may fail. After the audit, do an MVCDRAIN (no eject). This recalls the VTVs before the data-check area in ascending block-id order and the VTVs after the data-check area in a descending block-id order. Processing the VTVs in this sequence ensures that VTCS recovers as many VTVs as possible from the media. You then need to recreate the data for any VTVs still on the MVC.

Although this indicates that a specific failure has occurred when performing data transfers, this may not be a fault in the media. It could be that a RTD is writing data to the media out of specification. Patterns of failures are therefore important. As an example, lots of DATA CHECK conditions suddenly occurring lots of drives and volumes.


	Deduplication	Indicates if the MVC is deduplicated.
	Drain	Indicates if the MVC is currently the subject of drain or reclaim processing. Should the processing fail, the MVC may be left in this state as a safeguard. To clear this condition, perform a MVCDRain against the MVC.
	Eject	Indicates if the MVC has been ejected.
	Export	Indicates if the MVC is an export MVC.
	Full	Indicates if there is no space available on the MVC.
	Invalid MIR	Indicates if VTCS has received status from an RTD to indicate the MIR (media information record) for a 9x40 media is invalid. An invalid MIR does not prevent access to data but may cause significant performance problems while accessing records on the tape. The MVC is not capable of high-speed searches on areas of the tape that do not have a valid MIR entry.
VTCS attempts to depreference MVCs with this condition. For recalls, if the VTV resides on multiple MVCs, VTCS selects MVCs with valid MIRs ahead of MVCs with invalid MIRs. VTCS avoids using MVCs with invalid MIRs for migration, unless the migration is at the beginning of the tape. Migrating from the beginning of tape corrects the MIR. VTCS detects the invalid MIR condition at either mount time or dismount time. If detected at mount time and the operation can be completed with another MVC, VTCS dismounts the first MVC and selects the alternate MVC.

VTCS has only a limited ability to switch to an alternate MVC. That is, it is mainly used for migrate and virtual mount. For MVCs with invalid MIRs, determine the cause of the error, which may be caused by media or drive problems, and fix the error. To recover an MVC with an invalid MIR, read the MVC to the end of the tape with a VTCS audit. If the media is the problem, run an MVCDRAIN EJECT to recall the VTVs and cause the MVC to be removed from the MVC pool.


	Lost	Indicates if VTCS attempted to mount an MVC and the mount did not complete within a 15-minute time out period. VTCS has had no specific error report although there could be combination of hardware problems, HSC problems, or by the MVC being removed from the ACS. VTCS attempts to depreference the usage of MVCs with this state. Determine the cause of the error and fix it.
You can also use the VTCS MVCMAINT utility to set LOST(OFF) for the following events:

LOST(ON) was set due to LSM failures or drive errors that have been resolved.

LOST(ON) was set because the MVC was outside the ACS and has been reentered.

This condition is automatically cleared by VTCS if it subsequently requests a mount of the MVC and this is successful.


	Maximum VTV	Indicates if the MVC has reached the maximum number of VTVs.
	Mounted	Indicates if the MVC is mounted on an RTD.
	Protected	Indicates if the MVC is protected.
	Read-only	Indicates if the MVC has been marked read-only:
If this is due to the MVC being the target of an export or consolidation process, the read-only state protects the MVC from further updates.

If the MVC media is set to file protect, correct the error and use the MVCMAINT utility to set READONLY(OFF).If the MVC does not have the appropriate SAF rules set to enable VTCS to update the MVC, correct the error and use the MVCMAINT utility to set READONLY(OFF).


	Retired	Indicates if the MVC is retired and is considered by VTCS as having reached the end of its useful life. VTCS recalls from, but does not migrate to, the MVC. Replace the MVC as soon as possible. Once this has been done, use the MVCMAINT utility to set RETIRED(OFF).
	Usable	Indicates if the MVC can be used for migration.
	VLE Synchronization Pending	Indicates if a VLE synchronization is pending.
	Warranty Expired	Indicates if the MVC's warranty has expired. VTCS continues to use the MVC but you should start making plans to replace the MVC when it reaches Retired state.
	Last Verified	The date and time the last VTV media verify was performed to the MVC. This date reflects the last time that VTCS knew the MVC contents were valid.
	ACS	The ACD ID where the MVC resides.
	VLE	The VLE where the MVC resides.
	Consolidated Date	For a consolidation MVC, the date and time of the consolidation.
	EOT Block ID	The end-of-tape block ID.
	EOT Partition ID	The end-of-tape partition ID.
	Block ID First Space	The block ID of the first space on the MVC.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Selected Row Data	Show data for selected rows
	[image: Remove Pane icon]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Remove Pane icon]
	Print	Display as a printable page
	[image: Remove Pane icon]
	Filter	Filter the data
	[image: Remove Pane icon]
	Remove filter	Remove the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










VTVs on MVC

This data table displays a list of all VTVs in the MVC that was selected in the Multi-Volume Cartridges (MVCs) data table.

You may need to scroll horizontally or detach the table to view all columns.

Click a row to display MVCs for that VTV in the MVCs Containing VTV data table.

The status for some fields is summarized with a status indicator:


	Icon	Name	Description
	[image: Surrounding text describes good.jpg.]
	Good	Indicates no threshold violations are detected
	[image: Surrounding text describes caution.jpg.]
	Caution	Indicates warning thresholds have been exceeded
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates critical thresholds have been exceeded
	[image: Surrounding text describes unknown.jpg.]
	Unknown	Indicates status could not be detected






Click a status indicator to display its details.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	VTV Tapeplex	The name of the tapeplex the VTV belongs to.
	VTV Volser	The volume serial number of the VTV.
Context menu: Reconcile VTV.


	Resident	Indicates if the VTV is resident on the VTSS.
	Migrated	Indicates if VSM has migrated the VTV.
	Scratch	Indicates if the VTV is a scratch volume.
	Imported	Indicates if VSM has imported the VTV from another tapeplex. Imported VTVs cannot be modified or used for scratch mounts.
	Replication	Indicates the VTV's replication status:
NOT REPLICATED: This VTV has not been replicated.

REPLICATION REQUIRED: This VTV should be replicated and is currently queued for processing.

REPLICATION STARTED: Replication is active for this VTV but not yet complete.

REPLICATED: The VTV has been replicated to the VTSS identified in the Replica VTSS column.


	Electronic Export	Indicates electronic export status:
EXPORT-NOT POSSIBLE: Export of this VTV to a remote tapeplex was attempted and the request was rejected. Typically, this is due to a different copy of the VTV residing in the remote tapeplex.

EXPORT-REJECTED: Electronic export was actively rejected. This could be due to the target tapeplex not allowing import of the VTV, or a clash with copy status.

EXPORT-REQUIRED: This VTV should be electronically exported and is currently queued for processing.

EXPORT-STARTED: Electronic export is active for this VTV, but not yet complete.


	Management Class	The name of the Management Class for the VTV.
	Uncompressed Size (MB)	The uncompressed size of the VTV in megabytes. This is the size of the VTV as perceived by the application programs.
	Compression Percentage	The VTV compression percentage achieved. This is the difference between the uncompressed and compressed VTV size, expressed as a percentage of the uncompressed VTV size. A compression of zero per cent indicates that no compression was possible on the VTV.
	Created	The date and time when the VTV contents were last changed by an application.
	Last Used	The date and time when the VTV was last touched by VTCS. This includes most functions that update the status of the VTV, including VTV mount, migrate, recall, or scratch.
	Maximum VTV Size (MB)	The maximum (compressed) size of VTVs in megabytes (400, 800, 2000 or 4000).
	VTSS	The VTSS where the VTV resides. If the VTV is migrated, the VTSS where the VTV was last resident. If this field is empty, the VTV is non-existent (not created or used, scratched, and deleted) or has been manually imported.
	Compressed Size (MB)	The compressed size of the VTV in megabytes. This is the raw space that will be occupied on the MVCs or within the VTSSs.
	VTV Page Size	The VTV page size, large or standard.
	Last Mounted	The date and time when the VTV content was last mounted for access by an application.
	Last Recall	The date and time when the VTV was last recalled back from a MVC into a VTSS.
	Times Read	The number of times the VTV has been read.
	Copies to Migrate	The number of migration copies of the VTV.
	Replica VTSS	The VTSS where the replica VTV resides.
	Owning Tapeplex	The name of the tapeplex where the replica VTV resides.
	Block ID	The Block ID of the VTV on the MVC.
	Partition ID	The Partition ID of the VTV on the MVC.
	First Migrated	The date the VTV was first migrated to the MVC.
	Initialized	Indicates if the VTV has been initialized. If VTCS has used the VTV at least once, it is initialized. VTVs that are defined with the CONFIG utility but have never been used by VTCS are not initialized.
	Avoid Early Mount	Indicates if concurrent recall or mount encountered an error with this VTV. If so, no further concurrent recall or mount activity is attempted for this VTV.
	Consolidated	Indicates if VSM has consolidated the VTV.
	Fenced	Indicates if VSM has fenced the VTV.
	Migration Pending	Indicates if VTV migration is pending. This status is displayed when a VTV is initially created, or when the VTV requires reconciling or archiving. In these latter cases, individual MVC copies may indicate Reconcile or Deletion.
	Mounted	Indicates if the VTV is currently mounted.
	New Create	Indicates if the VTV is newly created.
	Refresh	The last refresh date and time.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









MVC States

This graph shows MVC counts for each tapeplex, with current state summarized as Warning, Critical, or Good.

Warning includes MVCs with one or more of the following states: Audit, Drain, Max VTV, or Warranty Expired.

Critical includes MVCs with one or more of the following states: Not usable, Broken, Data_Check, Invalid MIR, Lost, or Retired.

Good includes MVCs with none of the above states.

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









MVC Space Usage by MVC Pool

This graph shows the MVC space usage counts and availability for each MVC Pool.

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









MVC Space Usage

This graph shows MVC space usage counts, sorted by usage type and percentage range.

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard
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Display MVC Pool

This pane displays Multi-Volume Cartridge Pool information.

To display, select Display and MVC Pool on the navigation tree.



Multi-Volume Cartridge (MVC) Pools

This data table shows MVC Pool information.

You may need to scroll horizontally or detach the table to view all columns.

Click a row to display MVCs for that MVC Pool in the MVCs in MVC Pool and Space Usage in MVC Pools data tables.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex the MVC Pool belongs to.
	MVC Pool	The MVC Pool name.
Context menu: MVC Drain, Reclaim.


	Initialize MVC	Indicates if un-initialized MVCs are to be initialized when first mounted.
	Minimum Free MVCs	The minimum number of free MVCs.
	Reclaim Threshold Percentage	The fragmented space threshold (as a percentage) that determines when an MVC is eligible for demand or automatic reclamation.
	MVC Pool Inplace Threshold Percentage	The fragmented space threshold (as a percentage) that determines when an MVC in partitioned format is eligible for dynamic reclaim processing.
	Reclaim Max MVC	The MVC limit for a single reclaim.
	Reclaim Start	The percentage of reclaim candidates to total MVCs that trigger automatic reclaim.
	Space Reclaim	The space reclamation setting.
	Total MVCs	The number of MVCs in the MVC Pool.
	Free MVCs	The total number of free MVCs in the MVC Pool.
	Standard MVCs	The number of initialized standard MVCs. in the MVC Pool.
	Partitioned MVCs	The number of initialized partitioned MVCs in the MVC Pool.
	Un-initialized MVCs	The number of un-initialized MVCs in the MVC Pool.
	Audit MVCs	The number of MVCs with status AUDIT.
	Broken MVCs	The number of MVCs with status BROKE.
	Consolidated MVCs	The number of MVCs with status CONSOLIDATE.
	Data Check MVCs	The number of MVCs with data checks.
	Drain MVCs	The number of MVCs with status DRAIN.
	Ejected MVCs	The number of MVCs with status EJECTED.
	Export MVCs	The number of MVCs with status EXPORT
	Full MVCs	The number of MVCs marked FULL.
	Invalid MIR MVCs	The number of MVCs with Invalid MIRs
	Lost MVCs	The number of MVCs with status LOST.
	Max VTV MVCs	The number of MVCs with maximum VTVs.
	Read-only MVCs	The number of MVCs marked Read-Only.
	Retired MVCs	The number of MVCs marked RETIRED.
	Usable MVCs	The number of usable MVCs.
	Warranty Expired MVCs	The number of MVCs with expired warranty.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









Space Usage in MVC Pool

This data table displays the space usage in the MVC Pool that was selected in the Multi-Volume Cartridge (MVC) Pools data table.

Table columns and descriptions include:


	Column	Description
	ACS/VLE - Media - Storage CLass	A tree table of the space usage in the selected MVC Pool, summarized by ACS/VLE, Media, and Storage Class.
Click the arrow to expand or contract the tree.


	Total MVC Count	The total number of MVCs in the MVC Pool.
	Free Volumes	The number of free MVCs.
	Available (GB)	The amount of space available in the MVC Pool.
	Used (GB)	The amount of space used in the MVC Pool.
	Fragmented (GB	The amount of fragmented space in the MVC Pool.
	Unavailable (GB)	The amount of unavailable space in the MVC Pool.
	Refreshed	The date and UTC time the data was stored or last updated.






Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










MVCs in MVC Pool

This data table displays a list of all MVCs in the MVC Pool that was selected in the Multi-Volume Cartridge (MVC) Pools data table.

You may need to scroll horizontally or detach the table to view all columns.

The status for some fields is summarized with a status indicator:


	Icon	Name	Description
	[image: Surrounding text describes good.jpg.]
	Good	Indicates no threshold violations are detected
	[image: Surrounding text describes caution.jpg.]
	Caution	Indicates warning thresholds have been exceeded
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates critical thresholds have been exceeded
	[image: Surrounding text describes unknown.jpg.]
	Unknown	Indicates status could not be detected






Click a status indicator to display its details.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	MVC Volser	The volser of the MVC.
Context menu: Audit MVC Volser, MVC Drain, Reclaim, Reconcile.


	Media	The volume media type or recording technique.
If Need PTF is displayed, then this host lacks support for this media type, but another host does have support for this media type.


	Media Size (MB)	The size of the MVC in megabytes.
	Storage Class	The Storage Class that owns the MVC. MVCs only become a member of a storage class when they contain migrated VTVs.
Context menu: MVC Drain, Reclaim, Reconcile


	Number of VTVs Migrated	The number of current VTVs migrated to this MVC.
	VTV Count	The number of active VTVs on the MVC.
	Available (GB)	The size of the space available in the MVC for additional VTVs.
	Used (GB)	The size of the space in the MVC used by current VTVs.
	Fragmented (GB)	The size of the space in the MVC used by fragmented VTVs.
	Unavailable (GB)	The size of the space in the MVC that is not available for use.
	Available Percentage	The percentage of the MVC that is physically available for use.
	Used Percentage	The percentage of the MVC used by current VTVs.
	Fragmented Percentage	The percentage of the MVC that contains noncurrent VTVs. This space is not available for use until it is reclaimed or the MVC is drained.
	Usable Percentage	The percentage of space on the MVC that can be used by VTCS. This may be zero even if there is still space physically available. For instance, if the VTV per MVC limit is reached then the usable percentage is reported as zero. Similarly, if an error has been reported against an MVC, VTCS does not use this MVC for output and the usable percentage is reported as zero.
	Times Mounted	The number of times the MVC has been mounted for writing or reading since it was added to the MVC inventory.
	Last Mounted	The date and time at which the MVC was mounted or attempted to be mounted on a RTD.
	Last Migration	The date and time at which the last VTV migration was performed to the MVC.
	Last Drain/Reclaim	The date and time at which the MVC was last processed by Drain or Reclaim processing and its end-of-tape pointer was reset.
	VTSS Last Mounted	The name of the last VTSS that performed a migration to the MVC.
Context menu: Audit VTSS, Vary VTSS.


	Initialized	Indicates the MVC's initialization status, either standard, partitioned, or not initialized.
	Audit	Indicates if the MVC is either currently being audited or has been the subject of a failed audit. While in this state the MVC is not used for migration but can be used for recalls. Due to the inherent state, recalls may fail because the CDS is not yet up-to-date with the MVC contents. To clear this condition, rerun the audit against this MVC.
	Broken	Indicates if the MVC, drive, or combination of the two has a problem. VTCS attempts to depreference MVCs with this state. If the MVC caused the problem, use a DRAIN(EJECT) command to remove the MVC from service. If the RTD caused the problem, use the MVCMAINT utility to reset the MVC state.
	Consolidation	Indicates if the MVC is consolidation MVC.
	Data Check	A data check condition has been reported against this MVC. VTCS attempts to depreference the usage of MVCs with this state. To get into this state, a data transfer must have failed upon two different RTDs.
To clear this state:

If all VTVs on the MVC are duplexed, run MVC Drain on the MVC without the Eject option. This recovers all VTVs and removes the MVC from service.

If all VTVs on the MVC are not duplexed, run VTCS AUDIT on the MVC. The audit may fail. After the audit, do an MVCDRAIN (no eject). This recalls the VTVs before the data-check area in ascending block-id order and the VTVs after the data-check area in a descending block-id order. Processing the VTVs in this sequence ensures that VTCS recovers as many VTVs as possible from the media. You then need to recreate the data for any VTVs still on the MVC.

Although this indicates that a specific failure has occurred when performing data transfers, this may not be a fault in the media. It could be that a RTD is writing data to the media out of specification. Patterns of failures are therefore important. As an example, lots of DATA CHECK conditions suddenly occurring lots of drives and volumes.


	Deduplication	Indicates if the MVC is deduplicated.
	Drain	Indicates if the MVC is currently the subject of drain or reclaim processing. Should the processing fail, the MVC may be left in this state as a safeguard. To clear this condition, perform a MVCDRain against the MVC.
	Eject	Indicates if the MVC has been ejected.
	Export	Indicates if the MVC is an export MVC.
	Full	Indicates if there is no space available on the MVC.
	Invalid MIR	Indicates if VTCS has received status from an RTD to indicate the MIR (media information record) for a 9x40 media is invalid. An invalid MIR does not prevent access to data but may cause significant performance problems while accessing records on the tape. The MVC is not capable of high-speed searches on areas of the tape that do not have a valid MIR entry.
VTCS attempts to depreference MVCs with this condition. For recalls, if the VTV resides on multiple MVCs, VTCS selects MVCs with valid MIRs ahead of MVCs with invalid MIRs. VTCS avoids using MVCs with invalid MIRs for migration, unless the migration is at the beginning of the tape. Migrating from the beginning of tape corrects the MIR. VTCS detects the invalid MIR condition at either mount time or dismount time. If detected at mount time and the operation can be completed with another MVC, VTCS dismounts the first MVC and selects the alternate MVC.

VTCS has only a limited ability to switch to an alternate MVC. That is, it is mainly used for migrate and virtual mount. For MVCs with invalid MIRs, determine the cause of the error, which may be caused by media or drive problems, and fix the error. To recover an MVC with an invalid MIR, read the MVC to the end of the tape, with a VTCS audit. If the media is the problem, run an MVCDRAIN EJECT to recall the VTVs and cause the MVC to be removed from the MVC pool.


	Lost	Indicates if VTCS attempted to mount an MVC and the mount did not complete within a 15-minute time out period. VTCS has had no specific error report although there could be combination of hardware problems, HSC problems, or by the MVC being removed from the ACS. VTCS attempts to depreference the usage of MVCs with this state. Determine the cause of the error and fix it.
You can also use the VTCS MVCMAINT utility to set LOST(OFF) for the following events:

LOST(ON) was set due to LSM failures or drive errors that have been resolved.

LOST(ON) was set because the MVC was outside the ACS and has been reentered.

This condition is automatically cleared by VTCS if it subsequently requests a mount of the MVC and this is successful.


	Maximum VTV	Indicates if the MVC has reached the maximum number of VTVs.
	Mounted	Indicates if the MVC is mounted on an RTD.
	Protected	Indicates if the MVC is protected.
	Read-only	Indicates if the MVC has been marked read-only:
If this is due to the MVC being the target of an export or consolidation process, the read-only state protects the MVC from further updates.

If the MVC media is set to file protect, correct the error and use the MVCMAINT utility to set READONLY(OFF).If the MVC does not have the appropriate SAF rules set to enable VTCS to update the MVC, correct the error and use the MVCMAINT utility to set READONLY(OFF).


	Retired	Indicates if the MVC is retired and is considered by VTCS as having reached the end of its useful life. VTCS recalls from, but does not migrate to, the MVC. Replace the MVC as soon as possible. Once this has been done, use the MVCMAINT utility to set RETIRED(OFF).
	Usable	Indicates if the MVC can be used for migration.
	VLE Synchronization Pending	Indicates if a VLE synchronization is pending.
	Warranty Expired	Indicates if the MVC's warranty has expired. VTCS continues to use the MVC but you should start making plans to replace the MVC when it reaches Retired state.
	Last Verified	The date and time the last VTV media verify was performed to the MVC. This date reflects the last time that VTCS knew the MVC contents were valid.
	ACS	The ACD ID where the MVC resides.
	VLE	The VLE where the MVC resides.
	Consolidated Date	For a consolidation MVC, the date and time of the consolidation.
	EOT Block ID	The end-of-tape block ID.
	EOT Partition ID	The end-of-tape partition ID.
	Block ID First Space	The block ID of the first space on the MVC.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









MVC States in MVC Pool

This graph shows the number of MVCs in the selected MVC Pool, sorted by current MVC state.

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









Usage in MVC Pool

This graph shows the amount of used and available space for the selected MVC Pool sorted by ACS/VLE, Media, or Storage Class.

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click a graph icon to change the graph display type.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









Volumes in MVC Pool

This graph shows the number of MVCs in the selected MVC Pool, sorted by current usage state.

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click a graph icon to change the graph display type.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









Sizes in MVC Pool

This graph shows the size of MVCs in the selected MVC Pool, sorted by current usage state.

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard
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Display VLE

This pane displays Virtual Library Extension (VLE) information.

To display, select Display and VLE on the navigation tree.



Virtual Library Extension (VLE)

This data table shows VLE information.

You may need to scroll horizontally or detach the table to view all columns.

Click a row to display vRTDs for that VLE in the Drives (vRTDs) for VLE data table and also to display VTSSs that are attached to that VLE in the VTSSs Attached to VLE data table.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex name.
	VLE	The VLE name.
	Status	The VLE status.
	VLE Version	The VLE version.
	Autonomous Devices	Indicates if the VLE has the autonomous devices feature.
	Version 2 API	Indicates if the VLE has the Version 2 API feature.
	Deduplication	Indicates if the VLE has the deduplication feature.
	Mount/Recall	Indicates if the VLE has the mount/recall feature.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Drives (vRTDs) for VLE

This data table displays a list of all vRTDs in the VLE that was selected in the Virtual Library Extension (VLE) data table.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Device Address	The vRTD address.
	Device Type	The device type of the vRTD. For VLE, the device type is VL.
	MVC Allocated	The volser of the MVC allocated for mounting on the vRTD.
	MVC Mounted	The MVC that is currently mounted on the vRTD.
	Host	The host that currently owns the vRTD.
	Owner VTSS	The VTSS that is currently connected to the vRTD.
	Status	One of the following vRTD statuses:
RECOVER RTD: The vRTD is being reset after a problem, a vary, or an initialization.

MIGRATE VTV: The vRTD is migrating a VTV.

RECALL VTV: The vRTD is recalling a VTV.

UNLOAD MVC: A forced unload of the vRTD is occurring.

VTV TRANSFER: The vRTD is migrating a VTV before recalling it on another VTSS.

AUDIT MVC: An MVC is being audited.

BUSY: The vRTD is busy (non-specific task).

IDLE: An MVC is allocated to the vRTD but the MVC is not being used.

ONLINE/FREE: The vRTD is online and available.

MAINTENANCE: The vRTD is in maintenance mode.

OFFLINE: The vRTD is offline and unavailable to all hosts and VTSSs

RECOVERY: The vRTD is being reset following an error or a vary online mode.

INITIALIZE: The host is verifying vRTD status and availability.

SUSPEND: The vRTD operations are suspended. This occurs when one or more vRTDs and a CLINK are configured on the same port. The vRTDs remain in SUSPEND mode while the CLINK is online.

PATH OFFLINE: The vRTD status is unknown because the VTSS cannot contact the vRTD or if the paths were not correctly configured.

PATH SUSPEND: The vRTD is globally online but the path from the VTSS is suspended due to the vRTD being paired with a Clink.

FAIL/OFFLINE: The vRTD was placed offline due to a failure.

TOP ID: The process Id of the request that is top of the queue for next using this vRTD from this host. The TOP ID column only applies for requests from the host upon which the command has been executed. This host may not have the top claim upon the vRTD.

TOP HOST: The host which has the request that is top of the queue for next using this vRTD. The TOP HOST indicates which host has the top claim upon the vRTD.


	MVC Volser	The volser of the MVC currently mounted on the vRTD or allocated to the vRTD for mounting.
	Internal Device Type	The internal coding of the device type.
	Requests Queued	The number of requests that are currently queued.
	Allocation Time Remaining (mins)	The allocation time remaining, in minutes.
	Local Wait Time (mins)	The local wait time, in minutes.
	Serial Number	The serial number of the vRTD.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









VTSSs Attached to VLE

This data table displays a list of all VTSSs that are attached to the VLE that was selected in the Virtual Library Extension (VLE) data table.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	VTSS	The name of the VTSS.
	Status	The VTSS status.
	DBU (%)	The disk buffer usage percentage.
	Capacity (MB)	The VTSS capacity, in megabytes (MB).
	VTV Count	The number of VTVs in the VTSS.
	Maximum Migrate Tasks	The maximum number of auto-migration tasks for the VTSS.
	Minimum Migrate Tasks	The minimum number of auto-migration tasks for the VTSS.
	Default ACS	The ACS the VTSS is associated with.
	Auto-Migrate Host	The host associated with this VTSS for auto-migration.
	Auto-Migrate Threshold	The threshold for auto-migration.
	Drive Count	The number of RTDs and vRTDs in the VTSS.
	Model	The VTSS model number.
	High AMT	The high auto-migrate threshold.
	Low AMT	The low auto-migrate threshold.
	Maximum VTV Size (MB)	The maximum size of VTVs in this VTSS, in megabytes (MB).
	VTV Page Size	The page size setting for VTVs in this VTSS.
	RTC Data Verify	Indicates if this VTSS has the RTC Data Verify feature.
	Connectivity	The connectivity type between the VLE and VTSS
	Serial Number	The VTSS serial number.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Display VTD






Display VTD

This pane displays Virtual Tape Drive (VTD) information.

To display, select Display and VTD on the navigation tree.


Virtual Tape Drives (VTDs)

This data table shows VTD information.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex the VTD is in.
	VTSS	The VTSS the VTD is in.
Context menu: Audit VTSS, Vary VTSS.


	VTD ID	The VTD ID.
	VTV Volser	The volser of the VTD currently mounted on or allocated to the VTD.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









Hosts for VTD

This data table shows the selected VTD's host system, device address, status and usage.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Host	The name of the host that owns the VTD.
	Device Address	The device address of the VTD. If the device has not been defined to this host in the CONFIG, then this will contain physical address within the VTSS prefixed by '##'.
	Status	One of the following:
Available: The VTD is available for work.

Dismounting: The VTV volser shown in the VTV column is was mounted on the VTD and the VTD has been unloaded. VTCS either has not received the dismount request or is currently in the progress of synchronizing the VTV and CDS information.

Imported: The VTV volser shown in the VTV column has been electronically imported with the VTD. It is awaiting the confirmation request from the host that performed the export.

Importing: The VTV volser shown in the VTV column is being electronically imported with the VTD.

Mounted: The VTV volser shown in the VTV column is mounted on the VTD.

Mounting: The VTV volser shown in the VTV column is in the process of being mounted on the VTD. Typically, this indicates that an auto recall is in progress.

Mount(other): The VTV volser shown in the VTV column is mounted on the VTD. The mount was not performed by the host on which the command was executed.

Not Available: The VTD is not available for work.

Redrive Later: A previous attempt to mount the VTV volser shown in the VTV column upon the VTD failed. It will be interpreted again within the next few minutes.

Replicating: The VTV volser shown in the VTV column is in the process of being replicated.

Undefined: The VTV volser shown in the VTV column is undefined.

Unknown: The VTV volser shown in the VTV column is unknown.


	Usage	One of the following:
Configuring: Configuration of the VTD is in progress.

ECAM init error: Unable to initialise VTD through ECAM-t with VTSS.

ECAM I/O error: ECAM-t I/O has failed on this VTD.

ECAM only: The VTD is one of the VTDs connected to another VTSS for the process of replicating VTVs.

Not accessed: The VTD is not found in the VTSS configuration.

Not verified: The VTD is defined with NOVERIFY in the configuration.


	Client Address	The address of the drive as reported by the client that last performed a mount on the VTD.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
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	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









VTD Status

This graph shows VTD status for the tapeplex and for the host. The graph is color-coded to indicate the number of VTDs that are unknown, unverified, replicating, redrive later, not available, imported, dismounting, mounted, and available.

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









VTD Usage

This graph shows VTD usage for the tapeplex and for the host. The graph is color-coded to indicate the number of VTDs that are not verified, not accessed, ECAM only, ECAM I/O error, ECAM init error, and configuring.

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
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	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard
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Display VTSS

This pane displays Virtual Tape Storage Subsystem (VTSS) information.

To display, select Display and VTSS on the navigation tree.



Virtual Tape Storage Subsystem (VTSS)

This data table shows VTSS information.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex the VTSS belongs to.
	VTSS	The name of the VTSS.
Context menu: Audit VTSS, Vary VTSS.


	Status	One of the following global VTSS states for all hosts:
QUIESCING: Quiescing state.

QUIESCED: Quiesced state.

OFFLINE: Offline state.

OFFLINE-P: Offline pending state.

ONLINE: Online state.

ONLINE-P: Online pending state.

STARTED: The VTSS is initialized and in process of going to the requested state (online, offline, or quiesced).


	Capacity (MB)	The capacity of the VTSS in megabytes.
	DBU Percentage	The percentage of disk buffer used of the total disk buffer capacity.
	High AMT	The high auto-migrate threshold.
	Low AMT	The low auto-migrate threshold.
	VTV Count	The number of VTVs resident in the VTSS.
	Maximum Migrate Tasks	The maximum number of auto-migrate tasks for the VTSS.
	Minimum Migrate Tasks	The minimum number of auto-migrate tasks for the VTSS.
	Default ACS	The configured default ACS ID for the VTSS.
	Auto-Host	The host system performing the auto-migration.
	Auto-migrate Threshold	The current auto-migration threshold for the VTSS.
	RTD Count	The number of RTDs attached to the VTSS.
	Model	The VTSS model (VSM2, VSM3, VSM4, VSM5, VSM 6, VSM 7, or unknown).
	Maximum VTV Size (MB)	The maximum size of VTVs in megabytes.
	VTV Page Size	The VTV page size, either Standard or Large.
	RTC Data Verify	Indicates if RTC data is verified.
	Connectivity	The Connectivity type, either CHANNEL or ECAM-T protocol.
	Serial Number	The serial number of the VTSS.
	Refreshed	The date and UTC time the data was stored or last updated.






Click a row in the data table to display, for that VTSS, the following data tables:

CLINKs for VTSS

Clusters for VTSS

Drive Paths for VTSS

Features for VTSS

Hosts for VTSS

VLEs for VTSS

VTDs in VTSS

Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










CLINKs for VTSS

This data table displays a list of all CLINKs for the VTSS that was selected in the Virtual Tape Storage Subsystem (VTSS) data table.

If the table is not visible, click the arrows left or right of the displayed tabs and select the table.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Partner Tapeplex	The partner tapeplex in the cluster.
	Partner VTSS	The secondary or receiving VTSS in the cluster.
	CLINK ID	The CLINK ID that has been assigned to the CLINK within the VTSS
	Channel ID	The back-end channel interface to which the CLINK is connected.
	IPIF ID	The IPIF ID of the CLINK
	Cluster	The cluster name if the CLINK is used for replication of VTVs within the tapeplex and is part of a cluster. The VTSS name in the Partner VTSS column indicates the other VTSS that operates in the cluster.
	Status	One of the following:
Maint: The link has failed or it has been varied into maintenance mode.

Offline: The link is offline and unavailable to all hosts and VTSSs.

ONLINE: The link is online and available to all hosts and VTSSs.

ON-SYNC: Available for synchronous replication.

ON-ASYNC: Available for asynchronous replication.

P_OFFLINE: The link is pending offline.

P_ONLINE: The link is pending online.

RECOVERY: The link is being reset following an error or a vary online operation.

UNUSABLE: Not available for replication due to hardware errors or assigned-elsewhere conditions.

UUI ERR: This is a CLINK defined for electronic export and it has been unable to contact the remote VTCS. There should be messages in the HSC JOBLOG that indicate the reason for the problem. This could include problems with the definitions, the local SMC, or the remote HTTP server on the remote VTCS.


	Usage	One of the following:
ASSIGNED: Link is assigned to the host in the HOST field but is not currently replicating. This usage occurs when VTCS is starting or terminating link use or is attempting error recovery on the link after a replication failure.

FREE: Link is idle (not doing replications).

REPLICATING: Link is actively doing replications.


	Host	The host that the link is assigned to
	Partner VTD	The address of the VTD on the partner VTSS that forms the other end point to the connection. For a cluster link, the host address of the VTD is reported. For an electronic export link, this is not possible as there is no access to the other tapeplex configuration. In this case, only the ordinal number of the VTV is reported.
	Replication Capability	Indicates the CLINK is available for synchronous or asynchronous replication.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Clusters for VTSS

This data table displays a list of all Clusters for the VTSS that was selected in the Virtual Tape Storage Subsystem (VTSS) data table.

If the table is not visible, click the arrows left or right of the displayed tabs and select the table.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Cluster	The cluster name.
	Direction	The direction of the link between the VTSSs, either TO, FROM, or PEER:
TO or FROM indicate the direction of VTV replication in Uni-Directional Cluster. VTVs can only be replicated from the Sending to the Receiving VTSS.

PEER indicates that the VTSSs are configured as a Bi-Directional (Peer-to-Peer) Cluster. VTVs can be replicated from either VTSS to the other.


	Partner VTSS	The partner VTSS in the cluster.
	Mode	One of the following cluster operating modes:
ASYNC-REPLICATE: Both VTSSs in the cluster are online to VTCS. Production workload can go to either VTSS, but for a unidirectional (primary/secondary) cluster, VTVs can only be replicated from the sending VTSS. Synchronous replication is not enabled across the cluster.

SYNC-REPLICATE: Both VTSSs in the cluster are online to VTCS. Production workload can go to either VTSS, but for a unidirectional (primary/secondary) cluster, VTVs can only be replicated from the sending VTSS. Synchronous replication is enabled across the cluster.

DEGRADED: One of the two VTSSs in a bidirectional peer-to-peer cluster is either offline or quiesced. Production workload can go the remaining online VTSS. VTVs requiring replication, however, are allocated to the remaining VTSS only if no other full-function clusters are available and suitable. In this case, replicate VTVs are migrated immediately with keep and queued for replication when the other VTSS comes online. When the other VTSS comes online, VTCS reconciles the contents of both VTSSs.

DEGRADED SECONDARY: The primary is online to VTCS and the secondary is either offline or quiesced. Workload can run on the primary. VTVs requiring replication, however, are allocated to the primary only if no other full-function clusters are available. In this case, replicate VTVs are migrated immediately with keep and are queued for replication, which occurs when the secondary comes online.

DEGRADED PRIMARY: The secondary is online to VTCS and the primary is either offline or quiesced. Workload can run on the secondary. VTVs requiring replication, however, are allocated to the secondary only if no other full-function clusters are available. When the primary comes back online, VTCS reconciles the contents of the primary and secondary.

NON-OPERATIONAL: No workload is possible on this cluster.

CLINKS OFFLINE: All defined CLINKs are offline. No workload is possible on this Cluster.

ONLY SECONDARY: The Secondary is online to VTCS and the Primary has no CLINKs online. Workload can run on the Secondary. VTVs requiring replication, however, are allocated to the Secondary only if no other Full Function Clusters are available.

ONLY PRIMARY: The Primary is online to VTCS and the Secondary has no CLINKs online. Workload can run on the Primary. VTVs requiring replication, however, are allocated to the Primary only if no other Full Function Clusters are available. In this case, Replicate VTVs are migrated immediately with keep and are queued for replication.


	Replication Capability	Indicates the cluster is available for synchronous or asynchronous replication.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Drive Paths for VTSS

This data table displays a list of all drive paths for the VTSS that was selected in the Virtual Tape Storage Subsystem (VTSS) data table.

If the table is not visible, click the arrows left or right of the displayed tabs and select the table.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Path Name	The name allocated to the path.
	VLE	The VLE name.
	Device Address	The device address for the drive.
	Logical Device ID	The logical device ID assigned to the path.
	Channel ID	The CHANIF value that was specified for the path.
	IPIF ID	The IPIF value that was specified for the path.
	Status	One of the following:
ONLINE: The path is online and available for use.

ON-ASYNC: The path is online and available for use for asynchronous replication of VTVs.

ON-SYNC: The path is online and available for use for synchronous replication of VTVs.

OFFLINE: The path or the device to which it connects has been varied offline.

MAINT: The path or the device to which it connects has been varied into an offline maintenance mode. This could be a result of repeated failures.


	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Features for VTSS

This data table displays a list of features for the VTSS that was selected in the Virtual Tape Storage Subsystem (VTSS) data table.

If the table is not visible, click the arrows left or right of the displayed tabs and select the table.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Feature	The VTSS feature description.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Hosts for VTSS

This data table displays a list of hosts for the VTSS that was selected in the Virtual Tape Storage Subsystem (VTSS) data table.

If the table is not visible, click the arrows left or right of the displayed tabs and select the table.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Host	The host name.
	Migrates	Indicates if the host supports migrates on this VTSS.
	Reclaims	Indicates if the host supports reclaims on this VTSS.
	Status	The VTSS status from the host: Online, Offline, or Quiesced.
	VTD Count	The number of VTDs for the HOST-VTSS.
	Active Migrate Tasks	The number of active migration tasks for the HOST-VTSS.
	VTSS Accessible	Indicates if the VTSS is accessible from the host.
	Immediate Migrate Wait Time (mins)	The migrate wait time fore the HOST-VTSS, in minutes.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
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	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










VLEs for VTSS

This data table displays a list of VLEs for the VTSS that was selected in the Virtual Tape Storage Subsystem (VTSS) data table.

If the table is not visible, click the arrows left or right of the displayed tabs and select the table.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	VLE	The VLE name.
	Status	The VLE status.
	VLE Version	The VLE version number.
	Autonomous Devices	Indicates if the VLE has the autonomous devices feature.
	Version 2 API	Indicates if the VLE has the Version 2 API feature.
	Deduplication	Indicates if the VLE has the deduplication feature.
	Mount/Recall	Indicates if the VLE has the mount/recall feature.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
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	Selected Row Data	Show data for selected rows
	[image: Remove Pane icon]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










VTDs in VTSS

This data table displays a list of VTD IDs for the VTSS that was selected in the Virtual Tape Storage Subsystem (VTSS) data table.

If the table is not visible, click the arrows left or right of the displayed tabs and select the table.

You may need to scroll horizontally or detach the table to view all columns.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	VTD ID	The VTD ID.
	VTV Volser	The Volser of the VTV on the VTD
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
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	Selected Row Data	Show data for selected rows
	[image: Remove Pane icon]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









DBU Percentage for VTSS

This graph shows the disk buffer utilization (DBU) used percentage for the selected VTSS, with color coding in the background indicating the low and high auto-migration threshold (AMT) percentage settings and also the Critical DBU threshold percentage setting.

Hover on an object to display summary data for the object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
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	Dial gauge	Display the gauge as a dial
	[image: Remove Pane icon]
	LED gauge	Display the gauge as an LED
	[image: Remove Pane icon]
	Meter gauge	Display the gauge as a status meter
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	Print	Display as a printable page
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Filter Data icon]
	Help	Display VSM GUI Help
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	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Display VTV






Display VTV

This pane displays Virtual Tape Volume (VTV) information.

To display, select Display and VTV on the navigation tree.



Virtual Tape Volumes (VTVs)

This data table shows VTV information.

You may need to scroll horizontally or detach the table to view all columns.

Click a row to display MVCs for that VTV in the MVCs Containing VTV data table.

The status for some fields is summarized with a status indicator:


	Icon	Name	Description
	[image: Surrounding text describes good.jpg.]
	Good	Indicates no threshold violations are detected
	[image: Surrounding text describes caution.jpg.]
	Caution	Indicates warning thresholds have been exceeded
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates critical thresholds have been exceeded
	[image: Surrounding text describes unknown.jpg.]
	Unknown	Indicates status could not be detected






Click a status indicator to display its details.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex the VTV belongs to.
	VTV Volser	The volume serial number of the VTV.
Context menu: Reconcile VTV.


	Management Class	The name of the Management Class for the VTV.
	VTSS	The VTSS where the VTV resides. If the VTV is migrated, the VTSS where the VTV was last resident. If this field is empty, the VTV is non-existent (not created or used, scratched, and deleted) or has been manually imported.
	Uncompressed Size (MB)	The uncompressed size of the VTV in megabytes. This is the size of the VTV as perceived by the application programs.
	Compressed Size (MB)	The compressed size of the VTV in megabytes. This is the raw space that will be occupied on the MVCs or within the VTSSs.
	Compression Percentage	The VTV compression percentage achieved. This is the difference between the uncompressed and compressed VTV size, expressed as a percentage of the uncompressed VTV size. A compression of zero per cent indicates that no compression was possible on the VTV.
	Maximum VTV Size (MB)	The maximum (compressed) size of VTVs in megabytes (400, 800, 2000 or 4000).
	VTV Page Size	The VTV page size, large or standard.
	Last Mounted	The date and time when the VTV content was last mounted for access by an application.
	Last Recall	The date and time when the VTV was last recalled back from a MVC into a VTSS.
	Last Used	The date and time when the VTV was last touched by VTCS. This includes most functions that update the status of the VTV, including VTV mount, migrate, recall, or scratch.
	Created	The date and time when the VTV contents were last changed by an application.
	Times Read	The number of times the VTV has been read.
	Copies to Migrate	The number of migration copies of the VTV.
	Replication	Indicates the VTV's replication status:
NOT REPLICATED: This VTV has not been replicated.

REPLICATION REQUIRED: This VTV should be replicated and is currently queued for processing.

REPLICATION STARTED: Replication is active for this VTV but not yet complete.

REPLICATED: The VTV has been replicated to the VTSS identified in the Replica VTSS column.


	Replica VTSS	The VTSS where the replica VTV resides.
	Owning Tapeplex	The name of the tapeplex where the replica VTV resides.
	Electronic Export	Indicates electronic export status:
EXPORT-NOT POSSIBLE: Export of this VTV to a remote tapeplex was attempted and the request was rejected. Typically, this is due to a different copy of the VTV residing in the remote tapeplex.

EXPORT-REJECTED: Electronic export was actively rejected. This could be due to the target tapeplex not allowing import of the VTV, or a clash with copy status.

EXPORT-REQUIRED: This VTV should be electronically exported and is currently queued for processing.

EXPORT-STARTED: Electronic export is active for this VTV, but not yet complete.


	Initialized	Indicates if the VTV has been initialized. If VTCS has used the VTV at least once, it is initialized. VTVs that are defined with the CONFIG utility but have never been used by VTCS are not initialized.
	Avoid Early Mount	Indicates if concurrent recall or mount encountered an error with this VTV. If so, no further concurrent recall or mount activity will be attempted for this VTV.
	Consolidated	Indicates if VSM has consolidated the VTV.
	Fenced	Indicates if VSM has fenced the VTV.
	Imported	Indicates if VSM has imported the VTV from another tapeplex. Imported VTVs cannot be modified or used for scratch mounts.
	Migrated	Indicates if VSM has migrated the VTV.
	Migration Pending	Indicates if VTV migration is pending. This status is displayed when a VTV is initially created, or when the VTV requires reconciling or archiving. In these latter cases, individual MVC copies may indicate Reconcile or Deletion.
	Mounted	Indicates if the VTV is currently mounted.
	New Create	Indicates if the VTV is newly created.
	Resident	Indicates if the VTV is resident on the VTSS.
	Scratch	Indicates if the VTV is a scratch volume.
	Multiple Start	Used to track the start of multi-volume chaining when a data set runs off the end of one volume onto another.
	Multiple Next	Used to track the end of multi-volume chaining when a data set runs off the end of one volume onto another.
	Refresh	The last refresh date and time.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
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	Selected Row Data	Show data for selected rows
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	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
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	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










MVCs Containing VTV

This data table displays a list of all MVCs containing the VTV selected in the Virtual Tape Volumes (VTVs) data table.

You may need to scroll horizontally or detach the table to view all columns.

Click a row to display VTVs for that MVC in the VTVs on MVC data table.

The status for some fields is summarized with a status indicator:


	Icon	Name	Description
	[image: Surrounding text describes good.jpg.]
	Good	Indicates no threshold violations are detected
	[image: Surrounding text describes caution.jpg.]
	Caution	Indicates warning thresholds have been exceeded
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates critical thresholds have been exceeded
	[image: Surrounding text describes unknown.jpg.]
	Unknown	Indicates status could not be detected






Click a status indicator to display its details.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Fields with a context menu indicator can initiate Management commands on specific data items. Right click a field to display the context menu and select the command.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	MVC Tapeplex	The tapeplex the MVC belongs to.
	MVC Volser	The volser of the MVC.
Context menu: Audit MVC Volser, MVC Drain, Reclaim, Reconcile.


	Media	The volume media type or recording technique.
If Need PTF is displayed, then this host lacks support for this media type, but another host does have support for this media type.


	Media Size (MB)	The size of the MVC in megabytes.
	Storage Class	The Storage Class that owns the MVC. MVCs only become a member of a storage class when they contain migrated VTVs.
Context menu: MVC Drain, Reclaim, Reconcile


	MVC Pool	The name of the MVC Pool the MVC is in.
Context menu: MVC Drain, Reclaim.


	Number of VTVs Migrated	The number of current VTVs migrated to this MVC.
	VTV Count	The number of active VTVs on the MVC.
	Available (GB)	The size of the space available in the MVC for additional VTVs.
	Used (GB)	The size of the space in the MVC used by current VTVs.
	Fragmented (GB)	The size of the space in the MVC used by fragmented VTVs.
	Unavailable (GB)	The size of the space in the MVC that is not available for use.
	Available Percentage	The percentage of the MVC that is physically available for use.
	Used Percentage	The percentage of the MVC used by current VTVs.
	Fragmented Percentage	The percentage of the MVC that contains noncurrent VTVs. This space is not available for use until it is reclaimed or the MVC is drained.
	Usable Percentage	The percentage of space on the MVC that can be used by VTCS. This may be zero even if there is still space physically available. For instance, if the VTV per MVC limit is reached then the usable percentage is reported as zero. Similarly, if an error has been reported against an MVC, VTCS does not use this MVC for output and the usable percentage is reported as zero.
	Times Mounted	The number of times the MVC has been mounted for writing or reading since it was added to the MVC inventory.
	Last Mounted	The date and time at which the MVC was mounted or attempted to be mounted on a RTD.
	Last Migration	The date and time at which the last VTV migration was performed to the MVC.
	Last Drain/Reclaim	The date and time at which the MVC was last processed by Drain or Reclaim processing and its end-of-tape pointer was reset.
	VTSS Last Mounted	The name of the last VTSS that performed a migration to the MVC.
Context menu: Audit VTSS, Vary VTSS.


	Block ID	The Block ID of the VTV on the MVC.
	Partition ID	The Partition ID of the VTV on the MVC.
	First Migrated	The date the VTV was first migrated to the MVC.
	Initialized	Indicates the MVC's initialization status, either standard, partitioned, or not initialized.
	Audit	Indicates if the MVC is either currently being audited or has been the subject of a failed audit. While in this state the MVC is not used for migration but can be used for recalls. Due to the inherent state, recalls may fail because the CDS is not yet up-to-date with the MVC contents. To clear this condition, rerun the audit against this MVC.
	Broken	Indicates if the MVC, drive, or combination of the two has a problem. VTCS attempts to depreference MVCs with this state. If the MVC caused the problem, use a DRAIN(EJECT) command to remove the MVC from service. If the RTD caused the problem, use the MVCMAINT utility to reset the MVC state.
	Consolidation	Indicates if the MVC is consolidation MVC.
	Data Check	A data check condition has been reported against this MVC. VTCS attempts to depreference the usage of MVCs with this state. To get into this state, a data transfer must have failed upon two different RTDs.
To clear this state:

If all VTVs on the MVC are duplexed, run MVC Drain on the MVC without the Eject option. This recovers all VTVs and removes the MVC from service.

If all VTVs on the MVC are not duplexed, run VTCS AUDIT on the MVC. The audit may fail. After the audit, do an MVCDRAIN (no eject). This recalls the VTVs before the data-check area in ascending block-id order and the VTVs after the data-check area in a descending block-id order. Processing the VTVs in this sequence ensures that VTCS recovers as many VTVs as possible from the media. You then need to recreate the data for any VTVs still on the MVC.

Although this indicates that a specific failure has occurred when performing data transfers, this may not be a fault in the media. It could be that a RTD is writing data to the media out of specification. Patterns of failures are therefore important. As an example, lots of DATA CHECK conditions suddenly occurring lots of drives and volumes.


	Deduplication	Indicates if the MVC is deduplicated.
	Drain	Indicates if the MVC is currently the subject of drain or reclaim processing. Should the processing fail, the MVC may be left in this state as a safeguard. To clear this condition, perform a MVCDRain against the MVC.
	Eject	Indicates if the MVC has been ejected.
	Export	Indicates if the MVC is an export MVC.
	Full	Indicates if there is no space available on the MVC.
	Invalid MIR	Indicates if VTCS has received status from an RTD to indicate the MIR (media information record) for a 9x40 media is invalid. An invalid MIR does not prevent access to data but may cause significant performance problems while accessing records on the tape. The MVC is not capable of high-speed searches on areas of the tape that do not have a valid MIR entry.
VTCS attempts to depreference MVCs with this condition. For recalls, if the VTV resides on multiple MVCs, VTCS selects MVCs with valid MIRs ahead of MVCs with invalid MIRs. VTCS avoids using MVCs with invalid MIRs for migration, unless the migration is at the beginning of the tape. Migrating from the beginning of tape corrects the MIR. VTCS detects the invalid MIR condition at either mount time or dismount time. If detected at mount time and the operation can be completed with another MVC, VTCS dismounts the first MVC and selects the alternate MVC.

VTCS has only a limited ability to switch to an alternate MVC. That is, it is mainly used for migrate and virtual mount. For MVCs with invalid MIRs, determine the cause of the error, which may be caused by media or drive problems, and fix the error. To recover an MVC with an invalid MIR, read the MVC to the end of the tape, with a VTCS audit. If the media is the problem, run an MVCDRAIN EJECT to recall the VTVs and cause the MVC to be removed from the MVC pool.


	Lost	Indicates if VTCS attempted to mount an MVC and the mount did not complete within a 15-minute time out period. VTCS has had no specific error report although there could be combination of hardware problems, HSC problems, or by the MVC being removed from the ACS. VTCS attempts to depreference the usage of MVCs with this state. Determine the cause of the error and fix it.
You can also use the VTCS MVCMAINT utility to set LOST(OFF) for the following events:

LOST(ON) was set due to LSM failures or drive errors that have been resolved.

LOST(ON) was set because the MVC was outside the ACS and has been reentered.

This condition is automatically cleared by VTCS if it subsequently requests a mount of the MVC and this is successful.


	Maximum VTV	Indicates if the MVC has reached the maximum number of VTVs.
	Mounted	Indicates if the MVC is mounted on an RTD.
	Protected	Indicates if the MVC is protected.
	Read-only	Indicates if the MVC has been marked read-only:
If this is due to the MVC being the target of an export or consolidation process, the read-only state protects the MVC from further updates.

If the MVC media is set to file protect, correct the error and use the MVCMAINT utility to set READONLY(OFF).If the MVC does not have the appropriate SAF rules set to enable VTCS to update the MVC, correct the error and use the MVCMAINT utility to set READONLY(OFF).


	Retired	Indicates if the MVC is retired and is considered by VTCS as having reached the end of its useful life. VTCS recalls from, but does not migrate to, the MVC. Replace the MVC as soon as possible. Once this has been done, use the MVCMAINT utility to set RETIRED(OFF).
	Usable	Indicates if the MVC can be used for migration.
	VLE Synchronization Pending	Indicates if a VLE synchronization is pending.
	Warranty Expired	Indicates if the MVC's warranty has expired. VTCS continues to use the MVC but you should start making plans to replace the MVC when it reaches Retired state.
	Last Verified	The date and time the last VTV media verify was performed to the MVC. This date reflects the last time that VTCS knew the MVC contents were valid.
	ACS	The ACD ID where the MVC resides.
	VLE	The VLE where the MVC resides.
	Consolidated Date	For a consolidation MVC, the date and time of the consolidation.
	EOT Block ID	The end-of-tape block ID.
	EOT Partition ID	The end-of-tape partition ID.
	Block ID First Space	The block ID of the first space on the MVC.
	Refreshed	The date and UTC time the data was stored or last updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Remove Pane icon]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









VTV States

This graph shows VTV counts for each tapeplex, with current state summarized as Warning, Critical, or Good.

Warning includes VTVs in Migrate Pending state.

Critical includes VTVs in Avoid Early Mount or Fenced state.

Good includes VTVs in none of the above states.

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









VTV Compression

This graph shows VTV counts by tapeplex, sorted by compression percentage range.

To display, select Display and VTV on the navigation tree.

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Filter Data icon]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard









VTV Counts

This graph shows VTV scratch and resident counts by tapeplex, sorted by current status.

Hover on an object to display summary data for the object.

Hover on a label to highlight related objects on the graph.

Click an object to filter the data table by that object.

Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes verticalbargraph.jpg.]
	Vertical bar graph	Display the graph as a vertical bar chart
	[image: Surrounding text describes horizontalbargraph.jpg.]
	Horizontal bar graph	Display the graph as a horizontal bar chart
	[image: Surrounding text describes stackbargraph.jpg.]
	Stacked bar graph	Display the graph as a stacked bar chart
	[image: Surrounding text describes piechart.jpg.]
	Pie chart	Display the graph as a pie chart
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard
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This menu provides access to the following VSM GUI panes:


	
Command Log



	
Audit



	
MVC Drain



	
Reclaim



	
Reconcile



	
Vary









Command Log






Command Log

The Command Log lists all the commands submitted by users through the Management menu of VSM GUI.

When a command is selected from the list, the command output details are displayed in the Detail tabs beneath the list.

To display the Command Log, select Management and Command Log on the navigation tree.

Click a row to display the output for that command in the Detail tabs. Depending on the selected command, these tabs may include:

	
Audit Output


	
Exceptions


	
MVC Results


	
Tapeplex Results


	
VTVs Moved


	
VTV Results


	
Electronic Exports


	
Vary Output


	
Canceled Processes




Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Exceptions are denoted in the Exceptions column with an icon:


	Icon	Name	Description
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates exceptions occurred during the running of a command.






Click the icon to display the Exceptions tab.

Table columns and descriptions include:


	Column	Description
	Submitted	The time the command was submitted.
	User Name	The user name that submitted the command.
	Tapeplex	The tapeplex the command was run on.
	Command Type	The type of command issued:
AUDIT

MVC DRAIN

RECLAIM

RECONCILE

VARY CLINK

VARY DRIVE

VARY VTSS


	Command	The actual command that was sent to ELS.
	Status	The current status of the command:SubmittedCompleted
	Completed	The date and time ELS completed running the command.
	Exception	Any exceptions that occurred during the running of a command.








Audit Output

The Audit Output detail tab lists Audit events resulting from the command that is currently selected in the Command Log.

Table columns and descriptions include:


	Column	Description
	MVC VTV	The MVC volser (collapsed) and its VTV volsers (expanded)
	Audit Event	A VSM audit action
	Block ID	The Block ID of the audited VTV
	Uncompressed Size (MB)	The uncompressed size of the VTV in megabytes
	Management Class	The management class assigned to the VTV
	Number of VTVs Audited	The number of VTVs in the MVC that were audited
	Process ID	The process ID, which is a unique number in the range 0 - 65536






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Exceptions

The Exceptions detail tab lists by tapeplex exceptions resulting from the command that is currently selected in the Command Log.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Error Number	The error number
	Error Message	The error message associated with the error number






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










MVC Results

The MVC Results detail tab lists by MVC the results of the command that is currently selected in the Command Log.

Table columns and descriptions include:


	Column	Description
	MVC VTV	The MVC volser (collapsed) and its VTV volsers (expanded)
	ACS Location	The name of the ACS where the MVC is located
	Storage Manager Location	The Storage Manager assigned to the MVC
	Media	The media type of the MVC
	Media Size (MB)	The media size of the MVC in megabytes
	Storage Class	The Storage Class assigned to the MVC
	Candidate VTV Count	The number of VTVs in the MVC
	Total VTV Size (MB)	The total size of the MVC in megabytes






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Tapeplex Results

The Tapeplex Results detail tab lists by tapeplex the results of the command that is currently selected in the Command Log.

The Command types are:

	
AUDIT_MVC


	
AUDIT_VTSS


	
CANCEL


	
MVC_DRAIN


	
RECLAIM


	
RECONCILE


	
VARY_CLINK


	
VARY_RTD


	
VARY_VTSS




The Status values are:

	
STARTING


	
RUNNING


	
PARTIAL


	
SUCCESSFUL


	
FAILED




Table columns and descriptions include:


	Column	Description
	Tapeplex VTV	The name of the tapeplex (collapsed) and its VTV volsers (expanded)
	Candidate VTV Count	The total number of VTVs
	Total VTV Size (MB)	The total size of the VTVs in megabytes






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










VTVs Moved

The VTVs Moved detail tab lists by moved VTV the results of the command that is currently selected in the Command Log.

Table columns and descriptions include:


	Column	Description
	MVC VTV	The MVC volser (collapsed) and its VTV volsers (expanded)
	MVC Volser Recalled From	The MVC volser the VTV was recalled from
	Block ID Recalled From	The Block ID the VTV was recalled from
	VTSS Recalled From	The VTSS the VTV was recalled from
	MVC Volser Migrated To	The MVC volser the VTV was migrated to
	Block ID Migrated To	The Block ID the VTV was migrated to
	VTSS Migrated To	The VTSS the VTV was migrated to
	Reason	The reason the MVC was recalled or migrated
	VTVs Recalled /Migrated	The number of VTVs in the MVC that were recalled or migrated






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










VTV Results

The VTV Results detail tab lists by VTV the results of the command that is currently selected in the Command Log.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex where the VTV is located
	VTV Volser	The volser of the VTV
	Uncompressed Size (MB)	The uncompressed VTV size in megabytes
	Compressed Size (MB)	The compressed VTV size in megabytes
	Compression Percentage	The VTV compression percentage
	Created	The VTV creation date and time
	Management Class	The management class assigned to the VTV
	MVC Volser	The name of the MVC volser for the reconciled VTV
	Tapeplex	The name of the new tapeplex for the reconciled VTV
	Reason	The reason the VTV was reconciled






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Electronic Exports

The Electronic Exports detail tab lists VTVs that were electronically exported by the command that is currently selected in the Command Log.

Electronic Exports that were rejected are denoted in the Rejected column with an icon:


	Icon	Name	Description
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates exceptions occurred during the running of a command.






Click the icon to display the Exceptions tab.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex where the VTV resides
	VTV Volser	The volume serial number of the electronically exported VTV
	Tapeplex Exported To	The name of the tapeplex the VTV is electronically exported to
	MVC Volser Exported To	The MVC the VTV is electronically exported to
	Block ID Exported To	The Block ID the VTV is electronically exported to
	VTSS Exported To	The name of the VTSS the VTV is electronically exported to
	Rejected	Indicates if the electronic export has been rejected






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Vary Output

The Vary Output detail tab contains a link to the appropriate Display page (Display CLINK, Display Drive, or Display VTSS) where you can see the results of the command.






Canceled Processes

The Canceled Processes detail tab lists Queued and Active processes that were manually canceled.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex name.
	Host	The host running the process.
	Process ID	The Process ID for the function, which is a unique number in the range 0 - 65536. When the process ID reaches 65536 it wraps back to zero.
	Function	The type of request:
AllocSCR: Job allocation request for a scratch VTV.

AllocVTV: Job allocation request for a specific VTV.

Audit#: Audit utility request.

Cancel@: Cancel command.

Consold#: Consolidate or export utility task.

Consolid: Recall VTVs for remigration to a consolidation MVC. This appears as a child request to an Int_cons or Consold# request.

Dismount: Dismount a VTV from a VTD.

Display@: Display or query command.

Drain: Recall VTVs from MVC for remigration during drain or reclaim processing. This is a child of a VtvMover request.

Drain@: Drain command or utility.

DrainMVC: There is one DrainMVC request per MVC being drained. DrainMVC, which is a child request of a Drain@ request, is responsible for managing the entire drain process for a single MVC. The VTV column indicates the status of the processing against the MVC.

DELETSCR: Delete scratch utility.

Getmgpol: Obtain current management and storage class definitions.

Getconfig: Get configuration information

HSCChnge: Notification of parameter files being changed.

Import#: Importing of VTV or MVC by a utility.

Int_cons: PGMI initiated consolidate request

MEDVERfy: Media Verify parent task

Migrate: General request to perform the migrations of VTVs to a MVC. This may appear as a child to other request types.

Migrate@: Migrate command or utility. This includes migrates to threshold and auto migrates.

Mount: Mount a VTV upon a VTD. Depending upon circumstances, this may be subsequently seen as a VTV transfer or recall request.

Move MVC: There is one Move MVC request per MVC being processed by reconcile or archive. Move MVC, which is a child request of a MoveVTV# request, is responsible for managing the entire VTV movement process for a single MVC. The VTV column indicates the status of the processing against the MVC.


	
	MoveVTV#: This is a request from the ARCHIVE or RECONCILE utility commands to move copies of VTVs between MVCs. The value -TIME- in the VTV column indicates that the ELAPSED parameter was specified.
MvcMaint: MVCMAINT utility request.

MVC_chek: Check status of MVC.

MVC_eot: Reset the end of tape position of a MVC after completing a drain or reclaim. This is a child of either a DrainMVC, ReclmMVC or Move MVC request.

MVC_inv: Audit of an MVC. This appears as a child request to an Audit# request.MVCpool#: Obtain details and status of MVC pools for a utility.PGMI_req: A request received through the PGMI interface that has yet to be decoded.Query@l: Query or Display command.

MVC_upd: Reset or update MVC status.

Recall: General request to perform the recall of VTVs from a MVC. This may include a Cross TapePlex Autorecall (CTA) request from the mounting system. Recall may appear as a child to other request types.

Recall@: Recall command or utility.

Reclaim@: Auto reclaim request or a Reclaim command or utility. The value -TIME- in the VTV column indicates that the ELAPSED parameter was specified.

ReclmMVC: There is one ReclmMVC request per MVC being reclaimed. ReclmMVC, which is a child request of a Reclaim@ request, is responsible for managing the entire reclaim process for a single MVC. The VTV column indicates the status of the processing against the MVC.

Reconcil: Perform a crosscheck between the contents of the two VTSSs in a cluster.

Replicat: Perform the replication of VTVs between VTSSs in a cluster.

Scratch: Scratch a VTV request from HSC.

Sel_scr: PGMI select scratch

Set@: Set command.

Transfer: Mount a VTV upon a VTD by transferring the VTV between two VTSSs.

Unload: Unload MVC from RTD.

Uscratch: Unscratch a VTV request from HSC.

Vary_dev: Perform very processing against an individual RTD or CLINK. This appears as a child request to an VARY@ request.

Vary@: Vary command.

VtvMaint: VTVMAINT utility request.


	
	VTVMover: There is one VTVMover request per MVC being drained or reclaimed. This is a child of either a DrainMVC, ReclmMVC or Move MVC request. This request is responsible for the movement of VTVs from one MVC to another.
VTSS_inv: Audit of a VTSS. This appears as a child request to an Audit# request.

VTSS_list: Obtain a list of VTV resident within a VTSS. This appears as a child request to a Reconcil or auto migration request.

VTV_upd: Resynchronize VTV status in the VTSS with the CDS.


	Parent ID	The ID of the parent process associated with the request.
	VTSS	The VTSS name or the VTSS list name associated with the request.
	VTV Volser	The volser of the VTV currently being used in the process.
	MVC Volser	The volser of the MVC currently being used in the process.
	RTD Device Address	The unit address of the RTD currently being used in the process.
	VTD Device Address	The device address of the VTD currently being used in the process
	Task Type	The task that is processing the queue or the task to which the request is queued.
	Reason	The reason why the process is active.
	ACS	The ACS the process is using.
	LSM	The LSM the process is using.
	Storage Manager	The Storage manager the process is using.
	Internal Device Type	The Internal device type the process is using.
	For Mount	Indicates if the process is for a mount.
	For VTV Move	Indicates if the process is for VTV moves.
	Local Wait Time (mins)	The local wait time in minutes.
	Storage Class	The storage class for migration targets.
	Refreshed	The date and UTC time the data was stored or updated.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes refreshsmena.png.]
	Run ELS	Refresh data by running the necessary ELS commands to update all of the database tables that are referenced on the page
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Audit






Audit

The Audit command request issues a direct request to ELS to run the AUDIT command. AUDIT updates the MVC and VTV information in the HSC CDS.

Select Management and Audit on the navigation tree to display this pane.

Select the tapeplex to audit on the drop-down list.

Then select Audit by MVC or Audit by VTSS.



Audit by MVC

If Audit by MVC was selected, enter the MVC volsers to audit, separated by commas, or click the magnifying glass to display the Select MVCs dialog box.

In the Select MVCs dialog box, type in your search string and then click Apply. The search operator looks for volsers containing the search string.

The search results are listed in the Tapeplex and MVC Volser fields.

To search again, click Reset to blank the search field and start over.

To select a volser, click the volser and then click OK.

To select more than one volser, click the first volser, then press CTRL while clicking the other volsers required. Use the arrow button to move the volsers to the Selected column. Then click OK.

To select a range of volsers, click the first volser in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range. Use the arrow button to move the range of volsers to the Selected column. Then click OK.

When the MVC volsers to audit have been selected, they are displayed on the Audit Command pane.

Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Audit by VTSS

If Audit by VTSS was selected, click the magnifying glass to display a dialog box with available VTSSs in the specified tapeplex.

In the Available column, click the VTSS to audit and then click the arrow button to move it to the Selected column. Then click OK.

To select more than one VTSS, click the first VTSS, then press CTRL while clicking the other VTSSs required. Use the arrow button to move the VTSSs to the Selected column. Then click OK.

To select a range of VTSSs, click the first VTSS in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range. Use the arrow button to move the range of VTSSs to the Selected column. Then click OK.

To move all VTSSs to the Selected column, click the double arrow button. Then click OK.

The selected VTSSs are displayed on the Audit Command pane for submission to the host.

Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






MVC Drain






MVC Drain

The MVC Drain command request issues a direct request to ELS to run the MVCDRain command. MVC Drain recalls all current and scratched VTVs from an MVC and, optionally, virtually ejects the MVC, making it unavailable for VSM use without physically ejecting it from the library

Select Management and MVC Drain on the navigation tree to display this pane.

Select the tapeplex to drain on the drop-down list.

Then select one of the following:

	
Drain by MVC


	
Drain by MVC Pool


	
Drain by Storage Class






Drain by MVC

If Drain by MVC was selected, enter the MVC volsers to drain, separated by commas, or click the magnifying glass to display the Select MVCs dialog box.

In the Select MVCs dialog box, type in your search string and then click Apply. The search operator looks for volsers containing the search string.

The search results are listed in the Tapeplex and MVC Volser fields.

To search again, click Reset to blank the search field and start over.

To select a volser, click the volser to highlight it and then click OK.

To select more than one volser, click the first volser, then press CTRL while clicking the other volsers required. Use the arrow button to move the volsers to the Selected column. Then click OK.

To select a range of volsers, click the first volser in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range. Use the arrow button to move the range of volsers to the Selected column. Then click OK.

When the MVC volsers have been selected, they are displayed in the MVC Drain Command pane.

Select optional parameters:

	
EJECT specifies that VTCS virtually ejects the MVC (the MVC will not be used for output) and physically deletes the VTVs. Without this parameter, the VTVs are not physically deleted but the CDS record is updated to show no VTVs on the MVC.


	
WARRANTY selects MVCs with expired warranties.


	
ERROR selects MVCs that are in error.


	
CONMVC specifies the maximum number of MVCs that VTCS concurrently processes for both drain and reclaim. Valid values are 1 to 99. If not specified, the default is the CONMVC value specified on the CONFIG RECLAIM statement.


	
NOWAIT specifies that the utility does not wait for the operation to complete and returns after the request is submitted.


	
RETIRED selects MVCs that are retired.


	
DATACHK selects MVCs that have a data check.


	
RECALWER specifies whether VTCS recalls VTVs with read data checks. NO is the default. YES recalls VTVs with read data checks.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Drain by MVC Pool

If Drain by MVC Pool was selected, select the MVC Pool to drain on the drop-down list.

When the MVC Pool has been selected, it is displayed in the MVC Drain Command pane.

Select optional parameters:

	
EJECT specifies that VTCS virtually ejects the MVC (the MVC will not be used for output) and physically deletes the VTVs. Without this parameter, the VTVs are not physically deleted but the CDS record is updated to show no VTVs on the MVC.


	
WARRANTY selects MVCs with expired warranties.


	
ERROR selects MVCs that are in error.


	
CONMVC specifies the maximum number of MVCs that VTCS concurrently processes for both drain and reclaim. Valid values are 1 to 99. If not specified, the default is the CONMVC value specified on the CONFIG RECLAIM statement.


	
NOWAIT specifies that the utility does not wait for the operation to complete and returns after the request is submitted.


	
RETIRED selects MVCs that are retired.


	
DATACHK selects MVCs that have a data check.


	
RECALWER specifies whether VTCS recalls VTVs with read data checks. NO is the default. YES recalls VTVs with read data checks.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Drain by Storage Class

If Drain by Storage Class was selected, select the Storage Class to drain on the drop-down list.

When the Storage Class has been selected, it is displayed in the MVC Drain Command pane.

Select optional parameters:

	
EJECT specifies that VTCS virtually ejects the MVC (the MVC will not be used for output) and physically deletes the VTVs. Without this parameter, the VTVs are not physically deleted but the CDS record is updated to show no VTVs on the MVC.


	
WARRANTY selects MVCs with expired warranties.


	
ERROR selects MVCs that are in error.


	
CONMVC specifies the maximum number of MVCs that VTCS concurrently processes for both drain and reclaim. Valid values are 1 to 99. If not specified, the default is the CONMVC value specified on the CONFIG RECLAIM statement.


	
NOWAIT specifies that the utility does not wait for the operation to complete and returns after the request is submitted.


	
RETIRED selects MVCs that are retired.


	
DATACHK selects MVCs that have a data check.


	
RECALWER specifies whether VTCS recalls VTVs with read data checks. NO is the default. YES recalls VTVs with read data checks.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Reclaim






Reclaim

The Reclaim command request issues a direct request to ELS to run the RECLAIM command. RECLAIM performs demand MVC space reclamation.

Select Management and Reclaim on the navigation tree to display this pane.

Select the tapeplex to reclaim space from on the drop-down list.

Then select one of the following:

	
Reclaim by All MVCs


	
Reclaim by MVC


	
Reclaim by MVC Pool


	
Reclaim by Storage Class


	
Reclaim by ACS






Reclaim by All MVCs

If Reclaim by All was selected, all MVCs across the tapeplex will be examined for Reclaim eligibility regardless of MVC Pool, Storage Class, or ACS.

Select optional parameters:

	
MAXMVC: Maximum number of MVCs processed by a single space reclamation task. Valid values are 1 to 98. The default is the CONFIG RECLAIM value.


	
INPTHRESH: Percentage of fragmented space that makes a partitioned MVC eligible for dynamic reclaim processing. Valid values are 3 to 97. The default is the current active global INPTHRSH value.


	
CONMVC: Maximum number of MVCs to concurrently process. Valid values are 1 to 99. The default is the CONFIG RECLAIM value.


	
THRESH: Percentage of fragmented space that makes an MVC eligible for demand or automatic reclamation. Valid values are 4 to 98. The default is the CONFIG RECLAIM value.


	
ELAPSE: Maximum time for reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reclaim process.


	
NOWAIT: Do not wait for operation to complete. Return after the request is submitted.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Reclaim by MVC

If Reclaim by MVC was selected, enter the MVC volsers to reclaim, separated by commas, or click the magnifying glass to display the Select MVCs dialog box.

In the Select MVCs dialog box, type in your search string and then click Apply. The search operator looks for volsers containing the search string.

The search results are listed in the Tapeplex and MVC Volser fields.

To search again, click Reset to blank the search field and start over.

To select a volser, click the volser to highlight it and then click OK.

To select more than one volser, click the first volser, then press CTRL while clicking the other volsers required. Use the arrow button to move the volsers to the Selected column. Then click OK.

To select a range of volsers, click the first volser in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range. Use the arrow button to move the range of volsers to the Selected column. Then click OK.

When the MVC Reclaim candidates have been selected, they are displayed on the Reclaim Command pane.

Select optional parameters:

	
MAXMVC: Maximum number of MVCs processed by a single space reclamation task. Valid values are 1 to 98. The default is the CONFIG RECLAIM value.


	
INPTHRESH: Percentage of fragmented space that makes a partitioned MVC eligible for dynamic reclaim processing. Valid values are 3 to 97. The default is the current active global INPTHRSH value.


	
CONMVC: Maximum number of MVCs to concurrently process. Valid values are 1 to 99. The default is the CONFIG RECLAIM value.


	
THRESH: Percentage of fragmented space that makes an MVC eligible for demand or automatic reclamation. Valid values are 4 to 98. The default is the CONFIG RECLAIM value.


	
ELAPSE: Maximum time for reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reclaim process.


	
NOWAIT: Do not wait for operation to complete. Return after the request is submitted.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Reclaim by MVC Pool

If Reclaim by MVC Pool was selected, select the MVC Pool to reclaim space from on the drop-down list.

Select optional parameters:

	
MAXMVC: Maximum number of MVCs processed by a single space reclamation task. Valid values are 1 to 98. The default is the CONFIG RECLAIM value.


	
INPTHRESH: Percentage of fragmented space that makes a partitioned MVC eligible for dynamic reclaim processing. Valid values are 3 to 97. The default is the current active global INPTHRSH value.


	
CONMVC: Maximum number of MVCs to concurrently process. Valid values are 1 to 99. The default is the CONFIG RECLAIM value.


	
THRESH: Percentage of fragmented space that makes an MVC eligible for demand or automatic reclamation. Valid values are 4 to 98. The default is the CONFIG RECLAIM value.


	
ELAPSE: Maximum time for reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reclaim process.


	
NOWAIT: Do not wait for operation to complete. Return after the request is submitted.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Reclaim by Storage Class

If Reclaim by Storage Class was selected, select the Storage Class to reclaim MVC space from on the drop-down list.

Select optional parameters:

	
MAXMVC: Maximum number of MVCs processed by a single space reclamation task. Valid values are 1 to 98. The default is the CONFIG RECLAIM value.


	
INPTHRESH: Percentage of fragmented space that makes a partitioned MVC eligible for dynamic reclaim processing. Valid values are 3 to 97. The default is the current active global INPTHRSH value.


	
CONMVC: Maximum number of MVCs to concurrently process. Valid values are 1 to 99. The default is the CONFIG RECLAIM value.


	
THRESH: Percentage of fragmented space that makes an MVC eligible for demand or automatic reclamation. Valid values are 4 to 98. The default is the CONFIG RECLAIM value.


	
ELAPSE: Maximum time for reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reclaim process.


	
NOWAIT: Do not wait for operation to complete. Return after the request is submitted.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Reclaim by ACS

If Reclaim by ACS was selected, select the ACS to reclaim MVC space from on the drop-down list.

Select optional parameters:

	
MAXMVC: Maximum number of MVCs processed by a single space reclamation task. Valid values are 1 to 98. The default is the CONFIG RECLAIM value.


	
INPTHRESH: Percentage of fragmented space that makes a partitioned MVC eligible for dynamic reclaim processing. Valid values are 3 to 97. The default is the current active global INPTHRSH value.


	
CONMVC: Maximum number of MVCs to concurrently process. Valid values are 1 to 99. The default is the CONFIG RECLAIM value.


	
THRESH: Percentage of fragmented space that makes an MVC eligible for demand or automatic reclamation. Valid values are 4 to 98. The default is the CONFIG RECLAIM value.


	
ELAPSE: Maximum time for reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reclaim process.


	
NOWAIT: Do not wait for operation to complete. Return after the request is submitted.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Reconcile






Reconcile

The Reconcile command request issues a direct request to ELS to run the RECONcil command. Reconcile performs cross-checks between the MVCs, VTVs, Storage Class, and Management Class definitions. VTVs are optionally moved from one Storage Class to another to reconcile VTV media and location.

Select Management and Reconcile on the navigation tree to display this pane.

Select the tapeplex to reconcile on the drop-down list.

Select one of the following to define which MVCs will be checked:

	
Reconcile by All MVCs


	
Reconcile by MVC


	
Reconcile by Storage Class






Reconcile by All MVCs

Click All MVCs to select all MVCs as reconciliation candidates.

MVCs can be further filtered to reconcile the following:

	
Reconcile All VTVs in All MVCs


	
Reconcile Selected VTVs in All MVCs


	
Reconcile by Management Class in All MVCs






Reconcile All VTVs in All MVCs

If Reconcile by All VTVs is also selected, All VTVs in All MVCs will be reconciled.

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Reconcile Selected VTVs in All MVCs

If Reconcile by VTV is also selected, only the selected VTVs in all MVCs will be reconciled. Enter the VTV volsers to reconcile, separated by commas, or click the magnifying glass to display the Select VTVs dialog box.

In the Select VTVs dialog box, type in your search string and then click Apply. The search operator looks for volsers containing the search string.

The search results are listed in the Tapeplex and VTV Volser fields.

To search again, click Reset to blank the search field and start over.

To select a volser, click the volser and then click OK.

To select more than one volser, click the first volser, then press CTRL while clicking the other volsers required. Use the arrow button to move the volsers to the Selected column. Then click OK.

To select a range of volsers, click the first volser in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range. Use the arrow button to move the range of volsers to the Selected column. Then click OK.

Selected VTVs are displayed on the Reconcile Command pane.

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Reconcile by Management Class in All MVCs

If Reconcile by Management Class is also selected, all VTVs in the selected Management Classes in all MVCs will be reconciled. Click the magnifying glass to display a dialog box with all defined Management Classes in the specified tapeplex.

In the Available column, click the class to reconcile and then click the arrow button to move it to the Selected column. Then click OK.

To select more than one class, click the first class, then press CTRL while clicking the other classes required. Use the arrow button to move the classes to the Selected column. Then click OK.

To select a range of classes, click the first class in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range. Use the arrow button to move the range of classes to the Selected column. Then click OK.

To move all classes to the Selected column, click the double arrow button. Then click OK.

The selected Management Classes are displayed on the Reconcile Command pane.

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.








Reconcile by MVC

Click MVC to specify selected MVCs as reconciliation candidates.

If Reconcile by MVC is selected, enter the MVC volsers to reconcile, separated by commas, or click the magnifying glass to display the Select MVCs dialog box.

In the Select MVCs dialog box, type in your search string and then click Apply. The search operator looks for volsers containing the search string.

The search results are listed in the Tapeplex and MVC Volser fields.

To search again, click Reset to blank the search field and start over.

To select a volser, click the volser and then click OK.

To select more than one volser, click the first volser, then press CTRL while clicking the other volsers required. Use the arrow button to move the volsers to the Selected column. Then click OK.

To select a range of volsers, click the first volser in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range. Use the arrow button to move the range of volsers to the Selected column. Then click OK.

Selected VTVs are displayed on the Reconcile Command pane.

MVCs can be further filtered to reconcile the following:

	
Reconcile All VTVs in Selected MVCs


	
Reconcile Selected VTVs in Selected MVCs


	
Reconcile by Management Class in Selected MVCs






Reconcile All VTVs in Selected MVCs

If Reconcile by All VTVs is also selected, all VTVs in the selected MVCs will be reconciled.

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Reconcile Selected VTVs in Selected MVCs

If Reconcile by VTV is also selected, only the selected VTVs in the selected MVCs will be reconciled. Enter the VTV volsers to reconcile, separated by commas, or click the magnifying glass to display the Select VTVs dialog box.

In the Select VTVs dialog box, type in your search string and then click Apply. The search operator looks for volsers containing the search string.

The search results are listed in the Tapeplex and VTV Volser fields.

To search again, click Reset to blank the search field and start over.

To select a volser, click the volser and then click OK.

To select more than one volser, click the first volser, then press CTRL while clicking the other volsers required. Use the arrow button to move the volsers to the Selected column. Then click OK.

To select a range of volsers, click the first volser in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range. Use the arrow button to move the range of volsers to the Selected column. Then click OK.

Selected VTVs are displayed on the Reconcile Command pane.

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Reconcile by Management Class in Selected MVCs

If Reconcile by Management Class is also selected, all VTVs in the selected Management Classes in the selected MVCs will be reconciled. Click the magnifying glass to display a dialog box with all defined Management Classes in the specified tapeplex.

In the Available column, click the class to reconcile and then click the arrow button to move it to the Selected column. Then click OK.

To select more than one class, click the first class, then press CTRL while clicking the other classes required. Use the arrow button to move the classes to the Selected column. Then click OK.

To select a range of classes, click the first class in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range. Use the arrow button to move the range of classes to the Selected column. Then click OK.

To move all classes to the Selected column, click the double arrow button. Then click OK.

The selected Management Classes are displayed on the Reconcile Command pane.

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.








Reconcile by Storage Class

Click Storage Class to specify MVCs in selected Storage Classes as reconciliation candidates.

If Reconcile by Storage Class was selected, click the magnifying glass to display a dialog box with all Storage Classes in the specified tapeplex.

In the Available column, click the Storage Class and then click the arrow button to move it to the Selected column. Then click OK.

To select more than one Storage Class, click the first Storage Class, then press CTRL while clicking the other Storage Classes required. Use the arrow button to move the Storage Classes to the Selected column. Then click OK.

To select a range of Storage Classes, click the first Storage Class in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range. Use the arrow button to move the range of Storage Classes to the Selected column. Then click OK.

To move all Storage Classes to the Selected column, click the double arrow button. Then click OK.

The selected Storage Classes are displayed on the Reconcile Command Request pane.

MVCs can be further filtered to reconcile the following:

	
Reconcile All VTVs in Selected Storage Classes


	
Reconcile Selected VTVs in Selected Storage Classes


	
Reconcile by Management Class in Selected Storage Classes






Reconcile All VTVs in Selected Storage Classes

If Reconcile by All VTVs is also selected, all VTVs in the selected Storage Classes will be reconciled.

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Reconcile Selected VTVs in Selected Storage Classes

If Reconcile by VTV is also selected, only the selected VTVs in the selected Storage Classes will be reconciled. Enter the VTV volsers to reconcile, separated by commas, or click the magnifying glass to display the Select VTVs dialog box.

In the Select VTVs dialog box, type in your search string and then click Apply. The search operator looks for volsers containing the search string.

The search results are listed in the Tapeplex and VTV Volser fields.

To search again, click Reset to blank the search field and start over.

To select a volser, click the volser and then click OK.

To select more than one volser, click the first volser, then press CTRL while clicking the other volsers required. Use the arrow button to move the volsers to the Selected column. Then click OK.

To select a range of volsers, click the first volser in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range. Use the arrow button to move the range of volsers to the Selected column. Then click OK.

Selected VTVs are displayed on the Reconcile Command pane.

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Reconcile by Management Class in Selected Storage Classes

If Reconcile by Management Class is also selected, all VTVs in the selected Management Classes in the selected Storage Classes will be reconciled. Click the magnifying glass to display a dialog box with all defined Management Classes in the specified tapeplex.

In the Available column, click the class to reconcile and then click the arrow button to move it to the Selected column. Then click OK.

To select more than one class, click the first class, then press CTRL while clicking the other classes required. Use the arrow button to move the classes to the Selected column. Then click OK.

To select a range of classes, click the first class in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range. Use the arrow button to move the range of classes to the Selected column. Then click OK.

To move all classes to the Selected column, click the double arrow button. Then click OK.

The selected Management Classes are displayed on the Reconcile Command pane.

Select optional parameters:

	
MAXMVC: Specifies the maximum number of MVCs that will be processed by a single reconciliation task. Valid values are 1 to 98. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
ELAPSE: Specifies the maximum time for the reconciliation in minutes. Valid values are 1 to 1440. If not specified, there is no time limit on the reconciliation process. This parameter is ignored if MOVEVTV is not specified.


	
CONMVC: Specifies the maximum number of MVCs that VTCS concurrently processes during subsequent recall and migrate operations. Valid values are 1 to 99. If not specified the CONFIG RECLAIM value (or default) is used. This parameter is ignored if MOVEVTV is not specified.


	
MOVEVTV: Move VTVs per the currently active Management Policies as specified by the MGMTclas statements that apply to the VTVs. If you do not specify MOVEVTV, only a report is generated and no VTVs are moved.




Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.








Vary






Vary

The Vary command request issues a direct request to ELS to run the VARY command.

Select Management and Vary on the navigation tree to display this pane.

Select the tapeplex with devices to vary on the drop-down list.

Then select one of the following:

	
Vary by CLINK


	
Vary by RTD


	
Vary by VTSS






Vary by CLINK

If Vary by Clink was selected, select the VTSS and CLINK ID.

Select whether to vary the selection ONLINE or OFFLINE.

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Vary by RTD

If Vary by RTD was selected, click the magnifying glass to display a dialog box with all defined RTDs in the specified tapeplex.

In the Available column, click the RTD to vary and then click the arrow button to move it to the Selected column. Then click OK.

To select more than one RTD, click the first RTD, then press CTRL while clicking the other RTDs required. Use the arrow button to move the RTDs to the Selected column. Then click OK.

To select a range of RTDs, click the first RTD in the range and then press SHIFT and the down arrow key simultaneously to define and highlight the range. Use the arrow button to move the range of RTDs to the Selected column. Then click OK.

To move all RTDs to the Selected column, click the double arrow button. Then click OK.

The selected RTDs are displayed on the Vary Command Request pane.

Select whether to vary the selection ONLINE, OFFLINE, or MAINT.

Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.






Vary by VTSS

If Vary by VTSS was selected, select the VTSS to vary.

Select whether to vary the selection ONLINE, OFFLINE, or QUIESCED.

Submit the request:

In the Run Command on field, select Any Host or Specific Host. If you select Specific Host, identify the host in the Server Address field.

Click SUBMIT to continue. A confirmation dialog box is displayed. Click YES to submit the request to the host, or click NO to return to the previous pane.

When the operation is completed, the results are available for display on the Command Log pane.
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[image: Surrounding text describes vsmconsole.jpg.]

The VSM Console menu provides a mechanism for interaction with the VSM console (VSMc) server.







	
Note:

The VSM Console menu is only available for tapeplexes with ELS version 7.3.1 or higher.










This menu provides access to the following:


	
Command Line Interface



	
Configuration/Policy



	
Console Log









Command Line Interface






Command Line Interface

The Command Line Interface provides a facility for entering oVTCS commands and submitting them to the VSMc server for execution.

To issue a command, select the tapeplex and the appropriate node server address. Then type the command in the input text box and click Submit.




	
Note:

The server address IPs are the ones that were registered during Site Configuration to accept commands for that tapeplex. Address issues may be corrected in the Site Configuration by an administrator.







There are two tables on the Command Line Interface page:

	
The Command Log table lists the commands sent to the VSMc server.


	
The Command Output table lists replies for the command and the details of any exceptions that occurred.





Command Log Table

Commands that were executed from VSM GUI for the selected tapeplex are listed in chronological order, with the most recent at the top. The table is updated when you submit a new command.

Select a command in the table to display its details in the Command Output table.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Submitted	The date and time the request was submitted
	Username	The name of the user submitting the request
	Host	The server address
	Command	The command that was submitted
	Status	The status of the request
	Completed	The date and time the request was complected
	Exception	Indicates if any exceptions occurred
	Return Code	The return code for exceptions
	Reason Code	The reason code for exceptions






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard






Use the View menu to perform the following operations:


	View Option	Description
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns









Command Output Table

Details for the selected Command Log entry are shown in the Command Output table. The table lists replies for the command that were received from the VSMc server. Under a separate tab, details are listed for any exceptions that occurred.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for information about this feature.

Table columns and descriptions include:


	Column	Description
	Line Number	The line number in the reply
	Type	The line type, where T is a normal text message and E is an error text response
	Subtype	The line subtype, where C is a Control line, D is a Data line, E is the Last (end) line, L is a Label line, W is a single WTO line, H is a New page header, R is a Report header, and P is a Print line
	Text	The message text
	Error Number	For exceptions, the error number
	Error Message	For exceptions, the error message






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard






Use the View menu to perform the following operations:


	View Option	Description
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns
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Configuration/Policy

VSM configuration and policy files are managed from the Configuration/Policy tab on the VSM Console panel.

Tapeplex configuration parameters can be managed from data sets in a configuration file or a policy file or both. Each tapeplex supports a single configuration file and a single policy file. Each of these files can be accessed (downloaded or uploaded) through one of up to two hosts for each tapeplex.

VSM GUI supports the download and upload of a configuration file and a policy file for each tapeplex configured in the application. An editing function is available for updating file contents.

The following topics describe these functions:

	
Upload and Download Overview


	
File Management Details


	
VSMc-Configuration/Policy Panel


	
Edit File


	
Upload File


	
Download File






Upload and Download Overview

The storage locations and transmission paths of configurations and policies for tapeplexes managed by the VSM GUI application are illustrated in the Configuration and Policy File Management diagram.


Figure 7-1 Configuration and Policy File Management

[image: Surrounding text describes Figure 7-1 .]



The VSM GUI server (virtual machine) can store a copy of the configuration and policy for each tapeplex as a file in the server's file system. This is the file that is uploaded, or sent to the tapeplex for configuration or policy changes. This file can be edited before being uploaded to the tapeplex.

A configuration or policy that is downloaded is stored in the VSM GUI's database. This is a decomposition view (tapeplex's interpretation) of the configuration or policy, and cannot be manually edited on the server.

VSM GUI provides a simple editor for the configuration or policy files that will be uploaded to the tapeplex. You can use this editor to view and edit the server copy of the file, or a backup copy of that file, which is also stored on the VSM GUI's server.

The editor can also load a previously created configuration or policy file from the user computer's file system. It cannot write edited content directly back to the user's computer.

Regardless of the source, the edited content can then be written to the VSM GUI's server copy, for later upload to the associated tapeplex. A backup copy can also be made on the server. See Edit File for details on using this editor.

The file copies can also be directly modified on the server through a remote session with the VM using FTP or PuTTY. Providing the file name is not changed, the edited copy will be sent to the tapeplex during an upload operation.






File Management Details

Details on how both the Configuration file and the Policy files are managed on the VSM GUI server (virtual machine) file system and database are described below:

	
The file name is limited to 8 characters.


	
The files will be downloaded to the server where the VSM GUI application is deployed.


	
The configuration files will be stored in the /opt/vsmgui/config/config directory.


	
The policy files will be stored in the /opt/vsmgui/config/policy directory


	
The downloaded Configuration file will be named as CFGxxxxx, where xxxxx is the unique numeric file identifier assigned by the server and stored in the database along with the tapeplex name.


	
The downloaded Policy file will be named as POLxxxxx, where xxxxx is the unique numeric file identifier assigned by the server and stored in the database along with the tapeplex name.


	
The above file names are assigned automatically by the VSM GUI server (using unique identifiers) when the tapeplex is first defined and configured during Site Configuration.


	
The text content of each configuration or policy is stored on the VM server in two formats:

	
Flat file text format, in locations and file names described above. This content may be edited or replaced by the user through remote connection to the VM's file system. The contents of this flat file are transmitted to the tapeplex during the upload operation.


	
Database table format, with each line of each file as a separate record in the table. This content may not be modified by the user, and is only updated when the file decomposition is downloaded back again. This is the content displayed to the user in the Configuration and Policy File Management panel.





	
When a file download has been started, any existing file text content in the database table will be deleted in preparation for receiving the new file content. Therefore, if an error occurs in the file download process, the database content for that configuration or policy may be empty or only partially populated. However, the flat file content is not modified until after a successful download has completed. Then the entire flat file is replaced.


	
Caution: When downloading a file, the existing file on the VSMc server's file system at the location displayed to the user will be overwritten automatically. Therefore, the user is responsible for maintaining a master copy of the desired configuration or policy to be re-copied to the file location before each upload back to the tapeplex.


	
Both a file upload and a file download will update the status.









VSMc-Configuration/Policy Panel

VSM configuration and policy files are managed from the Configuration/Policy tab on the VSM Console panel.

Select the tapeplex from the menu at the top of the panel. Only tapeplexes running oVTCS (ELS version 7.3.1 or higher) are listed.

Select the server address from the menu at the top of the panel. Only server addresses configured for the selected tapeplex are listed.

The two panel boxes below the tapeplex and address selections display the file path and names of the configuration and policy files last downloaded from the selected tapeplex, and the date and time they were downloaded.

Below the file information section is a tool bar with control buttons including functions similar to controls on tables in other user interface panels. Below the toolbar is a display of the content of the configuration or policy decomposition.

The toolbar includes the following options:

	
View: Displays a menu of view options for the file content pane. This menu is most useful for hiding or showing the line number column. Hiding line numbers allows clipboard copy/paste to obtain content lines without line numbers preceding each line.


	
Edit File: Displays a dialog allowing the selected file to be viewed and edited, then saved back to the GUI server at the file path/name displayed. Content can be loaded and edited from the current file, a backup file, a file on the user's own computer, or from the last file download operation. See Edit File for details.


	
Upload: Uploads the current configuration (CONFIG) or policy (MGMTDEF) file to the selected tapeplex and activates it. See Upload File for details.


	
Download: Downloads the configuration (DECOMPILE) or policy (GETMGPOL) file from the selected tapeplex. See Download File for details.


	
Export to Excel: For the selected tapeplex, exports the configuration or policy file decomposition content to a file formatted for Microsoft Excel. The selected tapeplex name will be in the heading, and the file type (configuration or policy) will be in the content column header.


	
Printable Page: Opens a new browser tab with an abbreviated selection of both the configuration and policy file content. The entire content of either file may not be displayed. For full file content, use the Export to Excel button, or select content from the display pane (drag mouse cursor over content to be selected, then copy and paste.


	
Refresh File Content: After downloading file content, it may be a minute or two before the file download from the tapeplex has been completed. After this time, this button may be used to refresh the displayed file content. Verify the refresh with the File Last Downloaded field. Refreshing will reset the tapeplex selection back to the first tapeplex on the list. Re-select the tapeplex if necessary.


	
Detach: Displays the selected file content in a separate window.




Table columns and descriptions include:


	Column	Description
	Line	The line numbers in the configuration file
	Downloaded Configuration|Policy (Decomposition)	The contents of the downloaded file. This decomposition is the accepted result of the file upload, showing the tapeplex's interpretation of that uploaded file execution. It may not exactly match the upload file content.






Use the View menu to perform the following operations:


	View Option	Description
	Columns	Show all or selected columns and manage hidden and visible status.
	Detach	Display the table in a separate window
	Reorder Columns	Select the column sequence for Visible columns






The content pane shows the decomposition for either the configuration or the policy of the selected tapeplex after downloading. This decomposition is the accepted result of the file upload, showing the tapeplex's interpretation of that uploaded file execution.

This decomposition should show basically the same content as the file itself, and most of the content can be used directly in a modified configuration or policy file. However, the decomposition content may contain additional information that may not be compatible with the acceptable content of a configuration or policy file. Therefore, content shown should be evaluated for valid configuration or policy file commands or functionality.

Content shown in the pane can be copied with standard operating system copy/paste commands. For example, in Windows, you can drag the mouse cursor over multiple rows, use Ctrl-C to copy the selected content to the clipboard, then Ctrl-V to paste it into an external editor.

If line numbers are shown in the pane, they will be copied also. To copy content without line numbers, use the View menu to unselect display of the line number column, before copying content.

You can also use the Edit File button to display the file, and copy content from that window without line numbers.






Edit File




	
Note:

The locations and use of the editable files are in the Upload and Download Overview. See Upload and Download Overview for details.







Selecting the Edit File button on either the Configuration File or Policy File panel will display an editor dialog.


Figure 7-2 Editor Dialog

[image: Surrounding text describes Figure 7-2 .]



The top of the dialog offers selections for displaying and editing these files.

	
Current File: Loads the editor from the Current Upload File location displayed in the line above the buttons. This is the file that would be sent to the tapeplex if the Upload button on the underlying panel was clicked. Since this file can be overwritten by any subsequent download operation by any user, this file should be considered a transient file that should be reviewed and edited and saved just before any upload operation.


	
Backup File: Loads the editor with an optional backup file, if it had previously been saved by the user. This file is in the same directory location as the current file, but has the extension .bak appended to the file name. It is saved to the server when the Save to Backup File button at the bottom of the dialog is clicked.


	
Downloaded: Loads the editor with the content of the last file download operation. This content is the same as what is displayed in the underlying panel, as the decomposition of the tapeplex's configuration or policy. This content is generally usable as upload file content, but some decomposition content may contain invalid commands. For example, the line like CONFIG CDSLEVEL(V73ABOVE) frequently at the top of a downloaded configuration decomposition provides information about the configuration, but is not itself a valid command that can be included in the uploaded configuration file. This line must be removed from the file content if this button is used to create a configuration file.




The top three buttons load the editor with contents from the VSM GUI server's file system.




	
Caution:

Using any of these load buttons immediately replaces the entire editor content with the new content selected! There is no verification prompt warning of overwrite of any edited content.







Below the server file selection buttons is a button for loading the editor with local file content from the user's computer file system. This allows the option of managing versions of configuration and policy files for all tapeplexes in a user-defined repository, with greater control over backups and versions than what is provided on the VSM GUI's server. Files from the user's computer can only be loaded into the editor, for saving to the pre-defined current or backup copy on the server; modifications cannot be saved back to the user's computer directly.

The Browse button displays a file browser dialog, depending on the operating system running on the user's computer. Text files from the user computer can be loaded into the GUI application's editor. Once one local file has been loaded, the editor may be re-loaded with a different local file with the Update button that replaces the Browse button. After any optional editing, the editor content can be saved to either the current or backup file location on the GUI's server.

On any of the above file load operations, or for any subsequent save operations, the completion status for that operation is displayed below the editor field. Error messages provide details of any failure while reading or writing files.

If no configuration or policy file has already been created, a new one can be created by just entering the commands in a blank editor field and saving it with one or both of the save buttons on the bottom right of the dialog.

At the top of the editor is a tool bar to assist editing:

	
The blue arrows provide Undo and Redo functions.


	
Enter text in the Find field to locate the text in the content. The left and right arrows search backward and forward respectively.


	
The binocular icon provides more sophisticated searches and replacements, including matching case and whole words.


	
The Go to Line field highlights the entered line number when the right-arrow button is clicked. The blue highlight stays on the line until another line is selected. Enter a number larger than the last line number in the file to clear the highlight.




Be sure to save any edits using the Save to Current File or Save to Backup File buttons in the bottom right of the dialog. The Save to Current File button saves the content of the editor to the server file listed at the top of the dialog. The Save to Backup File button saves the content to the same location but with the extension .bak appended to the file name. Best practice is to save a backup copy of the current file before uploading it, since any subsequent Download operation by any user will overwrite the current upload file.

After all desired file operations are completed, click the Close button in the bottom right of the dialog. Ensure any file changes have been saved before clicking this button, as no checks are made that the latest modifications have been saved.






Upload File

Selecting the Upload button will prompt the user for verification that the selected configuration or policy file should be uploaded to the tapeplex, since doing so may overwrite any existing configuration or policy on the tapeplex. The verification dialog will summarize the file and tapeplex involved.

Upon acceptance of the warning, clicking the OK button in the verification dialog will attempt to upload the selected file. To see if the upload was successful, check the Database Update Log. See Database Update Log for details.

Since the upload file can be overwritten by any subsequent download operation by any user, this file should be considered a transient file that should be reviewed and edited and saved just before any upload operation. Best practice is to save a backup copy of the current upload file before uploading it, since a subsequent download operation will overwrite the current file.

To make a change to the configuration or policy file before uploading, the file may be viewed and modified using the built-in editor or a remote FTP or PuTTY session. See Edit File for details.

The name and path of each file for the selected tapeplex are listed in the appropriate panel box. Once any change has been made, it may be uploaded as described above. File names may not be changed. Only the file name listed on the panel will be uploaded to the tapeplex.

The file may be uploaded through either host through the server address selection, but only one configuration file and one policy file is available for the selected tapeplex.






Download File

Selecting the Download button on either file panel box will prompt the user for verification that the file should be downloaded, since doing so may overwrite any changes the user had made to an existing configuration or policy file on the VSM GUI server. The tapeplex and file name being downloaded is also displayed for confirmation of the action being applied.

Upon acceptance of the warning, clicking the OK button in the verification dialog will attempt to download the selected file. After the download process has been started, a pop-up message will display indicating that the user can view the Database Update Log and use the Refresh File Content button to confirm the completion of the download. Once the file has been downloaded, refreshing the Configuration/Policy page will update the File Last Downloaded date field to show the last date and time it was successfully downloaded. The downloaded file is available on the VM in the directory and file name shown in the appropriate panel box.

The request to download a file may be made to either host through the server address selection, but the file downloaded will be identical through either host server address. Only one configuration file and one policy file is available for the selected tapeplex.






Console Log






Console Log

Messages are displayed for a specific tapeplex. Select the tapeplex from the list and the Console Log will populate with messages from that tapeplex.

The log tables automatically update as new console messages are received. This update process can be turned off or on by clicking Turn Auto-update OFF/ON.

Three types of messages are displayed:

	
WTO (Write to Operator)


	
WTOR (WTO with Reply)


	
HILITE (highlighted WTO)




There are two tables on the Console Log page:

	
The WTORs and HILITEs table lists WTOR and HILITE messages. WTOR messages can be replied to from within this table.


	
The Log table lists WTO messages and replied to or deleted WTOR messages and deleted HILITE messages.




When a WTOR message in the WTOR and HILITEs table is replied to, the message is transferred to the Log table. If an exception occurs during the WTOR reply, it will be logged and the data will be accessible from the Log table.


WTORs and HILITEs Table

The list of WTOR and HILITE messages for the selected tapeplex are displayed in chronological order with the most recent at the bottom.

Fields with a context menu indicator can initiate commands on specific data items. Right click a field to display the context menu and select the command:

	
To reply to a WTOR message, right click the message text and select Reply. A dialog is displayed where you can enter and submit the reply text. When the reply has been successfully sent to oVTCS, the WTOR counter is updated and the table display is refreshed so the WTOR is no longer displayed in the WTORs and HILITEs table but is added to the Log table.


	
To delete a WTOR message, right click the message text and select Delete. To delete multiple messages, select the messages and then right click the message text and select Delete. For each deleted WTOR message, the WTOR counter is updated, and the table display is refreshed so the WTOR message is no longer displayed in the WTORs and HILITEs table but is added to the Log table.


	
To delete a HILITE message, right click the message text and select Delete. To delete multiple messages, select the messages and then right click the message text and select Delete. For each deleted HILITE message, the HILITE counter is updated, and the table display is refreshed so the HILITE message is no longer displayed in the WTORs and HILITEs table but is added to the Log table.




The WTOR and HILITE counts at the top of the page provide links to filter the WTORs and HILITEs table. Click the tapeplex name to show just the WTORs or HILITEs for that tapeplex.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Time	The date and time the message was issued
	Server Address	The HTTP server that issued the message
	ID	The unique internal identifier for the message
	Line Number	The message line number for ordering multi-line messages
	Token	The host-specific unique message token
	Type	The message type: WTOR, HILITE, or WTO
	Routing/Descriptor Category	The console routing and descriptor codes, where SYSSTAT is system status, SYSOPER is operator information, TPSTAT is tape status, and LOG is log only
	Multi-Line Type	The multi-line type for multi-line messages, where C is a Control line, D is a Data line, E is the Last (end) line, and L is a Label line
	Text	The message number and text






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard






Use the View menu to perform the following operations:


	View Option	Description
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns









Log Table

The WTO messages and replied to or deleted WTOR and HILITE messages are displayed chronologically, with the most recent at the bottom.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Time	The date and time the message was sent
	Server Address	The HTTP server that issued the message
	ID	The message ID
	Line Number	The console line number
	Token	The host-specific unique message token
	Type	The message type: WTOR, HILITE, or WTO
	Routing/Descriptor Category	One of the following:
SYSSTAT - system status

SYSOPER - operator information

TPSTAT - tape status

LOG - log only


	Multi-Line Type	The multi-line type for multi-line messages, where C is a Control line, D is a Data line, E is the Last (end) line, and L is a Label line
	Text	The message number and text
	Exception	The red Critical icon is displayed if an exception occurred. Clicking the icon displays the Row Detail for the selected row.
	Return Code	The return code from the WTOR reply: (0-Success, 4-Warning, 8-Error, 12-Fatal Error)
	Reason Code	The reason code from the WTOR reply
	Error Message	The error message from the WTOR reply
	WTOR Replied	The date-time the WTOR was replied to






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Pane Information icon]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard






Use the View menu to perform the following operations:


	View Option	Description
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns
















Administration Menu
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This menu provides access to the following:


	
Site Configuration



	
Application Logs



	
Database Update Log



	
User Activity Log









Site Configuration






Site Configuration




	
Note:

Ingest must be disabled before you add or change any value in the site configuration.







Site configuration defines and manages required site-specific information. Site configuration is performed during the initial installation process but can be run again at any time after installation to modify any of the configuration details.

Site configuration is performed using a multi-page wizard. The Site Configuration Wizard steps you through the configuration process.

Before you start, disable the Ingest service on your virtual machine.

Select Administration and Site Configuration on the navigation tree.

The Introduction page is displayed.

The Introduction page summarizes the site configuration tasks:

Configure Supported Tapeplexes:

	
Supply tapeplex names and severity level of log file messages for each tapeplex supported


	
Select whether data for all VTVs or just initialized VTVs is to be collected


	
For each tapeplex, provide connection details for each connected host


	
There must be at least one HTTP server defined for each tapeplex


	
The UI can only collect data and display data from the defined HTTP servers


	
Configured hosts must run a version of ELS supported by the UI




Configure Application Users:

	
Provide user names and optional Email addresses


	
Assign the roles for each user on each tapeplex


	
The Email address is optional


	
The user role defines the set of VSM GUI pages available




Configure Alert Levels:

	
Define alert levels to apply tapeplex-wide


	
Define the VTSSs in each tapeplex


	
Add the alert levels for each VTSS


	
All alert levels must be supplied




Edit Default Configuration Properties:

	
Several site configuration properties are editable to fine-tune host cycle times, batch record sizes, and session timeout times for your site.




Review Site Configuration Summary:

	
All configuration data is displayed and can be amended by returning to the appropriate page.




Click Next Page to display the Configure Supported Tapeplexes page and begin the site configuration process.



Configure Supported Tapeplexes

Configure Supported Tapeplexes has two elements:

	
Create/Edit Tapeplex defines and manages site configuration information about your supported tapeplexes


	
Create/Edit Host Data for Tapeplex defines and manages site configuration information about the host systems associated with the tapeplexes






Create/Edit Tapeplex

Create/Edit Tapeplex identifies and manages site configuration information about supported tapeplexes.

Data columns and descriptions include:


	Column	Description
	Tapeplex	The name of the supported tapeplex
	Logging Level	Defines the level at which logging entries will be created by the database refresh code. Enabling logging at a given level also enables logging at all higher levels.
Logging levels (in ascending order from lowest to highest) include:

ALL: All messages should be logged

FINEST: Highly detailed tracing messages should be logged

FINER: Fairly detailed tracing messages should be logged

FINE: Basic tracing messages should be logged

CONFIG: Static configuration messages should be logged

INFO: Informational messages should be logged

WARNING: Warning messages indicating a potential problem should be logged

SEVERE: Severe messages indicating a serious failure should be logged

OFF: No messages should be logged


	Initialized VTVs	Determines whether data for all VTVs or just initialized VTVs is to be collected






Click the icons to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes add.png.]
	Add	Add a new tapeplex to the configuration
	[image: Surrounding text describes edit.png.]
	Edit	Edit the selected tapeplex
	[image: Surrounding text describes delete.png.]
	Delete	Delete the selected tapeplex and associated host entries from the configuration







Add a New Tapeplex

Click the Add icon. A dialog is displayed.

Enter the name of the tapeplex.

Select the Logging Level and Initialized VTVs settings for this tapeplex.

Click OK to enter the data, or click Cancel to end the dialog. Your entries are recorded in the configuration when you click OK.

Repeat these steps to add another tapeplex.

When finished adding tapeplexes, go to Create/Edit Host Data for Tapeplex to define and manage information about the host systems associated with the tapeplexes.

When finished with Configure Supported Tapeplexes, click Next Page to display the next configuration page, or click Previous Page to go back one page.





Edit a Tapeplex

Select the tapeplex to edit.

Click the Edit icon. A dialog is displayed.

Change the settings you want to edit.

Click OK to enter the revised data, or click Cancel to end the dialog. Your changes are entered in the configuration when you click OK.

When finished with Configure Supported Tapeplexes, click Next Page to display the next configuration page, or click Previous Page to go back one page.





Delete a Tapeplex

Select the tapeplex to delete.

Click the Delete icon. A dialog is displayed.

Click OK to delete the tapeplex and all data associated with the tapeplex, or click Cancel to end the dialog. The tapeplex will be deleted when you click OK.

When finished with Configure Supported Tapeplexes, click Next Page to display the next configuration page, or click Previous Page to go back one page.








Create/Edit Host Data for Tapeplex

Create/Edit Host Data for Tapeplex defines and manages site configuration information about the host systems associated with a selected tapeplex.

Data columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex the host is associated with
	Server Address	The fully qualified domain name for the host
	Server Port	The port number for the SMC HTTP server that is expected to be running on the host. If this is not running, then the database refresh process will not collect data from this host.
	ELS Version	The ELS version on the host must be ELS 7.1 or higher. Data will not be collected from a host with an unsupported ELS version.
	SMC Subsystem	The SMC subsystem name on the host
	ELS Subsystem	The ELS subsystem name on the host






Click the icons to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes add.png.]
	Add	Add a new host entry to the selected tapeplex
	[image: Surrounding text describes edit.png.]
	Edit	Edit the selected host entry
	[image: Surrounding text describes delete.png.]
	Delete	Delete the selected host entry







Add a New Host

Select the tapeplex the host is associated with in the Create/Edit Tapeplex table.

Click the Add icon for the Create/Edit Host Data for Tapeplex table. A dialog is displayed.

Enter the host's HTTP server address, server port, ELS Version, SMC subsystem name and, optionally, ELS subsystem name. The SMC subsystem name is not required for ELS version 7.3.1 servers.

Click OK to enter the data, or click Cancel to end the dialog. Your entries are recorded in the configuration when you click OK.

Repeat these steps to add additional hosts to the tapeplex or to add hosts to a different tapeplex.

When finished with Configure Supported Tapeplexes, click Next Page to display the next configuration page, or click Previous Page to go back one page.





Edit a Host

Select the host to edit.

Click the Edit icon. A dialog is displayed.

Change the settings you want to edit.

Click OK to enter the revised data, or click Cancel to end the dialog. Your changes are entered in the configuration when you click OK.

When finished with Configure Supported Tapeplexes, click Next Page to display the next configuration page, or click Previous Page to go back one page





Delete a Host

Select the host to delete.

Click the Delete icon. A dialog is displayed.

Click OK to delete the host, or click Cancel to end the dialog. The host will be deleted when you click OK.

When finished with Configure Supported Tapeplexes, click Next Page to display the next configuration page, or click Previous Page to go back one page.










Configure Application Users

User Information identifies and manages information about the users who will access VSM GUI. Each user must be in your site's LDAP directory and must be assigned at least one user role on at least one tapeplex.

Create/Edit User Information identifies the users who are authorized for VSM GUI login.

Create/Edit User Roles for User manages user roles and tapeplex access for specific users.



Create/Edit User Information

Create/Edit User Information identifies the users who will be authorized for VSM GUI login.

Table columns and descriptions include:


	Column	Description
	Username	The name of a user that is allowed to run the application. The user name must be the name of a user defined on the site's LDAP directory services
	Email Address	The user's Email address (optional)
	VSM GUI Administrator	Indicates if the user is a VSM GUI administrator (user role VsmGuiAdmin)






Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes add.png.]
	Add	Add a user to the configuration
	[image: Surrounding text describes edit.png.]
	Edit	Edit the selected user
	[image: Surrounding text describes delete.png.]
	Delete	Delete the selected user and all assigned rolls for that user in the configuration







Create a User

Click the Add icon. A dialog is displayed.

Enter the username of the user.

Optionally, enter the user's Email address and check the VSM GUI Administrator box if applicable.

Click OK to enter the data, or click Cancel to end the dialog. Your entries are recorded in the configuration when you click OK.

Repeat these steps to add another user.

When finished, go to Create/Edit User Roles for User to define and manage user roles and tapeplex access for the user's you create.

When finished with User Information, click Next Page to display the next configuration page, or click Previous Page to go back one page.





Edit a User

Select the username to edit.

Click the Edit icon. A dialog is displayed.

Change the settings you want to edit.

Click OK to enter the revised data, or click Cancel to end the dialog. Your changes are entered in the configuration when you click OK.

When finished with User Information, click Next Page to display the next configuration page, or click Previous Page to go back one page





Delete a User

Select the username to delete.

Click the Delete icon. A dialog is displayed.

Click OK to delete the user, or click Cancel to end the dialog. The user will be deleted when you click OK.

When finished with User Information, click Next Page to display the next configuration page, or click Previous Page to go back one page.








Create/Edit User Roles for User

Create/Edit User Roles for User defines and manages user roles and tapeplex access for specific users. Each user must be assigned at least one user role on at least one tapeplex.

Table columns and descriptions include:


	Column	Description
	User Name	The name of the user to create or edit user roles for
	Tapeplex	The name of the tapeplex to which the user role field will apply
	User Role	The user's access role for this tapeplex:
	
VsmViewer: Accesses the Status and Display tabs, and the Administration - Database Update Log option, with no access to context menus, the Management and VSM Console tabs, and the other Administration options, on the specified tapeplex


	
VsmOperator: Accesses the Status, Display, Management, VSM Console, and Administration - Database Update Log option, with no access to other Administration options, on the specified tapeplex











Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes add.png.]
	Add	Add a new user role entry in the configuration
	[image: Surrounding text describes edit.png.]
	Edit	Edit the selected user role entry in the configuration
	[image: Surrounding text describes delete.png.]
	Delete	Delete the selected user role entry from the configuration







Create a User Role Entry

Select the username whose role entry you want to create.

Click the Add icon. A dialog is displayed.

Select the tapeplex the user role is for.

Select the user role.

Click OK to enter the data, or click Cancel to end the dialog. Your entries are recorded in the configuration when you click OK.

Repeat these steps to create another user role entry.

When finished with User Information, click Next Page to display the next configuration page, or click Previous Page to go back one page.





Edit a User Role Entry

Select the username whose role entry you want to edit.

Click the Edit icon. A dialog is displayed.

Change the settings you want to edit.

Click OK to enter the revised data, or click Cancel to end the dialog. Your changes are entered in the configuration when you click OK.

When finished with User Information, click Next Page to display the next configuration page, or click Previous Page to go back one page.





Delete a User Role Entry

Select the username whose role entry you want to delete.

Click the Delete icon. A dialog is displayed.

Click OK to delete the selected user role entry, or click Cancel to end the dialog. The user role entry will be deleted when you click OK.

When finished with User Information, click Next Page to display the next configuration page, or click Previous Page to go back one page.










Configure Alert Levels

Create/Edit Tapeplex Alert Levels defines the critical alert level threshold for the number of offline VTSSs in a tapeplex that will raise a critical alert.

Create/Edit Alert Levels for VTSS defines and manages alert level thresholds for VTSSs within a tapeplex.

When finished with Configure Alert Levels, click Next Page to display the next configuration page, or click Previous Page to go back one page.



Create/Edit Tapeplex Alert Levels

Create/Edit Tapeplex Alert Levels defines the critical alert level for the number of offline VTSSs in a tapeplex that will raise a critical alert.

Data columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex to define or edit alert values for
	VTSS Critical Level	The number of offline VTSSs within the tapeplex that will raise a critical alert






Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes add.png.]
	Add	Add a new tapeplex alert in the configuration
	[image: Surrounding text describes edit.png.]
	Edit	Edit the selected alert for the tapeplex and associated VTSS alerts in the configuration
	[image: Surrounding text describes delete.png.]
	Delete	Delete the selected alert for the tapeplex and associated VTSS alerts in the configuration







Add a New Tapeplex VTSS Critical Level Alert

Click the Add New Alert icon. A dialog is displayed.

Select the tapeplex the VTSS Critical Level alert is associated with.

Enter the VTSS Critical Level for the selected tapeplex.

Click OK to enter the data, or click Cancel to end the dialog. Your entries are entered in the configuration when you click OK.





Edit VTSS Critical Level Alert for a Tapeplex

Select the tapeplex where you want to edit the VTSS Critical Level alert.

Click the Edit Alert icon. A dialog is displayed.

Change the setting for the VTSS Critical Level alert.

Click OK to enter the revised data, or click Cancel to end the dialog. Your entries are entered in the configuration when you click OK.





Cancel an Alert for a Tapeplex

Select the tapeplex where the Critical Alert Level alarm will be deleted.

Click the Delete icon. A dialog is displayed.

Click OK to delete the alert, or click Cancel to end the dialog. Your entries are entered in the configuration when you click OK.








Create/Edit Alert Levels for VTSS

Create/Edit Alert Levels for VTSS defines and manages alert level thresholds for VTSSs within a tapeplex.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The name of the tapeplex to add or edit alerts for
	VTSS	The name of the VTSS in the tapeplex to add or edit alerts for
	Critical DBU Level (%)	The disk buffer usage (as a percentage) at which a critical alert is raised for the specified VTSS
	RTD Warning Level	The number of offline RTDs attached to a VTSS that will raise a warning alert
	RTD Critical Level	The number of offline RTDs attached to a VTSS that will raise a critical alert
	VRTD Warning Level	The number of offline vRTDs attached to a VTSS that will raise a warning alert
	VRTD Critical Level	The number of offline vRTDs attached to a VTSS that will raise a critical alert
	FICON CLINK Warning Level	The number of offline FICON CLINKS that will raise a warning alert
	FICON CLINK Critical Level	The number of offline FICON CLINKS that will raise a critical alert
	IP CLINK Warning Level	The number of offline IP CLINKS that will raise a warning alert
	IP CLINK Critical Level	The number of offline IP CLINKS that will raise a critical alert
	Queued Migrates Warning Level	The number of queued migrates that will raise a warning alert
	Queued Migrates Critical Level	The number of queued migrates that will raise a critical alert
	Queued Replications Warning Level	The number of queued replications that will raise a warning alert
	Queued Replications Critical Level	The number of queued replications that will raise a critical alert






Click the icons above the graph to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes add.png.]
	Add	Create alert levels for a VTSS in the configuration
	[image: Surrounding text describes edit.png.]
	Edit	Edit the selected alert for the configuration
	[image: Surrounding text describes delete.png.]
	Delete	Delete the selected alert from the configuration







Add New VTSS Alerts for a Tapeplex

Select the tapeplex where you want to add VTSS alerts.

Click the Add icon. A dialog is displayed.

Enter the VTSS name and then enter alert levels in each field.

Click OK to enter the data, or click Cancel to end the dialog. Your entries are entered in the configuration when you click OK

Repeat these steps to add additional VTSS alert levels.

When finished with Configure Alert Levels, click Next Page to display the next configuration page, or click Previous Page to go back one page.





Edit a VTSS Alert

Select the VTSS in the tapeplex where you want to edit the VTSS alerts.

Click the Edit icon. A dialog is displayed.

Change the settings you want to edit.

Click OK to enter the revised data, or click Cancel to end the dialog. Your entries are entered in the configuration when you click OK.





Cancel a VTSS Alert

Select the tapeplex and VTSS for which where the VTSS alerts will be deleted.

Click the Delete icon. A dialog is displayed.

Click OK to delete the alert, or click Cancel to end the dialog. Your entries are entered in the configuration when you click OK.










Edit Default Configuration Properties

Several site configuration properties are editable to fine-tune host cycle times, batch record sizes, and session timeout times for your site.

Table columns and descriptions include:


	Column	Description
	Primary Cycle Time (minutes)	Primary cycle times are for the data ingest process. The primary ingest gets updates from VTCS on VTV and MVC data, which causes VTCS to scan the CDS and requires host resources. To avoid impacting other production activity, this process should be done less frequently. The recommended frequency is 60 minutes, which is the default.
	Secondary Cycle Time (minutes)	Secondary cycle times are for the data ingest process. Secondary ingest gets data for all tables not updated by primary ingest. This is less work for VTCS, so the secondary cycle can be run more frequently with little impact on other production activity. The recommended value is 10 minutes, which is the default.
	Batch Size (records)	The number of records added to a database table in a single action during an ingest process. A larger number will result in a faster data load, but any error in a batch results in any remaining rows not being updated. The recommended value is 1000, which is the default.
	Session Timeout (Minutes)	The number of minutes of user inactivity before the VSM GUI application returns to the Login screen






Click the icon above the graph to perform the following operation:


	Icon	Name	Description
	[image: Surrounding text describes edit.png.]
	Edit	Edit configuration properties







Edit Configuration Properties

Click the Edit icon above the graph. A dialog is displayed:

Change the settings you want to edit.

Click OK to enter the revised data, or click Cancel to end the dialog. Your entries are entered in the configuration when you click OK.

When Configure Properties is complete, click Next Page to display the Summary page, or click Previous Page to go back one page in the Site Configuration wizard.








Review Site Configuration Summary

The Summary page lists your current site configuration settings.

Review the settings to ensure they are complete and accurate.

To make changes, use Previous Page to go back to the page where you want to make changes.

When you are finished, click Done to close the Site Configuration Wizard. A dialog is displayed:

Click OK to exit the Site Configuration Wizard.

Any changes made are now committed to the database.

Enable the Ingest service on your virtual machine to activate these changes.






Application Logs






Application Logs

VSM GUI application logs may be downloaded to your PC from the VSM GUI virtual machine.

Select Administration and Application Logs on the navigation tree.

Click Download Logs.

This opens a script that creates a log file and downloads it to the logs/archive directory on the VSM GUI virtual machine. A confirmation message is displayed when the file download has started.

To retrieve the downloaded file, first log in to the VSM GUI virtual machine (user vsmgui, password vsm6admin) and then go to the logs/archive directory and list its contents:

$ cd /opt/vsmgui/logs/archive

$ ls -lt

The first file listed is the most recently created application logs file. The file name format is VSMGUI_LOGS-mmddyy_hhmmss.tar.gz, where mmddyy_hhmmss is the date and time the file was created. For example: VSMGUI_LOGS-101716_092659.tar.gz.

Next, from a PC, use a file transfer tool such as WinSCP to pull the application logs file from the virtual machine to the PC, using the same login credentials, which can then be attached to a Service Request.

When the file is transferred to the PC, use your usual applications on the PC for extracting the contents of the zip file and viewing the downloaded application logs.




Database Update Log






Database Update Log

The Database Update Log details the state and status of processes that are run to update the VSM GUI database and displays any error messages that were generated for each process.

Select Administration and Database Update Logs on the navigation tree.


Database Update Log Data Table

This data table shows VSM GUI database update process status.

If errors have occurred, the Status field will contain a status indicator.

If a status indicator is displayed, select that row to display error information about that database update process in the Errors for Database Update data table.


	Icon	Name	Description
	[image: Surrounding text describes caution.jpg.]
	Warning	Indicates an error may have occurred
	[image: Surrounding text describes critical.jpg.]
	Critical	Indicates a critical error has occurred
	[image: Surrounding text describes unknown.jpg.]
	Unknown	Indicates status could not be detected






Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Tapeplex	The tapeplex the database update process was run on
	Type	The database update type
	Manifest ID	The manifest ID of the database update process
	Start Time	The date and time the database update process started
	End Time	The date and time the database update process ended
	State	The state of the database update process
	Status	The status indicator for the database update process
	Re-Run	Enables the corresponding Command Refresh update to be re-launched. This is not available for PRIMARY, SECONDARY, CFGDWNLD, CFGUPLD, POLICYDWNLD, POLICYUPLD, MSGINGEST and MSGRESPONSE manifests as these updates are run automatically.






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










Errors for Database Update

This data table shows the error number and error message for the selected database update process with errors.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	Thread	The database update thread that encountered the error
	Error Number	The error number with the selected database update process
	Error Message	The error message with the selected database update process






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns






Use the Page Size menu to specify the number of rows to include on a data table page.

If there are multiple pages, use the Page feature at the bottom of the table to navigate among them. Enter or select a page number or use the arrow buttons to move forward or backward in the list of pages.

Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Detach Pane icon]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help
	[image: Surrounding text describes closetabs.png.]
	Close All Tabs	Close all tabs and display just the Dashboard










User Activity Log






User Activity Log

The User Activity Log tracks user actions that may impact the operation of the oVTCS system, including GUI Login/Logout activity and Configuration/Policy file management activity. This is beneficial for administrators trying to track user activity from a single location.

Select Administration and User Activity Logs on the navigation tree.

Click the arrows in any column header to sort the data table by that column in ascending or descending order.

You can also filter data for individual data columns to further isolate specific information. See Using Filters for details.

Table columns and descriptions include:


	Column	Description
	User Name	User login name used to log in to the application
	Activity Time	Time the activity was started by the user
	Event Type	One of the following types:
Login - User has successfully completed the initial login to the GUI application.

Logout - User has clicked the Logout link in the upper right of the application.

Timeout - (Optional) If implemented, user has lost access to the application due to inactivity (may not be implemented if not detectable by the application).

Edit - User has clicked the Save to Current File button on the Edit File dialog of the Configuration and Policy File Management panel.

Upload - User has fully initiated the Upload operation on the Configuration and Policy File Management panel (accepted the verification dialog for Upload).

Download - User has fully initiated the Download operation on the Configuration and Policy File Management panel (accepted the verification dialog for Download).


	Tapeplex	Name of the tapeplex upon which a Configuration and Policy File Management operation was performed, left blank for Login, Logout, or Timeout
	File Type	Either Configuration or Policy, depending on the type of Configuration and Policy File Management operation performed, left blank for Login, Logout, or Timeout.
	File Name	Name of the file for which the Configuration and Policy File Management operation was performed, left blank for Login, Logout, or Timeout






Click the icons above the table to perform the following operations:


	Icon	Name	Description
	[image: Surrounding text describes selectedrowdata.jpg.]
	Selected Row Data	Show data for selected rows
	[image: Surrounding text describes toexcel.jpg.]
	Export to Excel	Export all rows to an Excel spreadsheet
	[image: Surrounding text describes printena.png.]
	Print	Display as a printable page
	[image: Surrounding text describes filter.png.]
	Filter	Filter the data
	[image: Surrounding text describes filterx.png.]
	Remove filter	Remove the data filter
	[image: Surrounding text describes refreshdatabase.png.]
	Refresh	Refresh with data from the VSM GUI database
	[image: Surrounding text describes detach.jpg.]
	Detach	Display in a separate window
	[image: Surrounding text describes help.jpg.]
	Help	Display VSM GUI Help






Rows Selected indicates the number of rows in the table that are currently selected.

Columns Hidden indicates the number of columns in the table that are not being displayed. These are displayed using the View menu.

Columns Frozen is the number of left-hand columns that remain static when the horizontal scroll bar is moved. A blue vertical line separates these columns from the others.

Use the View menu to perform the following operations:


	View Option	Description
	Scroll Table	Enable or disable scrolling
	Columns	Show all or selected columns and manage hidden and visible status
	Detach	Display the table in a separate window
	Sort	Sort the column in ascending or descending order
	Reorder Columns	Select the column sequence for Visible columns














Database Backup and Management
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Aged data must be periodically removed from VSM GUI database tables as flat files to free up space. The results should be compressed and moved to a location from which they can be archived.





The Backup Process






The Backup Process

A cron job runs daily at a fixed interval (1:00 a.m. by default). The script generates a series of files containing the data for the time period since the previous interval and then removes that data from the database. The generated data files are then collected into a compressed tar file that is placed into the backup directory (/data/export).

A field in the VSM GUI Site Configuration allows changes to the interval setting.

The data files are laid out in a fashion similar to the data as it is presented within the VSM GUI application. They are created in a tab-delimited format that can easily be read into Excel or any other spreadsheet-type client application.

In each of the above file names, the timestamp portion follows the same pattern, specifying the system time when the process started. For example, the date November 27, 2016 at 2:46:17 pm would become 2106-11-27.14.46.17 in the final file name. The name of the compressed tar file also includes a timestamp, so based on the above date, the file would be named 2106-11-27.14.46.17-dbBackup.tar.gz.

The generated files containing the off-loaded data are as follows:

AUDIT SUMMARY: YYYY-DD-MM.HH24.MI.SS-AUDIT-SUMMARY_VIEW.dat

Data Fields: Command ID, Process ID, Audit Type, Tapeplex, VTSS Name or MVC Volser, Reason, and Number of VTVs Audited.

CLI LOG: YYYY-DD-MM.HH24.MI.SS-CLI-LOG_VIEW.dat

Data Fields: Command ID, Submitted, Username, Tapeplex, Host, Command Type, Command, Status, Competed, Exception, Return Code, and Reason Code.

COMMAND LOG: YYYY-DD-MM.HH24.MI.SS-COMMAND-LOG_VIEW.dat

Data Fields: Command ID, Submitted, Username, Tapeplex, Host, Command Type, Command, Status, Completed, Exception, Return Code, and Reason Code.

CONSOLE ACTIONS: YYYY-DD-MM.HH24.MI.SS-CONSOLE-ACTION_VIEW.dat

Data Fields: ID, Tapeplex, Server Address, Token, Type, Routing/Descriptor Category, Line Number, Multi-line Type, Text, State, and Time.

CONSOLE LOG: YYYY-DD-MM.HH24.MI.SS-CONSOLE-LOG_VIEW.dat

Data Fields: ID, Tapeplex, Server Address, Token, Type, Routing/Descriptor Category, Line Number, Multi-line Type, Text, State, and Time.

MESSAGE RESPONSES: YYYY-DD-MM.HH24.MI.SS-MESSAGE-RESPONSE_VIEW.dat

Data Fields: Tapeplex, Server Address, Token, Return Code, Reason Code, and Error Message.

MVC DRAIN RECALL/MIGRATE SUMMARY: YYYY-DD-MM.HH24.MI.SS-MVC-DRAIN-SUMMARY_VIEW.dat

Data Fields: Command ID, Tapeplex, MVC Volser, Reason, and VTVs Recalled/Migrated.

MVC DRAIN RECALL/MIGRATE INFORMATION: YYYY-DD-MM.HH24.MI.SS-MVC-DRAIN_VIEW.dat

Data Fields: Command ID, Tapeplex, VTV Volser, Recalled From MVC Volser, Recalled From Block ID, Recalled From VTSS, Migrated To MVC Volser, Migrated To Block ID. and Migrated To VTSS.

RECLAIM RECALL/MIGRATE SUMMARY: YYYY-DD-MM.HH24.MI.SS-RECLAIM-SUMMARY_VIEW.dat

Data Fields: Command ID, Tapeplex, MVC Volser, Reason, and VTVs Recalled/Migrated.

RECALL RECALL/MIGRATE INFORMATION: YYYY-DD-MM.HH24.MI.SS-RECLAIM_VIEW.dat

Data Fields: Command ID, Tapeplex, VTV Volser, Recalled From MVC Volser, Recalled From Block ID, Recalled From VTSS, Migrated To MVC Volser, Migrated To Block ID, and Migrated To VTSS.

COMMAND LOG: YYYY-DD-MM.HH24.MI.SS-COMMAND-LOG_VIEW.dat

Data Fields: Command ID, Tapeplex, MVC Volser, Reason, and VTVs Recalled/Migrated.

RECONCILE RECALL/MIGRATE INFORMATION: YYYY-DD-MM.HH24.MI.SS-RECONCILE_VIEW.dat

Data Fields: Command ID, Tapeplex, VTV Volser, Recalled From MVC Volser, Recalled From Block ID, Recalled From VTSS, Migrated To MVC Volser, Migrated To Block ID, and Migrated To VTSS.

RECONCILE VTV REASONS: YYYY-DD-MM.HH24.MI.SS-RECONCILE-VTV_VIEW.dat

Data Fields: Command ID, Tapeplex, VTV Volser, Uncompressed Size (MB), Compressed Size (MB), Compression Percentage, Created, Management Class, and Reason.

USER ACTIVITY LOG: YYYY-DD-MM.HH24.MI.SS-USER-ACTIVITY-LOG_VIEW.dat

Data Fields: Username, Event Type, File Type, Tapeplex, File Name, and Time.




	
Note:

There may be other files generated that have a lower-case name (for example, YYYY-MM-DD-hh.mm.ss-command_log.dat) and zero length. These files should be ignored.










Using the Off-loaded Data






Using the Off-loaded Data

Should you need to use the above information, copy the tar image to a Windows PC using scp and then extract the data files from the tar image based on the above file names. The individual files can then be read in to an Excel Spreadsheet for viewing. The process is the same whether the file still exists on the VSM GUI server or has been moved to off-line storage.




Maintenance






Maintenance

Backup files that are not retrieved within 30 days are removed by the system automatically. Best practice is to retrieve the backup files before this occurs and move them to a backup location where they can be maintained.

It is important that the data be moved as opposed to copied when it is placed into backup storage. In other words, it is necessary to both copy the files to the new location and then to delete them from the VSM GUI server.










Using Filters
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Filters may be applied to VSM GUI data tables to further isolate specific types of information.

The Filter and Remove Filter icons on the toolbar above the data table control filtering.








	Icon
	Name
	Description





	[image: Surrounding text describes filter.png.]

	Filter
	Filter the data



	[image: Surrounding text describes filterx.png.]

	Remove filter
	Remove the data filter












Filtering the Data






Filtering the Data

When you click the Filter icon on the toolbar above the table, a Filter Table dialog is displayed.

Click Match All if you want display candidates to be included only if they match all of the filtering criteria.

Click Match Any if you want display candidates to be included if they match any of the filtering criteria.

Enter your filtering criteria in one or more of the displayed data fields.

Click Apply to update the data table with the selected filters.

Click OK to close the dialog.

Other options:

Click Reset to set the filters back to their original values.

Click Save to save the filter settings.

Retrieve and apply a saved search from the list of saved searches.

Click Advanced to toggle to advanced search mode.




Removing the Filter






Removing the Filter

Click the Remove Filter icon on the toolbar above the table to remove the filter from the displayed table.




Advanced Filtering






Advanced Filtering

For more complex filtering, click the Advanced button on the Filter Table dialog.

As before, click Match All to include only candidates that match all of the filtering criteria, or click Match Any to include candidates that match any of the filtering criteria. Then add search operators and new search fields as desired.


Adding Search Operators

Select one of the following operators for each data column you want to filter:

	
Starts with: Includes only items starting with the entry


	
Ends with: Includes only items ending with the entry


	
Equals: Includes only items that are identical to the entry


	
Does not equal: Includes only items that are not exactly identical to the entry


	
Less than: Includes only items that are less than the entry


	
Less than or equal to: Includes only items that are less than or equal to the entry


	
Greater than: Includes only items that are greater than the entry


	
Greater than or equal to: Includes only items that are greater than or equal to the entry


	
Between: Includes only items that are between the entries


	
Not between: Includes only items that are not between the entries


	
Contains: Includes only items containing the entry


	
Does not contain: Includes only items that do not contain the entry


	
Is blank: Includes only items that are blank


	
Is not blank: Includes only items that are not blank




Enter filtering criteria in the data fields.

Click Apply to update the data table with the selected operators and filtering criteria.

Click OK to close the dialog.

Other options:

Click Reset to set the filters back to their original values.

Click Save to save the filter settings.

Click Add Fields to add search fields.

Click Reorder to re-prioritize search fields.

Retrieve and apply a saved search from the list of saved searches.

Click Basic to toggle to basic search mode.





Adding Search Fields

Click Add Fields to add search fields.

Select from the list of fields that are currently in the data table but not in the Filter Table dialog.

Enter filtering criteria in the new data fields.

Click Apply to update the data table with the new data fields.

Click OK to close the dialog.

Other options:

Click Reset to set the filters back to their original values.

Click Save to save the filter settings.

Click Reorder to re-prioritize search fields.

Retrieve and apply a saved search from the list of saved searches.

Click Basic to toggle to basic search mode.






Saving Search Parameters






Saving Search Parameters

Search parameter settings can be saved and reused. After you define the filter and click Apply, click Save. A dialog is displayed.

Enter a name for the saved search. Check if you want it to be the default for the table and if you want it to run automatically whenever the table is displayed. Click OK to save the search and close the dialog.




Retrieving Saved Searches






Retrieving Saved Searches

To retrieve a saved search, display the table and then click the Filter icon on the toolbar above the table. A dialog is displayed.

Select the appropriate saved filter from the Saved Search list.

Click Apply to update the data table with the saved search.

Click Reset to set the filters back to their original values.

Click OK to close the dialog.




Personalizing Saved Searches






Personalizing Saved Searches

To personalize a saved search, select the saved search and then select Personalize on the Saved Search list. A dialog is displayed.

The following options are available:

Click Delete to delete the selected saved search from the list.

Click Duplicate to create a copy of the selected saved search. The copy will appear on the list of saved searches.

Rename the saved search by typing a new name in the Name field if desired.

Check if you want the saved search to be the default filter for the table, if you want it to run automatically whenever the filter icon is clicked, and if you want the saved search to be displayed in the search list.

Click Apply to save the personalized settings for the saved search.

Click OK to close the dialog.










LDAP Configuration for Weblogic
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This appendix describes LDAP and Weblogic server configuration procedures for VSM GUI.





LDAP Security Fundamentals






LDAP Security Fundamentals

There are three components for LDAP security:

	
LDAP security objects


	
The LDAP Tree Structure


	
The Distinguished Name





LDAP Security Objects

The LDAP objects used for authentication are as follows:

	
Organizational Unit (OU): objectClass organizationalUnit (OU)

An Organizational Unit object is similar to a Window directory. For LDAP, it typically holds either Group objects or User objects.


	
Group (CN): objectClass group (CN) [also posixGroup]

In the same way an Organizational Unit is similar to a directory, a Group object is similar to a file. The Group object contains a member attribute that is a list of Distinguished Names that define the users in that group.


	
User (CN): objectClass user (CN) [also organizationalPerson]

Also similar to a file, the User object describes a single person within the LDAP structure. Unlike a Group, a User does not contain a list. Instead, its attributes describe a user in as much detail as necessary.








LDAP Tree Structure

The structure of LDAP entries match the familiar tree structure for directories and files found in both UNIX and Windows. When you configure the Base Group and Principal during Weblogic server configuration, it will be critical that you use the tree structure to build the object's Distinguished Name.





LDAP Distinguished Name

The Distinguished Name is a value associated with each LDAP object to distinguish it from all of the other objects. This value is based on the tree structure described above. To build a Distinguished Name you basically work your way from the object you are naming to the top of the tree, so the Distinguished Name for user John Doe might be:

CN=johndoe,OU=Users,OU=VSMGUI,DC=yourfirm,DC=com

The object type is normally upper-case in the DN, but lower-case is also valid. For the name of the object, the case needs to exactly match the case of the actual name. In addition, there should be no spaces between the commas and the object types. The only spaces that should exist in a DN are those that exist in the name of the object; therefore the DN for the VSM Admins might be:

CN=VSM Admins,OU-Groups,OU=VSMGUI,DC=yourfirm,DC=com

There is a restriction in Weblogic concerning valid DNs. Certain characters that can potentially be added to a DN are not allowed by the Weblogic server. These characters are Comma (,), Plus Sign (+), Quotes (”), Backslash (\), Angle Brackets (< and >), and Semicolon (;).

Of these, the most common is the comma, especially if the user name is of the form Smith, John. This usually happens in Active Directory, although any DN can have one of these characters. This is important because one of the users is always set up as the Principal, the user that allows access to the LDAP Server. If your DNs contain any of these characters, then the Principal must be added as a special user with a different corresponding DN.

Notes:

	
Based on the customer environment, it is likely that the default configuration described above will not fit into the LDAP layout scheme defined for different organizations. For example, group information may be in a completely separate sub-tree, so that Groups may exist in a directory where groups are defined and may be named VSMGUI Groups. The Users might be in a completely separate sub-tree and be named VSMGUI Users. The Organizational Unit VSMGUI may not need to be defined at all. These changes in location will create a different DN for the fields in the Weblogic Configuration, and will have to be set accordingly.


	
There are two separate ways to set up the users. Typically you will want to add the names of users that already exist to a new Organizational Unit, and make that the User Base Directory. If you prefer, you can also set the User Base Directory to any container-type LDAP object, making all users that are members of that group available to use VSM GUI.


	
Setting up the values in the LDAP server will typically require a person that has security access to the LDAP server. If you are setting up a new server, you should be able to access the LDAP server as an administrator.


	
Pay particular attention to the DN values (Principal, User Base DN, and Group Base DN), and ensure that the Name Filter values correctly define the Attribute and Object Class values. Everything must align perfectly with the Active Directory values in order for authentication to properly work.
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LDAP Server Configuration

	
If you create a container in which to add names, it should be an Organizational Unit such as OU=Users,DC=yourfirm,DC=com. This can be placed at any level in the LDAP directory if all DNs described below are changed appropriately.


	
If the DNs currently being used have any of the previously described special character restrictions, then create a new Posix User: CN=VSM Administrator,... This user will be the login user for Weblogic and allows Weblogic to access the LDAP server.


	
Create a password for the VSM Administrator, if applicable. Make a note of this password, as it is required for the Weblogic configuration.


	
For any users that will use the VSM GUI application but do not currently exist in the LDAP, add them to the Users' Organizational Unit. To add users to this OU, perform the following:

	
Create the actual member: (CN=johndoe,OU=Users,...) with default attributes.


	
Create a password for that user.


	
If using the Users object described above, then add the user to the member attribute of the Users object (OU=Users,...). Otherwise, ensure that the user is part of whatever group is defined as the User Base.





	
5. Save the configuration. This will vary from client to client, and may not be required at all. Consult the documentation for your LDAP client for details
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Weblogic for OpenLDAP

	
Open the Weblogic Console at http://<VSMGUI IP>:7001/console/ and log in:

There are two platforms with unique credentials for the Weblogic Console login:

	
For the Linux x86-64 server platform, log in as user weblogic using the password weblogic1 (the number one, not a lower-case L).


	
For the LDOM on VSMc (Solaris) server platform, log in as user admin using the password vsm6SQLadm.





	
Click the Lock & Edit button in the upper left Change Center window.


	
From the Domain Structure window, select Security Realms.


	
From the Summary of Security Realms window, select myrealm.


	
In the Settings for myrealm window, click the Providers tab and ensure that the Authentication tab is selected.


	
Click the New button, which will open the Create a New Authentication Provider window. For the Name field, enter LDAP Server. In the Type field, select OpenLDAPAuthenticator. Click OK. You will be returned to the Settings for myrealm window, with LDAP Server at the bottom of the list.


	
Click the Reorder button. The available Authentication Providers will be listed. Click the LDAP Server check box, and use the controls to the right to move it to the top of the list. Click OK to the Settings for myrealm window. The LDAP Server Provider should now be at the top of the list.


	
Click LDAP Server. You will be taken to the Settings for LDAP Server window. Under the Common tab, change the Control Flag value to SUFFICIENT. Click Save.


	
Click the Provider Specific tab. You will be presented with a screen that has several fields to edit. For each field, enter the values as described in Table 1.


	
When the above entries have all been set, click the Save button. This will return to the Settings for LDAP Server page with notifications at the top stating that a process or processes need to be restarted.


	
Click the Activate Changes button in the upper left Change Center window.


	
Log out of the Console. Then stop and restart the Weblogic service.


	
Once the service is up, go back into the Console. Select Security Realms, then myrealm, as was done before. Click the Users and Groups tab. If the configuration worked properly, you should now see a list of all the users you added to the VSM Users group when you configured the OpenLDAP Service. This completes the OpenLDAP and Weblogic configuration.





Table B-1 Configuration Values for OpenLDAP Provider Specific Information

	Value	Description
	
Host

	
Either the DNS name or IP address of the Active Directory Server


	
Port

	
The port number on that server allocated to the AD Service, usually 389


	
Principal

	
This is the full DN for the user that will connect to the server It is usually easiest to go to the LDAP Configuration Client you are using, find the DN attribute for the administrator user and cut/paste this field into the Weblogic Console.


	
Credential

	
The password you assigned to the VSM Administrator user from above


	
Confirm Credential

	
Same as the Credential field above


	
SSLEnabled

	
Unchecked


	
User Base DN

	
Either the new directory DN, or an existing group if you prefer


	
All Users Filter

	
Blank


	
User From Name Filter

	
(&(cn=%u)(objectclass=user))


	
User Search Scope

	
subtree


	
User Name Attribute

	
cn


	
User Object Class

	
user


	
Use Retrieved User Name as Principal

	
Unchecked


	
Group Base DN

	
The DN of the object that contains groups; normally it matches the value in the User Base DN field.


	
All Groups Filter

	
Blank


	
Group from Name Filter

	
(&(cn=%g)(objectclass=groupOfNames))


	
Group Search Scope

	
subtree


	
Group Membership Searching

	
unlimited


	
Max Group Membership Search Level

	
0


	
Ignore Duplicate Membership

	
Unchecked


	
Use Token Groups For Group Membership Lookup

	
Unchecked


	
Static Group Name Attribute

	
cn


	
Static Group Object Class

	
groupOfNames


	
Static Member DN Attribute

	
member


	
Static Group DNs from Member DN Filter

	
(&(member=%M)(objectclass=groupOfNames))


	
Dynamic Groups Subgroup

	
All of the fields in this section should be left blank.


	
Connection Pool Size

	
6


	
Connect Timeout

	
0


	
Connection Retry Limit

	
1


	
Parallel Connect Delay

	
0


	
Results Time Limit

	
0


	
Keep Alive Enabled

	
Unchecked


	
Follow Referrals

	
Checked


	
Bind Anonymously on Referrals

	
Unchecked


	
Propagate Cause for Login Exception

	
Unchecked


	
Cache Enabled

	
Checked


	
Cache Size

	
32


	
Cache TTL

	
60


	
GUID Attribute

	
entryUUID
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Weblogic for Active Directory

	
Open the Weblogic Console at http://<VSMGUI IP>:7001/console/ and log in.

There are two platforms with unique credentials for the Weblogic Console login:

	
For the Linux x86-64 server platform, log in as user weblogic using the password weblogic1.


	
For the LDOM on VSMc (Solaris) server platform, log in as user admin using the password vsm6SQLadm.





	
Click the Lock & Edit button in the upper left Change Center window.


	
From the Domain Structure window, select Security Realms.


	
From the Summary of Security Realms window, select myrealm.


	
In the Settings for myrealm window, click the Providers tab and ensure that the Authentication tab is selected.


	
Click the New button, which will open the Create a New Authentication Provider window. For the Name field, enter LDAP Server. In the Type field, select ActiveDirectoryAuthenticator. Click OK. You will be returned to the Settings for myrealm window, with LDAP Server at the bottom of the list.


	
Click the Reorder button. The available Authentication Providers will be listed. Click the LDAP Server check box, and use the controls to the right to move it to the top of the list. Click OK to be returned to the Settings for myrealm window. The LDAP Server Provider should now be at the top of the list.


	
Click LDAP Server. You will be taken to the Settings for LDAP Server window. Under the Common tab, change the Control Flag value to SUFFICIENT. Click Save.


	
Click the Provider Specific tab. You will be presented with a screen that has several fields to edit. For each field, enter the values as described in Table 2:


	
Once the above entries have all be set, click the Save button. This will return to the Settings for LDAP Server page with notifications at the top stating that a process or processes need to be restarted.


	
Click the Activate Changes button in the upper left Change Center window.


	
Log out of the Console. Then stop and restart the Weblogic service.


	
Once the service is up, go back into the Console. Select Security Realms, then myrealm, as was done before. Click the Users and Groups tab. If the configuration worked properly, you should now see a list of all the users you added to the VSM Users group when you configured the Active Directory Service. This completes the Active Service and Weblogic configuration.





Table B-2 Configuration Values for Active Directory Provider Specific Information

	Value	Description
	
Host

	
Either the DNS name or IP address of the Active Directory Server


	
Port

	
The port number on that server allocated to the AD Service, usually 389


	
Principal

	
This is the full DN for the user that will connect to the server It is usually easiest to go to the LDAP Configuration Client you are using, find the DN attribute for the administrator user and cut/paste this field into the Weblogic Console.


	
Credential

	
The password you assigned to the VSM Administrator user from above


	
Confirm Credential

	
Same as the Credential field above


	
SSLEnabled

	
Unchecked


	
User Base DN

	
Either the new directory DN, or an existing group if you prefer


	
All Users Filter

	
Blank


	
User From Name Filter

	
(&(cn=%u)(objectclass=user))


	
User Search Scope

	
subtree


	
User Name Attribute

	
cn


	
User Object Class

	
user


	
Use Retrieved User Name as Principal

	
Unchecked


	
Group Base DN

	
The DN of the object that contains groups; normally it matches the value in the User Base DN field.


	
All Groups Filter

	
Blank


	
Group from Name Filter

	
(&(cn=%g)(objectclass=group))


	
Group Search Scope

	
subtree


	
Group Membership Searching

	
unlimited


	
Max Group Membership Search Level

	
0


	
Ignore Duplicate Membership

	
Unchecked


	
Use Token Groups For Group Membership Lookup

	
Unchecked


	
Static Group Name Attribute

	
cn


	
Static Group Object Class

	
group


	
Static Member DN Attribute

	
member


	
Static Group DNs from Member DN Filter

	
(&(member=%M)(objectclass=group))


	
Dynamic Groups Subgroup

	
All of the fields in this section should be left blank.


	
Connection Pool Size

	
6


	
Connect Timeout

	
0


	
Connection Retry Limit

	
1


	
Parallel Connect Delay

	
0


	
Results Time Limit

	
0


	
Keep Alive Enabled

	
Unchecked


	
Follow Referrals

	
Checked


	
Bind Anonymously on Referrals

	
Unchecked


	
Propagate Cause for Login Exception

	
Unchecked


	
Cache Enabled

	
Checked


	
Cache Size

	
32


	
Cache TTL

	
60


	
GUID Attribute

	
entryUUID
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C Reporting Problems

If a problem in encountered with VSM GUI, open a Service Request to Oracle.

Describe the problem and provide a screen shot if possible, attached to the Service Request.

Collect diagnostic logs from the VSM GUI application server, and attach them to the Service Request.

To gather diagnostic logs, run the following command from a terminal on the VSM GUI application server:

vsmgui@vsmguisvr:~$ /opt/vsmgui/scripts/vsmGui_getlogs.sh

Alternatively, from the VSM GUI, select Administration and Application Logs on the navigation tree and then click Download Log.

The generated log file can be found in /opt/vsmgui/logs/archive/.

For example:

vsmgui@vsmguisvr:~$ /opt/vsmgui/scripts/vsmGui_getlogs.sh

[ Feb 6 14:01:11 INFO: vsmGui_getlogs.sh: stage log files... ]

[ Feb 6 14:01:12 INFO: vsmGui_getlogs.sh: tar log files... ]

[ Feb 6 14:01:17 INFO: vsmGui_getlogs.sh: VSMGUI_LOGS-020615_140112.tar.gz log file is available in /opt/vsmgui/log/archive ]
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